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Welcome

Forms design and management has changed substantially with the
advancement of computer technology and forms software. Automation
of the paper system—both in forms design, and in the management of
information—has brought significant benefits to those who use forms.

Informed consists of a family of separate applications: Informed
Designer, Informed Manager, Informed Number Server, and Informed
Revision Distributor. Although packaged separately, together they
provide a complete solution for designing, distributing, filling, routing,
approving, and submitting electronic forms.

Informed Designer

Informed Designer gives you flexible tools to draw professional quality
forms quickly and easily. With advanced drawing tools, powerful graph-
ics manipulation commands, and precision control, you have all you need
to produce appealing, picture perfect forms on your Macintosh computer.
Since forms are stored electronically, you now have more freedom to
change your forms as your needs change. It’s as simple as “point and
click” to move a line or change a heading.

If you want to distribute paper forms to be filled out by hand or with a
typewriter, then Informed Designer is all you need. You can design forms
for in-house printing, or you can prepare camera-ready artwork for your
commercial printer. You can even use Informed Designer’s color capa-
bilities to color your forms and print them commercially using the spot
color printing process.

For those forms that you want to fill out electronically, Informed
Designer allows you to build in ‘intelligent’ features. Make your forms
automatically calculate, format, lookup, and check information for the
person using Informed Manager. You can also configure forms for
electronic signing by using digital signatures (for more information on the
intelligent features of Informed, please see your Informed Designer Data
Intelligence manual). Although you require Informed Manager to fill out
and save forms, you can test your forms using the test facility of Informed
Designer. This allows you to make sure that your formatting, calculations,
and other intelligent features work properly without having to switch to a
different application.
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About this manual

This manual includes a complete reference to Informed Designer’s design
and graphic features. General topics are organized in the following
chapters:

❏ Chapter 1, Manipulating documents, teaches you about Informed
documents. Instructions are provided on how to create, open, close,
and save documents.

❏ Chapter 2, Setting up a form, covers the commands you use to setup
the page and drawing area of your form.

❏ Chapter 3, Pages of a form, describes how the pages of a form are
organized. It provides instructions on how to create and remove pages,
and how to use the master page and the work page.

❏ Chapter 4, Drawing environment, teaches you about Informed
Designer’s drawing environment. It describes drawing aids such as the
rulers, grid lines, guide lines, and view scale.

❏ Chapter 5, Drawing tools, describes Informed Designer’s drawing
tools.

❏ Chapter 6, Changing an object’s appearance, provides instructions on
how to manipulate the appearance of objects on your form.

❏ Chapter 7, Manipulating objects, describes the features that help you
move, size, rotate, align, distribute, and group objects on your form.

❏ Chapter 8, Using graphics, teaches you how to import artwork and
text from other Macintosh applications and also explains the publish
and subscribe features of Informed Designer.

❏ Chapter 9, Using color, describes Informed Designer’s color capabili-
ties. It teaches how to define colors and how to produce color forms.

❏ Chapter 10, Printing forms, teaches you how to print forms. It
describes Informed Designer’s printing options.

❏ Chapter 11, Mailing documents, explains how you can use electronic
mail to send form documents to other users.
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The Informed Designer manual set

The Informed Designer manual set is designed to provide you with a
complete reference to the features and functionality of Informed
Designer. The manuals combine text and graphics to thoroughly docu-
ment every aspect of the software. In addition to the Informed Designer
Design and Graphics manual, the set is made up of the following:

❏ The Installation Guide provides you with instructions on installing
Informed Designer. The guide also describes the minimum hardware
and software configurations required to use Informed Designer.

❏ The Getting Started manual introduces you to the basic features of
Informed Designer. A series of 7 exercises leads you through the steps
involved in designing and creating you own invoice form. Once you
have created the form you will learn how to add intelligent features to
it. Finally, you will learn how to test and print the form.

❏ The Data Intelligence manual provides a detailed reference to the
intelligent features of Informed Designer. You’ll learn about the data-
handling capabilities of Informed. You’ll also learn how to perform
calculations, link forms and use formulas and functions. The way in
which Informed Designer uses the PowerTalk  features of electronic
signatures and AppleScript  is also described.

❏ The Informed Extensions manual describes how to install and use
extensions.

❏ The Informed AppleScript Reference manual documents the features
of Informed that can be scripted, and provides the relevant scripting
commands.

Installation instructions

The Installation guide is not provided with the CD version of Informed Designer. 



1 - 1

Chapter 1
Manipulating documents



1 - 2 Chapter 1: Manipulating documents

This chapter presents information about Informed documents and how
they are manipulated. You’ll learn about Informed document types and
password security, as well as how to create, open, close and save docu-
ments. Figure 1-1 below summarizes the commands that are discussed in
this chapter.

Saves a copy of  a document

Creates a new document

Saves a document

Closes a document
Opens an existing document

Sets the design password

Fig. 1-1
File menu and document manipulation commands

Informed documents

The term document refers to a file that contains information. An Informed
document is a file that contains information about a form. There are three
types of Informed documents: form documents, stationery documents,
and data documents (also called data files).

Fig. 1-2
Form, stationery, and data document icons

A form document consists of a form’s layout, and a database containing
zero or more completed forms. A stationery document contains only the
layout of a form. A data document contains only a form’s data.

Demonstration forms

A fourth type of form document exists -– the demonstration form. This type is used  during the Quick Start and cannot be saved. For more information, see the Quick Start User's Guide and the 1.4.3 Addendum.
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Form documents

A form document is accessed by both Informed Designer and Informed
Manager. You use Informed Designer to create and manipulate the layout
of a form (that is, the graphics and text on the form as well as its data
intelligence information). Once you’ve designed and created a form’s
layout, you can use Informed Manager to manipulate the database of
completed forms. A form document is illustrated below:

Layout

Database of 
completed 
forms

Fig. 1-3
Parts of an Informed document

Stationery documents

Form documents are accessed by both the Informed Designer and Man-
ager applications as described above. Stationery documents differ from
form documents in both their content and use. Unlike form documents,
stationery documents don’t contain completed forms.

The purpose of using stationery documents is to store form templates or
personal preferences. For instance, suppose that most of the forms you
create have the same company logo, header and footer. Rather than
redrawing (or cutting and pasting) these elements each time you create a
new form, you can simply create a template form and store it as a station-
ery document. Then, instead of using the New command to create a new
form, you would open the stationery document and its contents would be
read into a new untitled window. You would finish the form by adding
the remaining artwork and text, and then save it as a form document for
use with Informed Manager.

Another important use of stationery documents is for storing your prefer-
ence of default settings. Default settings determine the appearance of new
objects when they’re first drawn. For example, if the default line width
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for lines is 1 point, each new line that you draw will be 1 point. Of
course, after drawing an object, you can change its appearance any way
you like.

Although you’re free to change the default settings while drawing a form,
you cannot change these settings for new documents (a new document
always inherits the same preset defaults). However, you can use station-
ery documents to hold your preferred defaults. Simply create a new
document, change the default settings to your personal preferences, then
save the form as a stationery document. When you open the stationery
document, its default settings (in addition to the form itself) will be read
into a new untitled window.

Data documents

A data document, or data file, is a file containing form data only. The data
in a data file is associated with a specific form document. Data files can
only be created and opened with Informed Manager. For more informa-
tion on creating and opening data files, please see the Informed Manager
Reference manual.
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Creating a new document

The New command creates a new Informed document.

To create a new document, select New from the File menu. A new
untitled window will appear.

Fig. 1-4
Untitled drawing window

You can create as many documents—or open as many existing ones—as
you like. You are only limited by the amount of RAM (random access
memory) in your computer.

Each time you create a new document, Informed names it ‘UntitledX’
where X is a number (starting with 1, 2, 3, and so on). A new document
will always be named uniquely; if ‘Untitled1’ is already open, then a
subsequently created document will be called ‘Untitled2’ (provided of
course that ‘Untitled2’ isn’t already open).

Opening a new document

New
File menu
Command-N

Document name

Tool palette

Information box

Scroll bars

Close box

Page controls

Zoom box

The New command only provides you with a new, untitled drawing
window. To make any changes permanent, remember to save your
work. For more information on saving a document, see Saving a
document and Saving copies of a document later in this section.

Warning
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Each new document is assigned a set of default settings. These defaults
refer to the current settings of the object tools; that is, they determine
what new objects will look like. For example, the default font for the text
tool is Helvetica. Similarly, the line tool has a default width of one point.
See Appendix A for a complete list of default settings.

Although you can change the default settings while drawing a form, you
can’t change these settings for new documents (a new document always
inherits the same preset defaults). However, you can use stationery
documents to hold your preferred default settings. See Informed docu-
ments above for more information.

Opening a document

The Open command opens an existing document.

To open a document, select Open from the File menu. The Open dialog
appears:

Fig. 1-5
Open dialog

Open…
File menu
Command-O

Note You can make the Open dialog appear when you start Informed
Designer by holding down the Option key and double-clicking the
Informed Designer icon.



1 - 7

Use the Eject and Desktop buttons to select the disk or volume containing
the document that you wish to open. If your document is in a folder, you
will have to first open the folder to show the document. Use the mouse or
arrow keys to select the document in the list and then click Open or press
the Return key.

The Document Type pop-up menu allows you to select the types of
documents displayed in the in the Open dialog. For example, you can
choose to display only Form documents or only Stationery documents.

Password security

Passwords are an optional feature of Informed. Each Informed document
can have two different passwords: a design password and a data entry
password. To open and change the layout of a password secured docu-
ment with Informed Designer, you must know the design password. The
data entry password is required when you open a document to fill out
forms with Informed Manager. When you attempt to open a form locked
with a Designer password the following dialog appears:

Fig. 1-6
Entering the password

As you type the password, you’ll see small black circles—sometimes
called ‘bullets’—in place of the characters that you type. This is done
purposely to help keep your password confidential.

Opening a document

Note Passwords are case sensitive. This means that upper and lower case
letters are considered different. For example, the passwords ‘My
Password’ and ‘my password’ are different.
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After you type the password, click OK. Informed Designer will verify
that you’ve entered the correct password before opening the document.
(For instructions on how to change or clear the password, see Changing
the password later in this section.) If you enter an incorrect password,
you’ll see this dialog:

Fig. 1-7
Incorrect password message

Click OK, then enter the password again. If you don’t remember the
password, you can always cancel the Open command by clicking Cancel
on the dialog shown in Figure 1-6.

As your document is opened, Informed Designer displays progress
information in the information box at the lower-left corner of the drawing
window.

Fig.  1-8
Progress information

Informed Designer can open form documents, stationery documents, and,
through the use of extensions, other types of documents such as
SmartForm, TrueForm, and Fast Forms documents. Extensions are
individual files that add additional functionality to Informed. For more
information on extensions, please see the Informed Extensions manual.

Below is an explanation of how Informed Designer opens each type of
document.

❏ A form document is opened into its own window for editing.

❏ A stationery document is opened and copied into a new untitled
window.

❏ Documents that correspond to forms created with other products, such as
TrueForm and Fast Forms, are converted to an Informed document and
opened into a new untitled window.
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You may see the following warning when you open certain documents:

Fig. 1-9
Fast Forms document warning

Click OK to open and convert the document or click Cancel to cancel
the Open command.

When a document is open, its name appears in the Form menu along with
the names of all other open documents. You can choose an open docu-
ment by selecting its name from the Form menu.

Changing the Password

You can change the design and data entry passwords of a form by using
Informed Designer and Informed Manager respectively. The data entry
password can also be changed using Informed Designer. You can also
specify whether or not Informed Manager users can change the data entry
password.

Once you’ve opened a document, you can change its design password by
choosing the Set Passwords command from the File menu. The Set
Passwords dialog appears.

Fig. 1-10
Set Passwords dialog

To change a password, click either the Design Password or Data Entry
Password buttons. The Set Design Password or Set Data Entry Password
dialog appears requesting that you enter both the old and new passwords.

Opening a document

Set Paswords…
File menu

Selecting a form
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If the document’s current password is blank, simply enter the new
password in the text entry box provided, then click OK. If the document
has a password, enter it in the ‘Old password’ text entry box. Informed
Designer won’t let you change the password unless you know the current
password. If you want to remove the design password, leave the new
password blank.

Depending on the use and purpose of a form, you may or may not want to
allow those who fill it out to change the data entry password. If a form is
used exclusively by one person (perhaps yourself), the ability to change
the password might be appropriate. However, if a particular form docu-
ment is shared by several users, you might want to restrict them from
changing the password in order to prevent one person from changing it
and unintentionally (or intentionally) not telling the other users of the
form. If you want to prevent users from changing the data entry pass-
word, turn the ‘Allow users to change data entry password’ check box off
(the Set Passwords command will be disabled). Otherwise, leave the box
checked.

After you’ve changed either or both passwords, click OK on the Set
Passwords dialog. Informed Designer will confirm the changes that you
made by displaying a message. If you changed both passwords, you’ll see
two messages.

Fig. 1-11
Password changed or cleared message

Important Passwords are case sensitive. This means that upper and lower case
letters are considered different. For example, the passwords ‘My
Password’ and ‘my password’ are different.

Important Remember your password!
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Document conversion

To accommodate new features and capabilities of Informed, the data
format of Informed documents changes from time to time. For a docu-
ment that was created with an earlier version of Informed Designer,
opening it for the first time might prompt the dialog shown below.

Fig. 1-12
Conversion warning dialog

If you choose to continue (by clicking OK), Informed Designer will open
and convert the selected document to the newer format. The information
box near the lower left corner of the document window will display
progress information during the conversion process.

Missing fonts

When you open a document, Informed Designer checks to make sure that
the fonts used on the form are available in your system file. Different
system files on different computers can have different fonts installed. If
you draw a form on one computer, then transfer the document to different
computer, that computer might not have the fonts that you originally used
to draw the form. Whenever you transfer a document to a different
computer, you should make sure that the system file on that computer has
the fonts that are used on the form.

If Informed Designer detects that at least one font is missing from your
system file, you’ll see the dialog displayed on the top of next page:

Opening a document

Warning Be sure to make backup copies of your documents before you
convert them. Should an error occur during the conversion process,
you may damage your forms.
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Fig. 1-13
Missing fonts warning

Any text that uses an unavailable font will display using a font that’s
available in your system file. For information about installing fonts,
please see the Macintosh Owner’s Guide that came with your computer.

Opening a locked document

If you choose to open a locked document, or a document that resides on a
locked disk, Informed Designer will warn you.

Fig. 1-14
Locked document warning

If you continue, the document will be opened as usual. However, you
won’t be able to save any changes made to the document itself (the Save
command will always be disabled). To save any subsequent changes
made to the document, use the Save As command to save the document
as a new file.

Opening a document in use

An Informed Designer document that is presently in use cannot be
opened. Most commonly, if a document is already in use, you’ve prob-
ably already opened it yourself. If you try to open a document already in
use by another user or application, you’ll see the dialog displayed on the
top of the next page:
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Fig. 1-15
Document in use dialog

Click OK to dismiss the dialog.

You cannot open a document that resides on a file server and is being
used by another user. If you attempt to, a dialog appears giving you the
options of waiting until the document is available for use, or of cancelling
the attempt.

Opening signed documents

PowerTalk is Apple Computer’s system software extension that provides
various collaborative services such as electronic mail and electronic
approval. With PowerTalk installed on your computer, you can send
documents to other users and you can sign documents electronically.

Signing information using PowerTalk results in the creation of a digital
signature. The digital signature is attached to the information and it
allows any PowerTalk user to verify the integrity of the document at any
time. For more information about digital signatures, please see your
PowerTalk User’s Guide.

Chapter 3 of your Informed Designer Data Intelligence manual explains
how you can add signature cells to your forms so that Informed Manager
users can sign individual completed forms or parts of completed forms.
Separate from this feature is the ability to sign an entire document using
the Finder by dragging its icon onto your Signer.

When you open a form, Informed Designer checks if the document has
been signed using the Finder. If a digital signature is present, you’ll be
warned and given the opportunity to verify the signature.

Opening a document
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Fig. 1-16
Signed document warning

To verify the signature before opening the document, click Verify. If
verification is successful, you’ll see a dialog showing the identity of the
person who signed the document.

Fig. 1-17
Successful verification

If the document has been changed since it was signed, or if the digital
signature itself has been tampered with, a message indicating so will
appear when you click the Verify button.

To open the document without verifying the signature, click Continue
instead of Verify. To cancel opening the document, click Cancel.

Please see chapters 3 and 8 of your PowerTalk User’s Guide for detailed
information about digital signatures.

Warning An important purpose of the dialog in Figure 1-17 is to warn you that
the document you’re opening is signed. If you proceed to open the
document, changing and saving the document will invalidate the
digital signature.
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Closing a document

The Close command closes the currently active document. That is, the
document that corresponds to the front-most drawing window on your
screen.

To close the currently active document, choose Close from the File menu
or click the window’s close box. Depending on the kind of document that
you’re working with and the work that has been done, one of the follow-
ing situations will arise.

Closing a new document

If you’re closing a new document that has not been edited, the document
is closed immediately.

If you’re closing a new document to which changes have been made,
Informed Designer will warn you to save the changes:

Fig. 1-18
Standard save dialog

You can choose one of three actions.

❏ If you select Save you’ll be asked to name the new document and select
the disk or volume to store it on.

Closing a document

Close
File menu
Command-W
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Fig. 1-19
Save new document dialog

Type the name of the new document in the text entry box. Use the
Eject and Desktop buttons to select the disk or volume to store the
new document on. Click Save to save and close the document. Click-
ing Cancel instead will cancel the Close command; your document
will remain open.

If the name you choose for your new document already exists on the
selected disk or volume, or if a document by that name is already in
the current folder, Informed Designer will warn you.

Fig. 1-20
Replace existing document warning

Clicking Replace replaces the document. Clicking Cancel returns you
to the Save dialog (Figure 1-19) allowing you to enter a different
document name.

❏ If you select Don’t Save (on the dialog in Figure 1-18 any editing you’ve
done will be lost and the document will be closed.

❏ If you select Cancel, the Close command will be cancelled; your
document will remain open.
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Closing an existing document

If you’re closing an existing document (a document that was previously
opened), Informed Designer will first check if you’ve made changes to
the form. If your document has not changed since you last opened it, then
it’s closed immediately without warning.

However, if you’ve made changes to the document, then one of two
condition will arise.

❏ If your document does not contain any completed forms, or if it does
contain completed forms but the changes that you’ve made will not
affect this data, then you’ll see the standard save changes dialog.

Fig. 1-21
Standard save dialog

Click Save to save the changes and close the document. Click Don’t
Save to discard the changes and close the document. Click Cancel to
cancel the Close command and continue editing your form.

❏ If you’re closing a document that contains completed forms, and the
changes that you’ve made will affect this data (maybe you’ve added or
removed a cell, or changed a cell’s type), then you’ll see this dialog:

Fig. 1-22
Changes affecting data dialog

For more information about this
dialog and why it occurs, see
Changing documents that
contain completed forms  later in
this chapter.

Closing a document
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The purpose of the above dialog is to warn you that if you save the
current document, the changes you’ve made will in some way affect
the completed forms that already exist. Click Save to save the changes
and close the document. Click Don’t Save to discard the changes and
close the document. Click Cancel to cancel the Close command and
continue editing your form. If you Click Save, the changed layout is
saved and any associated data is updated.

Saving a document

The Save command saves the currently active document. That is, the
document that corresponds to the front-most drawing window on your
screen. This command is enabled only when changes have been made to
the currently active document.

To save a document, select Save from the File menu. Depending on the
type of document you’re working with and the kind of work that you’ve
done, one of the following situations will occur.

Saving a new document

If you’re saving a document for the first time, you’ll be asked to name the
new document and select the disk or volume to store it on.

Fig. 1-23
New Save dialog

Type the name of the new document in the text entry box. Use the Eject
and Desktop buttons to select the disk or volume to store the new docu-
ment on. Click Save to save the document. Clicking Cancel will cancel
the Save command and return you to editing your form.

Save
File menu
Command-S
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Since document names must be unique, Informed Designer will warn you
if a document with the same name already exists on the selected volume
or if one with the same name exists in the chosen folder.

Fig. 1-24
Replace existing document warning

Clicking Replace replaces the document. Clicking Cancel returns you to
the Save dialog (Figure 1-22), allowing you to enter a different document
name.

Saving an existing document

When saving an existing document, if it doesn’t contain any completed
forms, or if it does contain completed forms but the changes you’ve made
won’t affect this data, the document will be saved without warning.

However, if your document does contain completed forms, and you’ve
made changes that will affect this data in some way (i.e. you’ve added or
removed a cell, or changed a cell’s type), then you’ll see this dialog:

Fig. 1-25
Changes affecting data dialog

Like closing documents, the purpose of the above dialog is to warn you
that if you save the current form, the changes you’ve made will in some
way affect the completed forms in the document. Click Save to save the

Saving a document

For more information about this
dialog and why it occurs, see
Changing documents that
contain completed forms later in
this chapter.
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changes and close the document. Click Cancel to cancel the Save com-
mand and continue editing your form. If you Click Save, the changed
layout is saved and any associated data is updated.

Saving copies of a document

Use the Save As command to save a copy of a document with a different
name, in a different folder, or on a different disk or volume.

To use the Save As command, select it from the File menu. You’ll see the
dialog displayed below:

Fig. 1-26
Save As dialog

The same options apply as when saving a new document. The Eject and
Desktop buttons select the disk or volume to store the new document on.
The Document Type pop-up menu allows you to save the form in differ-
ent formats. You can save the form as a Form or as a Stationery document
type. If the current document contains a database of completed forms,
selecting ‘Form (layout only)’ omits the database and saves the layout
only. You can do this only if you’re saving the document as a form
document (stationery documents do not contain completed forms).

If you have installed any translator extensions in your Informed Exten-
sions folder, their names will appear in the Document Type pop-up menu
(Fig. 1-26 shows the EPS extension). For information about extensions,
please see your Informed Designer Extensions manual.

Save As…
File menu
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Changing documents that contain completed forms

As described in the section Informed documents, a form document
contains both the layout of a form as well as a database of completed
forms. Completed forms are manipulated using Informed Manager.

It’s important to note that when you change a layout with Informed
Designer, you also affect the completed forms in the document—if any
exist. For example, if you remove a field from a form, the data stored in
that field is also removed from each completed form.
As you make changes to your form, Informed Designer keeps track of
those changes that affect the data of the completed forms. When you save
a document, Informed Designer will warn you of such changes with a
dialog like the one shown below.

Fig. 1-27
Changes affecting data dialog

If a cell on your form will be affected by any change that you’ve made,
then its name will appear in the list, along with a description of the type
of change that was made. Click Yes to saving the document, or click
Cancel to cancel the command and return to editing your form.

If you save your document, Informed Designer will update the database
of completed forms in addition to changing the layout itself. The process
of updating the completed forms occurs almost instantly.

Informed Designer considers the following changes as those that will
affect the data of a completed form:

❏ creation of a new cell

❏ removal of a cell

❏ changing of a cell’s type

Changing documents that contain completed forms
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❏ changing of a cell’s calculation formula

❏ changing of a character cell’s character format.

A new cell is created when you draw or paste a new field or table. When
you create a new cell, Informed Designer will make room for it in each of
the existing completed forms when the document is saved. Cells are
removed by clearing or cutting fields or tables, or by removing pages that
contain fields or tables. You can change a cell’s type or the character
format of a character cell using the Cell command. A cell’s calculation
formula is changed using the Value command.

There’s one exception to the rules outlined above. If you cut a cell (by
cutting a field or table), and then paste it back before closing your form,
Informed Designer will preserve the cell’s data. For example, if you cut
and paste a field to move it from one page to another, the data that’s
associated with the cell of that field won’t be lost.

Building, rebuilding, and clearing indexes

As Indexes in chapter 1 of the Data Intelligence manual explains, you can
index any non-picture or non-signature cell on your form. When you fill
out and manipulate forms with Informed Manager, different commands
allow you to find and display forms of particular interest. Indexing a cell
allows Informed Manager to search for forms much faster. Please see
Indexes in chapter 1 of the Data Intelligence manual for more informa-
tion.

Depending on the changes that you make to a document, Informed
Designer may have to build, rebuild, or clear one or more indexes when
you save your form. For example, if you remove an indexed cell, In-
formed Designer will have to clear the index. If you index a cell that was
previously not indexed, or if you create and index a new cell, Informed
Designer will have to build the new index. If you change the type or
calculation of an indexed cell, the index will have to be rebuilt.

When you save a document, Informed Designer determines whether or
not any indexes must be built, rebuilt, or cleared, and if so, displays this
warning:
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Fig. 1-28
Warning message

Clicking Continue saves the document. If your document contains a
considerable number of completed forms (perhaps 1,000 or more), the
process of building, rebuilding, or clearing indexes might take several
minutes. During this process, Informed Designer displays progress
information.

Fig. 1-29
Progress information

The process of building, rebuilding, or clearing an index cannot be
interrupted.

Digital signatures

Chapter 3 of your Informed Designer Data Intelligence manual explains
how you can create signature cells on a form so that the Informed Man-
ager user can sign individual completed forms or parts of forms. A
signature cell can sign the data in all cells or selected cells on the form.
This capability relies on electronic signing services such as those pro-
vided by Apple Computer’s PowerTalk system extension.

An important purpose of digital signatures is to be able to determine if
data has changed since it was signed. If signed data has changed, the
digital signature will not verify successfully. The signature is said to be
invalid.

Changing documents that contain completed forms
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Changing the design of a form that contains signed data can potentially
invalidate digital signatures. For example, suppose that a form contains a
signature cell that signs five other cells on the form, and that an Informed
Manager user has filled out and signed several forms. Opening the form
document with Informed Designer, deleting one of the five cells contain-
ing signed data, and saving the document will invalidate the signatures.

Below is a list of the types of changes that can invalidate digital signa-
tures:

❏ deleting a cell that contains signed data

❏ changing the cell type of a cell that contains signed data

❏ changing the calculation formula of a cell that contains signed data.

For detailed information about the electronic signing services provided by
PowerTalk, please see your PowerTalk User’s Guide.

Form information

The Form Information command displays the Form Information dialog
which allows you to enter and view information about a form. You can
enter into the dialog information on a form’s ID, revision number, author,
organization, and description.

With a form open, choose the Form Information command from the Form
menu. The Form Information dialog appears:

Form Information command
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Fig. 1-30
Form Information dialog

Informed Designer automatically assigns a default form ID to every form
you create. In many organizations, each different form is identified by a
customized form ID. Rather than using the default form ID, or referring
to a form by name, you might refer to it by a custom form id (form
‘T10994’ instead of ‘Travel Expense Form’, for example).

The form ID is an important attribute of a form. It is relied on to associate
form data with form documents when the Informed Manager user elec-
tronically mails forms using a data only format. The form ID is also used
to help ensure the integrity of forms distribution using Informed Revision
Distributor.

A form can be further identified by its revision number. The revision
number often identifies a particular version of the form.

Other information includes the author’s name and organization, and a
description. Since users filling out forms with Informed Manager can
view (but not change) the form information, you might want to provide
information about filling out the form or instructions on how to obtain
help if necessary.

Form information

Important If Informed Manager users will be electronically mailing forms using
a data only format, of if you’re using Informed Revision Distributor to
distribute forms to users, the form must have a unique form id.
Please see your Informed Revision Distributor User’s Guide  for more
information.
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Enter the appropriate information on the Form Information dialog, then
click OK to accept the changes. To cancel any changes made, click
Cancel instead.
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Chapter 2
Setting up a form
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In this chapter, you’ll learn how to lay out a form on the printed page.
You’ll learn how to choose a paper size and the size of a form. As well,
you’ll also learn how use a powerful feature to replicate a form many
times across a single page. Below is a summary of the commands
described in this chapter.

Fig. 2-1
File menu and page setup commands*

Informed Designer also supports multiple page and multiple part forms.
For information about these and other page related features, see Pages of
a form.

Overview

When setting up your form, you need to specify the paper size that your
form will print on as well as the size of the form itself. The size of a form
is called the drawing size or the drawing area size and it’s specified
independently of the paper size. This allows you to create and print forms
of any size (up to a maximum of 17" by 17") regardless of the paper sizes
available on the printer that you’re using.

Sets the paper size and page options.

Sets the drawing size and options.
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The minimum and maximum drawing sizes are 0.5 and 17 inches square,
respectively. The allowable paper sizes vary from printer to printer. Most
dot matrix printers, such as Apple’s ImageWriter II printer, support
custom paper sizes as large as legal sized sheets. Most laser printers and
PostScript devices support only standard paper sizes including letter,
legal, and tabloid.

When the drawing area size exceeds the printable area of the selected
paper size, Informed Designer will automatically tile the form onto
multiple sheets of paper as necessary. This process is illustrated below.

Fig. 2-2
Printing a tabloid sized form onto four 8.5” by 11” pages

The dashed lines on the tabloid form divide it into four sections, each of
which will print on the printable area of one 8.5" by 11" page. Four 8.5"
by 11" pages are required to print the entire tabloid form.

Tiling gives you the ability to print large forms on printers that don’t
support large paper sizes. For example, if you’re designing a large form
for commercial reproduction, you might want to proof your form on an
Apple LaserWriter as you create it. By tiling, either automatically or
manually, you can print the entire form or only parts of the it onto smaller
sheets. When the form is complete, you would then print it on a typeset-
ting device such as a Linotronic L300 to obtain camera-ready artwork.
However before doing so, you would select the tabloid paper size so that
the form would print entirely on a single page (many typesetting devices
support the larger tabloid paper size).

Tabloid drawing area 
(11” by 17”)

Four 8.5” by 11” sheets
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The following sections explain the Page Setup and Drawing setup
commands. You use these commands to choose the paper size and
drawing size. As well, they allow you to control various printer options.
For more information about tiling, see Tiling.

Page setup

The Page Setup command sets the standard page options supported by
your printer. Use it to choose the paper size and control printing related
options such as page orientation.

Before setting the page options, make sure that your printer is properly set
up and connected to your computer. Also make sure that you’ve selected
it using the Chooser desk accessory. Then choose the Page Setup com-
mand from the File menu. You’ll see the Page Setup dialog associated
with your printer.

For information about the Chooser desk accessory, please consult your
Macintosh Owner’s Guide.

LaserWriter page options

If you’re using an Apple LaserWriter printer (or a printer that uses
Apple’s LaserWriter driver), you’ll see a dialog similar to this:

Fig. 2-3
LaserWriter Page Setup dialog

Page Setup…
File menu

Important In the discussion that follows, keep in mind that changing the paper
size DOES NOT automatically change the drawing size to match. For
more information about setting and changing the drawing size, see
Drawing setup later in this chapter.
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The standard printer options are provided (controls for choosing paper
sizes, page orientation, printer effects and so on). For more information
about these features, please consult your LaserWriter Owner’s Guide.

Keep in mind that although the LaserWriter accepts only standard paper
sizes, this doesn’t limit your ability to choose a different or non-standard
drawing size. If your drawing size is larger than your paper size, then
Informed Designer will tile your form onto multiple sheets when it prints
your form. You also have the option to manually tile only a particular
area of your form. Both the drawing window and the Drawing Setup
dialog visually indicate the currently selected paper size. See The drawing
window and Drawing setup for more information.

Enter the resolution of your printer in the Resolution text entry box.
Informed Designer uses this value to control the precise width of very
thin lines. It’s important that it’s set correctly for high resolution image-
setters such as Linotronic or Varityper devices. Otherwise, very thin lines
(1/4 point or thinner) might print too thin. If you’re using a 300 dpi laser
printer, a 300 dpi setting will ensure that thin lines print consistently.

Printing shaded objects

An important feature of Informed Designer is its ability to change the
screen resolution of shaded objects when your form is printed on a
PostScript printer. In this context, the term screen resolution refers to the
number of lines per inch that your printer uses to print a shaded object.

The screen resolution value for LaserWriter printers is set, by Informed
Designer, to default to a value that is appropriate for the printer you are
using. The default value remains accurate as long as you have set the
correct resolution for your printer in the ‘Resolution’ text entry box of the
Page Setup dialog. The default value is shown as DFLT in the ‘Screens
at’ text entry box

When you shade an object (using the Paint, Pen or Fill commands), you
choose none, block or a percentage of black ranging from 0% to 100%. A
0% shade is white and a 100% shade is black. Any value between 0% and
100% is a shade of gray (the higher the percentage, the darker the shade).

Note The word screen as used in the context of this discussion is not the
same as the notion of your computer’s display screen.  Be careful
not to confuse the two.
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Fig. 2-4
Informed Designer’s range of shades

When a shaded object is printed, the corresponding shade of gray is
obtained by covering the shaded area with the right proportion of black
and white. For example, an area that is 50% shaded will be half black and
half white. Of course, the black and white areas are intermixed so that the
resulting appearance is a shade of gray. For purposes of this discussion,
these black and white areas will be called dots. Therefore, an area
covered with a 50% shade will contain an equal number of evenly
distributed black and white dots.

Changing the screen value on the Page Setup dialog allows you to control
the size of the dots used when printing shades. You should only change
the default value if you are sure of the effect you wish to create. Below is
an example of a box filled with a 50% shade printed at both 72 and 36 lpi
(lines per inch).

Fig. 2-5
50 percent shade at 72 lpi (left) and 36 lpi (right)

To control the screen resolution of printed shades, type an appropriate
value in the Screens at’ text entry box on the Page Setup dialog. Usually,
the value you set depends on your printer’s resolution and the quality of
paper stock that your form will be printed on. For printing on a Laser-
Writer, the recommended value is 60 lpi; for higher resolution printers
such as the Linotronic L300, increase the value to 90 or more.

none

40% block out

0% 10% 20% 30%

60% 80% 100%
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ImageWriter page options

If you’re using an Apple ImageWriter printer, choosing the Page Setup
command will show a dialog similar to this:

Fig. 2-6
ImageWriter Page Setup dialog

As with the LaserWriter Page Setup dialog, all the standard options are
provided (standard page sizes, page orientation, and special effects). For a
complete description of these features, please consult your ImageWriter
Owner’s Guide.

When using an ImageWriter printer you can specify custom paper sizes.
This is necessary when you print onto pre-printed forms or labels of non-
standard sizes. Setting the custom paper size will ensure that the proper
length of paper is fed through the printer each time a form is printed.

If you choose the ‘Use above settings’ option, the paper size is deter-
mined by your selection of a standard size (top of the dialog). If you want
to use a non-standard size, click the ‘Use custom settings below’ choice,
then enter the custom width and height in the text entry boxes provided.
The values that you enter are expressed in the current ruler units and are
independent of whether you choose landscape or portrait printing. That is,
even if you select landscape printing, you still enter the width and height
of the physical sheet that exits the printer.

Page setup
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Drawing Setup…
File menu

The Tall Adjusted option

The size of a pixel (one dot) on the Macintosh screen is slightly wider
than the size of a pixel on the ImageWriter printer. As a result, the width
of a printed object appears slightly narrower than its corresponding size
on the computer screen. For example, a horizontal line that measures 8
inches on the screen will be approximately 7.5 inches long when it’s
printed.

The Tall Adjusted option on the ImageWriter Page Setup dialog adjusts
the size of the printed pixel so that an object’s printed size matches
exactly with its corresponding size on the screen. Click the Tall Adjusted
check box on the ImageWriter Page Setup dialog to turn this option on.

Drawing setup

The Drawing Setup command controls the size and options of the
drawing area. The drawing area is the area that appears in the drawing
window. It’s where you draw and manipulate the layout of your form.

To set the drawing size of a document, choose the Drawing Setup
command from the File menu. The Drawing Setup dialog appears:
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Fig. 2-7
Drawing Setup dialog

The left side of the Drawing Setup dialog illustrates the drawing setup. It
shows a scaled down version of the drawing area and the page (or pages)
that the drawing area is printed on. Their sizes and orientation always
reflect their current dimensions and placement relative to each other.

On the right of the Drawing Setup dialog are the current measurements of
the drawing size and the offsets. Also, you can see how many times the
drawing area is repeated in the drawing setup. You can type in any of the
text entry boxes or click any of the controls to change the associated
dimensions or options of the drawing setup.

When you type in the text entry boxes to change the drawing area size or
offsets, or to repeat the drawing area over the page, the drawing setup on
the dialog will be updated when you leave the text entry box. You leave
the text entry box by pressing Tab or Shift-Tab, or by clicking a different
text entry box or control.

The components of the Drawing Setup dialog are described in more detail
below.

Drawing setup

Page size rectangle

Drawing area rectangle 

These control the drawing size.

These control the position of the 
drawing area on the physical page.

These control the number of repeated 
drawing areas.

Drawing offset from top

Drawing offset from left

Click and drag
here to resize.
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Drawing size

The white rectangle on the illustrated drawing setup is called the drawing
area rectangle. It represents the drawing area and visually shows the size
of the drawing area relative to the page it’s printed on. The drawing area
is the area that appears in the drawing window. It’s where drawing
occurs.

The measurements of the drawing size are expressed in the current ruler
units and are indicated in the Width and Height text entry boxes. A
document’s minimum drawing size is 0.5 inches square. The maximum
drawing size is 17 inches square.

Changing the drawing size

You can change the drawing size in one of two ways.

❏ Click and drag the handle at the bottom-right corner of the drawing area
rectangle.

Fig. 2-8
Click and drag to change the drawing size

Click this handle and drag 
the mouse to change the 
drawing size.
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❏ Type directly in the Width and Height text entry boxes.

Fig. 2-9
Changing the drawing size by typing in the text boxes

You can enter a new dimension in any units you like (inches, centime-
ters, points, or picas); Informed Designer performs the appropriate
unit conversion for you. After entering a new dimension, press Tab (or
Shift-Tab) to update the illustrated drawing setup.

When you change the drawing size, Informed Designer will always
ensure that the new drawing size is not less than the minimum drawing
size and not greater than the maximum drawing size. If you type an
invalid value in a text entry box, Informed Designer will alert you (with a
beep) and highlight the incorrect value when you Tab to or click another
entry box or control on the dialog. As well, Informed Designer will
always make sure that your drawing size remains large enough to hold all
existing objects on your form. This means that objects cannot be acciden-
tally dropped off the drawing area when you change the drawing size.

If you want to make the drawing area fit completely over the printable
area of a single page (based on the current paper size and page options),
simply double-click anywhere in the drawing area rectangle.

Page size

The lightly shaded gray area under the drawing area rectangle represents
the paper size; it represents the page on which the drawing area is printed
and it corresponds to the currently selected paper size. Only the printable
area of the page, which is slightly smaller than the actual paper size, is
shown.

If the drawing size is set larger than the printable area of the current paper
size, additional sheets of paper are used to print one page of a form. The
illustrated drawing setup shows the sheets of paper that will be required

Drawing setup

For more information about
entering measurements and unit
conversion, see Appendix B,
Entering measurements.

You can type on the text entry boxes to 
change the drawing area size.
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to print one page of a form. Gray lines are drawn to indicate where the
page breaks will occur. Figure 2-10 below shows the drawing setup for a
tabloid drawing area (11" by 17") using the standard letter paper size
(8.5" by 11").

Fig. 2-10
Tabloid drawing setup

You can’t change the page size using the Drawing Setup command. Use
the Page Setup command instead. See Page setup for more information.

Offsetting the drawing

In addition to setting the drawing size, you can also change the position
of the drawing area relative to the page (or pages) that it’s printed on.
This is useful if you want the top or left edge of the drawing area to start
at a certain distance from the top or left edge of the page. For example,
suppose that you want a one inch margin on the left side of your form to
allow room for hole punching. Simply reduce the width of the drawing
area, and then enter ‘1’ in the ‘From left’ text entry box.
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Fig. 2-11
Drawing setup with one inch left margin

The horizontal drawing offset is the distance between the left side of the
drawing area and the left edge of the page. The vertical drawing offset is
the distance between the top of the drawing area and the top edge of the
page. These values are expressed in the current ruler units and they are
indicated in the Offset text entry boxes.

A second, and often more common need for the offset feature occurs
when printing crop marks, registration marks, and color names. These
marks are used by commercial printers to aid in lining up spot color
overlays and as an alignment aid when trimming a printed form. Since
they’re positioned outside the drawing area, you must make sure that
there’s enough room between the edge of the drawing area and the edge
of the printable area on the page for these marks to appear. For more
information, see Allowing for crop marks, registration marks, and color
names.

Drawing setup

Important The Offset values measure the distance from the drawing area to
the edge of the page, not to the edge of the printable area on the
page. Therefore, when the drawing area appears flush to the edge
of the page on the Drawing Setup dialog, the offset values will
indicate the margin sizes (the distances between the physical page
edge and the printable area on the page).
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Changing the offsets

You can change the offsets in one of two ways:

❏ Click and drag the drawing area rectangle across the page.

Fig. 2-12
Offsetting the drawing area by clicking and dragging

❏ Type the offsets directly into the Offset text entry boxes.

Fig. 2-13
Typing in the Offset text entry boxes

You can enter a new offset in any measurement unit you like (inches,
centimeters, points, or picas); Informed Designer performs the
appropriate unit conversion for you. After entering a new offset, press
Tab (or Shift-Tab) to update the drawing setup on the dialog.

Click and drag to 
change the offsets.

Change the drawing 
offsets by clicking here.

For more information about
entering measurements and unit
conversion, see Appendix B,
Entering measurements.
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When changing the offset values, Informed Designer will check to make
sure that all values are valid. If you type an invalid offset, Informed
Designer will alert you (with a beep) and highlight the incorrect value
when you Tab to or click another text entry box or control on the dialog.

Repeating the drawing area

If the drawing size is less than half the width or height of the printable
area on the selected paper size, Informed Designer allows you to repeat
the drawing area. This is useful if you want to print more than one form
on a single page.

For example, labels are often available on sheets for easy printing on laser
printers. Suppose that a sheet of labels contains 2 labels across and 6
down, and that each label is 3 inches wide by 1.5 inches tall. Figure 2-14
below shows a sample drawing setup that would be appropriate in this
situation. Note that the offset values have also been adjusted to ensure
that the printed labels line up with those on the sheet. In this example, the
first label is positioned 1 inch down and 1.25 inches across, respectively,
from the top and left edges of the sheet.

Fig. 2-14
Repeating the drawing area

To repeat the drawing area across or down the page, click the Horizontal
or Vertical check box, and type the desired number of areas in the
corresponding text entry box. If the number of areas you enter exceeds
the maximum that will fit on a single page, Informed Designer will ignore

Drawing setup
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those areas that don’t fit. For example, if you enter a vertical repeat of 7
on the dialog in Figure 2-14, the drawing setup would still show only 6
areas in the vertical direction.

When you print a form with a repeated drawing area, the form’s layout is
replicated across and down the page according to the parameters on the
Drawing Setup dialog. If you print a form while in Test mode, the cell
values entered automatically appear in each drawing area printed.

The real advantage of this feature comes when printing completed forms
with the Informed Manager application. When you print a group of
completed forms, Informed Manager will automatically use the next
form’s data each time a new drawing area is printed. For more informa-
tion, see your Informed Manager User’s Guide.

Allowing for crop marks, registration marks, and color names

Informed Designer can automatically print crop marks, registration
marks, and color names. Crop marks act as page edge indicators; they’re
used for trimming commercially printed forms. Registration marks are
used to align spot color overlays. Color names appear below the bottom
edge of each overlay. Figure 2-15 below illustrates these markings.

Fig. 2-15
Crop marks, registration marks, and color names

For a detailed description of registration marks and color names, see Spot
color. Also see Crop marks.

Crop marks

Registration marks

Color name

ABC Company

Black
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Crop marks, registration marks, and color names are always positioned
relative to the edges of the drawing area. Therefore, if you intend to print
these markings, you should set the drawing size equal to the actual size of
the printed form. For example, if you’re creating a standard US letter size
form (8.5" by 11"), you should use a drawing area of the same size.

When you use the Drawing Setup command, Informed Designer shows
you how your printed form will appear on paper (see Figure 2-7). Since
crop marks, registration marks, and color names are positioned outside of
the drawing area, you must allow room between the drawing area and the
edge of the page that it’s printed on. The following example describes
how to do this.

Suppose that you’re creating an 8.5 by 11 inch color form. You’re
planning to print spot color overlays on a Linotronic L300 imagesetter to
prepare your form for commercial printing. However, as you design the
form, you’d like to proof it on an Apple LaserWriter printer.

Since you want to print crop marks, registration marks, and color names,
it’s important that the drawing size reflects the exact dimensions of the
printed form.

Fig. 2-16
Drawing setup for 8.5" by 11" form

As indicated by the sample drawing setup, the form will print onto four
sheets of letter size paper. This is because the printable area on an 8.5 by
11 inch sheet is slightly inset due to the minimum margins on the printer.
Figure 2-17 below illustrates how the form will be printed.

Drawing setup
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Fig. 2-17
Printed form

Notice the positioning of the crop marks and registration marks. Since the
drawing area is pushed flush up towards the top-left corner of the
printable area on the first sheet, the top and left crop marks and registra-
tion marks won’t print. If you want to see all markings, you have to drag
the drawing area down and to the right on the Drawing Setup dialog.

Fig. 2-18
Adjusted drawing setup
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Now there’s enough room between the top and left edges of the drawing
area and the corresponding edges on the sheets of paper to allow for crop
marks and registration marks. Printing will occur as shown below.

Fig. 2-19
Printed form

Crop marks, registration marks, and color names are important only when
you prepare the final output of your form for commercial printing. Rather
than printing four pages every time you print your form, you could use
the manual tile print option to print a single sheet containing one particu-
lar area on the form. For more information, see Tiling.

Before printing your finished form on the Linotronic imagesetter, you
first change the selected paper size to tabloid (11" by 17") and adjust the
orientation of the drawing area.

Drawing setup



2 - 20 Chapter 2: Setting up a form

Fig. 2-20
Final drawing setup

Printing the form with the above drawing setup will produce one tabloid
sized sheet of output with the drawing area centered. Crop marks,
registration marks, and color names can be printed because there’s
enough room between the edge of the drawing area and the edge of the
tabloid page.
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Each form you create has one or more numbered pages, a work page, and
a master page. The numbered pages contain the form’s actual layout (i.e.
the first and second pages of a two page form). The work page and master
page each have a special purpose. This chapter describes the different
pages of a form as well as the commands summarized below.

Fig. 3-1
Edit menu and page commands

This chapter also describes the controls that are used to move from page
to page in a form. These controls are found near the bottom-left corner of
the drawing window.

Fig. 3-2
The page controls

Removes a page from a form

Sets the number of parts for a 
page

Adds a new page to a form

Moves to a different page
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Note The maximum number of pages in an Informed document is 99. If
your form contains 99 pages, the Add Page command will be
disabled, preventing you from adding any more pages.

Numbered pages

Add Page…
Edit menu
Pages sub-menu

Numbered pages

The numbered pages of a form are the actual pages that you fill out and
print. Each form can have between 1 and 99 numbered pages, with each
page having as many as 99 parts (see Multipart pages).

Adding a new page

Use the Add Page command to create a new page and add it to your form.

To add a new page, use the page controls to move to the page adjacent to
where you want to insert the new page (see Changing pages). Then
choose the Add Page command from the Pages sub-menu. The Add Page
dialog appears:

Fig. 3-3
Add Page dialog

To insert the new page before or after the current page, click the appropri-
ate radio button. The diagram to the left of the radio buttons on the dialog
shows the page placement you’ve selected. To add the new page, click
OK or press Return. To Cancel the Add Page command, click Cancel.
After inserting the new page, Informed Designer will automatically
display the new page.

Any items on the master page will appear on the added page.Note
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Removing a page

Use the Remove Page command to remove a single page and its contents
from a form.

To remove a page, use the page controls to select the page you want to
remove (see Changing pages). Then choose the Remove Page command
from the Pages sub-menu. If removal of the page is permitted, then the
Remove Page dialog appears:

Fig. 3-4
Remove Page dialog

Click OK to remove the page. Click Cancel to resume editing your form
without removing the page.

Before you can remove a page, Informed Designer will verify that the
page doesn’t contain any cells that are required by cells on other pages of
the form. If a cell on the page being removed appears in the formula of a
cell on a remaining page, Informed Designer will show this dialog:

Fig. 3-5
Can’t remove page dialog

Click OK or press Return to dismiss the dialog.

Remove Page…
Edit menu
Pages sub-menu
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A single page… …can have multiple parts.

Multipart pages

Each numbered page can have up to 99 parts. When a page is printed,
Informed Designer will automatically print one copy for each part.

Multipart pages are used most commonly when multiple copies of a form
must be printed and circulated to different individuals or departments
within an organization. For example, the bottom of a three part single
page form might say ‘Customer Copy’ on the first part, ‘Merchant Copy’
on the second and ‘Accounting Copy’ on the third.

Fig. 3-6
Multiple part form

With the Multipart command, you can instruct Informed Designer to print
a specified number of copies of a particular page (3 in the above ex-
ample). Then, using cell calculations, you can calculate a cell’s value
using the PartLabel function. With the PartLabel function, you can
specify the labels that appear on each different part. When you print your
form, Informed Designer will automatically insert the correct label on
each part. For more information about formulas, functions, and the
PartLabel function, please see chapters 5 and 6 in the Data Intelligence
manual.

Setting multipart pages

To set the number of parts for a page, first select the page using the page
controls (see Changing pages). Then choose Multipart Page from the
Pages  sub-menu. This Multipart Page dialog appears:

Numbered pages

Important When you print your form, Informed Designer will print the correct
number of parts for each page only if you’re in test mode. When
you’re in design mode, only a single copy of each page is printed.
For more information about test mode, see Testing your form in the
Data Intelligence manual.

Multipart Page…
Edit menu
Pages sub-menu
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Fig. 3-7
Multipart page dialog

Enter the number of parts (up to a maximum of 99) in the text entry box.
Set the number of parts for the current page or for all pages by clicking
the corresponding radio button. Then click OK to continue. Click Cancel
to cancel the Multipart command and resume editing your form.

Changing pages

Use the page controls located near the bottom-left corner of the drawing
window to change pages within a form.

Fig. 3-8
The page controls

The controls labelled ‘W’ and ‘M’ represent the work and master pages.
The rightmost control represents the current numbered page of your form.
When the numbered page control is selected, the number inside of it
corresponds to the current numbered page in the drawing window.

There are three ways to change a page.

❏ Click either arrow next to the page control to change pages in that
direction.
If you click and hold either arrow, Informed Designer will continue
changing pages in that direction until you release the mouse button. If
you’re on page 1, the left arrow disappears. If you’re on the last
numbered page of the form, the right arrow disappears.
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❏ Double-click the numbered page control, or from the Pages sub-menu,
choose Go To Page.
The Change Page dialog appears:

Fig. 3-9
Change pages dialog

Type the number of the page that you wish to move to, then click OK
or press the Return key. Informed Designer will move directly to the
requested page.

After changing pages, the number shown in the page control will change
to reflect the current page.

The work page

Every form contains one work page. Like the numbered pages of a form,
the work page can contain graphics, text, and cells. The only difference
between the work page and numbered pages is that the work page doesn’t
print, and whatever you place on the work page doesn’t show on any
other page of your form.

There are two common uses of the work page.

❏ As a place to put instructions or information useful to someone filling out
your form.
For example, suppose there are special instructions for distributing a
form after it has been filled out. You might include these instructions
on the work page.

❏ As a place to put cells that should not be printed with the rest of the form.
If you need to enter or calculate the value of a cell that doesn’t appear
on the form (but is required by other calculated cells), place it on the
work page. When you fill out the form, the work page functions like
any other numbered page. You can Tab to cells on the work page and
change their values. But when you print the form, the work page
won’t print.

Go To Page…
Edit menu
Pages sub-menu
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Using the work page

Display the work page by clicking the work page control near the lower-
left corner of the drawing window.

Fig. 3-10
Displaying the work page

When the work page is displayed, you can create and manipulate objects
like on any other numbered page of your form.

The master page

Every form has a master page. Like other pages of your form, the master
page can contain graphics, text and cells. Objects drawn on the master
page automatically appear on all numbered pages of your form. The
master page, therefore, is useful for drawing elements such as company
logos or page numbers that appear at the same position on all pages.

Fig. 3-11
The master page

The master page is like an additional layer of objects that’s printed with
each numbered page. In terms of stacking order, objects on the master
page are placed behind those on each of the numbered pages. Therefore,
an object on a numbered page that’s positioned over a master page object
will cover, and perhaps hide, the master page object.

Master page page 1 page 2 page 3

¥ ¥ ¥

Anything that 
you draw here…

…automatically appears here.

Click the work page control to 
see the work page.
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Using the master page

Display the master page by clicking the master page control near the
lower-left corner of the drawing window.

Fig. 3-12
Displaying the master page

When the master page is displayed, you can create and manipulate objects
as you do on any numbered page of your form. You can’t print the master
page alone.

Cells on the master page

When you fill out a form using Informed Manager (or the test mode of
Informed Designer), pressing the Tab key moves you from one cell to
next. Each cell that you draw has a unique tab position which determines
the tabbing order. When you fill out a form, you will automatically start
on the page that contains the cell with tab position 1. If you tab from a
cell on one page to a cell on a different page, Informed will automatically
change pages for you.

Cells on the master page are no different. However, unlike numbered
pages, the master page doesn’t represent an actual page of your form.
Therefore, instead of changing pages to the master page, you’ll simply
remain on the current page when you tab to a master page cell. For more
information, see Master page cells in chapter 1 of the Data Intelligence
manual.

The master page

Click the master page control to 
see the master page.
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This chapter presents information about Informed Designer’s drawing
environment. You’ll learn about the drawing window and its visual
attributes, as well as the various drawing aids including rulers, the grid,
guide lines and the view scale. You’ll also learn about the commands
summarized below.

Fig. 4-1
The Layout menu

The drawing window

You use the drawing window to create and change edit the layout of a
form. When you open or create a document, a drawing window will
appear showing the layout of the form.

Shows/hides the rulers

Show/hides the grid

Turns grid snapping on and off

Shows/hides guide lines

Turns guide snapping on and off

Sets the form's view to its actual printed size

Fits a form in the drawing window

Enlarges a form's view
Reduces a form's view

Displays the Ruler Options dialog

Displays the Grid Options dialog

Displays the Guide Options dialog
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Fig. 4-2
The drawing window

The elements of the Informed Designer drawing environment are briefly
described below. For more information on these topics, please consult the
indicated sections of this manual.

Drawing Area The drawing area is where you draw your form. Use the Drawing Setup
command to change the size and options of the drawing area. See
Drawing setup.

Rulers The rulers help you measure and position objects accurately on your
form. See Rulers.

Ruler crosshairs Ruler crosshairs indicate the position of the mouse and objects relative to
the ruler. See Ruler crosshairs.

Zero point marker Use the zero point marker to change the position of the ruler zero point.
To change the zero point, click and drag the zero point marker. To set the
zero point to its home position, click and release the zero point marker.
See Ruler zero point.

Grid lines Grid lines help you to accurately position and size objects on your form.
See Using the grid.

Specs
palette

Page break

Tool palette
Zero point marker
Close box

Guide lines
Grid lines

Information box

Drawing area

Rulers

Ruler crosshairs

Page controls

Zoom
box

Size
box

Title bar Document name

Scroll
bars

Scroll
boxes
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Guide lines The guide lines, like grid lines, help you position and size objects
accurately; use the guide lines to align objects to specific points on your
form. See Guide lines.

Page break Page breaks indicate the positions where the form crosses pages. See
Page size.

Page controls Use the page controls to view different pages of your form. See Changing
pages.

Tool palette The Tool palette contains the Pointer tool, the Zoom tool and all drawing
tools.

Specs palette The Specs palette displays the current position and dimensions of a
selected object on your form as well as the current position of the pointer.
You can use the Specs palette to change the dimensions of any object.
See The specs palette.

Faster scrolling

You can dramatically increase the scrolling speed of forms in Informed
Designer by taking advantage of any available memory.

The amount of memory required for fast scrolling depends on the dimen-
sions of your form and the monitor setting of your Macintosh. The larger
the form and the more grays or colors your monitor is displaying, the
more memory you will need. You can, however, minimize the amount of
memory required for fast scrolling by selecting a display preference. The
Edit menu contains a command called Preferences. Choosing this com-
mand displays the Preferences dialog shown below.

Fig. 4-3
Preferences dialog

The dialog contains three options. The first option ‘Display form in black
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and white’ will display your form in black and white. If your monitor
setting is set to multiple grays or colors, this option will significantly
reduce the required memory. If your monitor is set to ‘Black & White’,
selecting this option will have no effect on the memory required.

The amount of memory available to Informed Designer depends on which
version of the Macintosh operating system you’re running, and the size of
the memory partition in which the software is running. If you’re using
System software version 6.0.8 or earlier with the MultiFinder option
turned off, your Macintosh automatically gives Informed Designer the
full amount of memory in your computer. If MultiFinder is turned on or
you’re using System software version 7.0 or later, the amount of available
memory is determined by the application’s partition size. This size can be
changed to increase Informed Designer’s available memory. For more
information, please see Memory requirements, in your Installation guide.

The second option ‘Save form image’ provides the fast scrolling capabil-
ity in Informed Manager. The same memory requirements apply as for
the first option. With the option selected, Informed Designer will store
additional information in the form document. This information allows
Informed Manager to open the document much faster. However, selecting
this option will increase the size of the form document. A standard letter
size form will increase in size by approximately 10-20K per page.

In order to accommodate faster scrolling, Informed Designer creates
various temporary files, one for each page of a document. These files are
created only if you have enough disk space and they’re automatically
deleted when you close the document. However, if Informed Designer is
interrupted unexpectedly, the temporary files might be left on your hard
disk. If you’re using System software version 7.0 or later, these files will
appear in a folder in your Trash the next time you turn on your computer.
Otherwise, you’ll find the files in your System Folder. You can safely
remove these files before using Informed Designer again.

For information on ‘Fractional character widths’ please see Chapter 10,
Printing forms.
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Rulers

The rulers are a drawing aid that help you measure and align objects on
your form. Use the rulers to draw, position, and resize objects accurately.
When visible, the rulers appear on the top and left edges of the drawing
window.

Fig. 4-4
Rulers on the top and left of the drawing window

To display the rulers, choose the Show rulers command from the Layout
menu. Alternately, when the rulers are showing, this command becomes
Hide Rulers. Choose this command to hide the rulers.

Setting the ruler options

The rulers have options that you can set with the Ruler Options com-
mand. These options include the choice of unit measurement, placement
of the ruler home position, and locking or unlocking of the ruler zero
point.

To set the ruler options, choose the Ruler Options command from the
Layout menu. The dialog shown at the top of the next page appears:

Note Before you can create a new guide line, the rulers must be visible.
For more information about guide lines, see Guide lines below.

Ruler Options…
Layout menu

Show/Hide Rulers
Layout menu
Command-R
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Fig. 4-5
Ruler options dialog

Ruler units

On the Ruler Options dialog you can select from four basic units of
measurement: inches, centimeters, picas, and points. The inch measure is
most common and it is the default unit of measurement. To change the
ruler units, click any one of the radio buttons under the Ruler Units
heading.

Your choice of ruler units determines the default unit of measure on many
of Informed Designer’s dialogs. For example, when setting up the
drawing area, the associated text entry boxes on the Drawing Setup dialog
will display values in the current ruler’s units of measurement.

Ruler zero point

The ruler zero point represents the intersection of the zero mark on each
of the horizontal and vertical rulers. By default, the zero point is set to the
top left corner of the drawing area. You can change the zero point to align
it to any position on the drawing area.

To change the zero point, click and drag the zero point marker—the small
box at the upper-left corner of the drawing window—then release the
pointer at the new position.

Rulers

For information about entering
measurements and unit conver-
sion, see Appendix B, Entering
measurements.

Zero point marker
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Click here

Release here

Drag

New zero point

Fig. 4-6
Changing the zero point

If you release the mouse button in the content area of the drawing
window, you’ll change the zero point on each ruler. If you release the
mouse in the content area of either ruler, the zero point changes for that
ruler only.

If you want to set the zero point to its home setting (see next section),
click the zero point marker once.

If you want to lock the zero point, check the ‘Lock zero point’ check box
on the Ruler Options dialog. Locking the zero point prevents you from
changing it accidentally. When the zero point is locked, the short gray
lines on the zero point marker disappear.

Ruler home position

The ruler home position isn’t the same as the ruler zero point. If you
move the zero point on your drawing and then decide that you want to set
it back to its home position, simply click the zero point marker once.

Informed Designer allows you to align the ruler home position with either
the top-left or top-right edge of either the drawing area or the page. To set
the ruler home position, select the desired option under the ‘Ruler Home
Position’ heading on the Ruler Options dialog. The small diagram on the
dialog changes to reflect your choice.

Important Changing the ruler home position doesn’t automatically change
the ruler zero point to match. After changing the ruler home posi-
tion, click the zero point marker once to move the zero point to the
home position.

The diagram 
indicates where the 
home position is.

Locked zero point
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Ruler crosshairs

Ruler crosshairs are visual aids that help you position the mouse and
objects relative to particular points on the ruler. They appear as light gray
lines on each ruler.

Ruler crosshairs

Fig. 4-7
Ruler crosshairs indicating pointer position

With the ruler crosshairs, you can easily position objects on the drawing
area. For example, if you want to position the mouse one inch down and
to the right of the ruler zero point, simply drag the mouse until the ruler
crosshairs are over the one inch marks on both rulers.

The ruler crosshairs appear whenever the pointer is positioned over the
drawing area or whenever you draw, drag, or resize an object. When you
move the pointer, a single crosshair on each ruler shows the pointer’s
current horizontal and vertical position. When you draw, drag, or resize
an object, the ruler crosshairs indicate the position of the object’s edges.

Fig. 4-8
Ruler crosshairs show an object’s borders

If the grid is turned on, the ruler crosshairs will also snap to the grid.
Ruler crosshairs are therefore an accurate indication of where drawing
will start while positioning the pointer.

Rulers
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The grid

The grid consists of imaginary lines that run vertically and horizontally
across the drawing area of a form. Use the grid as an aid to position and
size objects on your form.

You display the grid by choosing the Show Grid command from the
Layout menu. When the grid is visible, the corresponding menu com-
mand becomes Hide Grid. Choose the Hide Grid command to turn the
grid display off. Grid lines are always drawn according to the specifica-
tions on the Grid Options dialog. For more information about changing
the appearance of the grid lines, see Grid options below.

Fig. 4-9
Grid Lines on the drawing window

If you’re using a color monitor, grid lines will appear in light blue.

With the grid, you can align objects in one of two ways: visually or by
using the Snap To Grid feature. When used visually, you position and
size objects by eye so that their boundaries lie along the grid lines.

Show/Hide Grid
Layout menu

Each grid axis functions independ-
ently of the other. For more
information about setting and
activating the grid axes, see Grid
options below.
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To align an object visually, 
move it to the appropriate 
grid lines.

Fig. 4-10
Visual alignment to the grid

Using Snap To Grid

When drawing, dragging, or resizing, you can have Informed Designer
automatically align—or ‘snap’—objects to the grid. You do this by
selecting the Snap To Grid command from the Layout menu.

With the Snap To Grid feature turned on, all objects that you manipulate
(by drawing, dragging, or resizing) will automatically align to the grid.
When you draw or resize an object, its edges will be constrained to lie on
the nearest grid lines, whichever are active. When you drag an object, its
upper-left corner will be constrained to lie along the nearest grid lines.

While the Snap To Grid feature is on, a check appears beside the corre-
sponding menu item to indicate that the feature is on. Subsequently, each
time you draw, drag, or resize an object, the object’s frame will be
snapped to the nearest grid lines. To turn the snapping feature off, choose
the Snap To Grid command again. The menu item will be unchecked,
allowing you to manipulate objects on a pixel by pixel basis.

When snapping an object, it’s important to note that the center of the
object’s frame—and not the edge of its frame—is snapped to the grid.
This is helpful when you want to position adjacent objects since, instead
of having their frames sit side by side, the frames of adjacent objects will
overlap.

The grid

If a drawing tool is selected and
the rulers are visible, the ruler
crosshairs will snap to the grid lines
when snapping is turned on.

Snap To Grid
Layout menu
Command-Y
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Fig. 4-11
Center of object frames snapped to the grid

When turned on, the Snap To Grid feature works regardless of whether
the grid lines are visible or not.

Grid options

With the Grid Options command you control the spacing and visual
density of the grid lines on your form. Informed Designer gives you the
ability to separately customize the grid for each form that you design.

To set the grid options, choose the Grid Options command from the
Layout menu. This dialog will appear:

Fig. 4-12
Grid Options dialog

Grid Options…
Layout menu
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Each grid axis is activated and measured independently. To activate a
grid axis, select the appropriate check box (Horizontal Grid or Vertical
Grid) on the dialog above. If a grid axis is turned off, choosing the Show
Grid command will not display grid lines in that direction, nor will
snapping occur in that direction while the Snap To Grid feature is on.

Grid separation—the distance between each grid line—can be specified in
one of three ways: in divisions per unit (inches, centimeters, picas, or
points), columns or rows per page, or unit separation (distance between
each grid line). Select the desired method by clicking the appropriate
radio button. The small diagram on the dialog changes to indicate your
choice.

Regardless of how you measure grid separation, you control the exact
spacing of the grid lines by typing a value in the accompanying text entry
box. Suppose that the current ruler measures in inches. If you type ‘9’
into the text box on the Horizontal Grid, the vertical grid lines will be
spaced at nine lines per inch; nine columns per page; or at a distance of
nine inches between each grid line, depending on the spacing method you
chose. When entering a unit separation, you can enter the value in any
units you like; Informed Designer will perform the unit conversion for
you.

Display options

Use the ‘Draw every’ check box and text entry box to control the visual
density of grid lines on your form. When you check this box, you can
specify how many grid lines are drawn across your form. For example, if
the horizontal grid lines are spaced at five divisions per inch, and you
type ‘5’ into the adjacent text entry box, then one vertical line will be
drawn for every five vertical lines on the grid (i.e. one grid line every
inch). If you leave the ‘Draw every’ check box unchecked, then grid lines
will not be drawn in that direction.

You can also control how grid lines are drawn relative to the objects on
your form. Select the ‘Behind objects’ radio button if you want objects on
your form to overlap the grid lines. Alternately, select the ‘In front of

The grid

The small diagram 
indicates the type 
of grid separation.

For more information about
entering measurements and unit
conversion, see Appendix B,
Entering measurements.
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objects’ option if you want the grid lines to overlap the objects on your
form.

The ‘Drawing accuracy’ pop-up menu controls the amount of precision
that Informed Designer allows when you draw, resize, and position
objects. This control is described in Drawing accuracy later in this
chapter.

Guide lines

Guide lines run vertically and horizontally along the drawing area of your
form. Like the grid, you use guide lines as an alignment aid. However,
they differ from grid lines because you create and adjust each guide line
independently—one line at a time. With the help of the rulers you can
place a guide line at any position on the drawing area, allowing you to
align objects to a specific position on your form.

Guide lines are displayed by selecting the Show Guides command from
the Layout menu. When guide lines are visible, the corresponding
command becomes Hide Guides. Select this command to hide the guide
lines. If you’re using a color monitor, guide lines will appear in blue.

Creating and removing guide lines

Before creating a guide line, make sure that the rulers are visible. Then,
click in the content area of either ruler and drag the mouse onto the
drawing area of your form. Release the mouse button when the new guide
line is aligned at the desired position.

…drag …

Click anywhere 
in the ruler's 
content area… …and release.

Fig. 4-13
Creating a guide line

You can also use the Align
command to align objects on your
form. For more information, see
Aligning objects in chapter 7.

Show/Hide Guides
Layout menu
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To remove a guide line, click and drag it back into the content area of the
ruler, or drag it completely off the top or left edge of the drawing window
if the rulers aren’t displayed.

Using guide lines

Similar to the grid, you use guide lines to align objects in one of two
ways: visually, or automatically with the Snap To Guides feature. When
used visually, you position and size an object by eye so that its edge lies
against the guide line.

Click and 
drag to the 
appropriate 
guide line.

Fig. 4-14
Visual alignment to a guide line

The Snap To Guides feature

When drawing, dragging, or resizing an object, you can have Informed
Designer automatically snap the object to the guide lines on your form.
You do this by choosing the Snap To Guides command from the Layout
menu.

With the Snap To Guides feature on, any object that you manipulate (by
drawing, dragging, or resizing) will automatically align to the nearest
guide line, provided that the object falls within the guide line’s ‘sensitiv-
ity area’. Suppose that guide lines have a sensitivity of five pixels. Then if

Guide lines

Note If you reduce the size of the drawing area (using the Drawing Setup
command), Informed Designer will automatically remove any guide
lines that no longer lie in the drawing area.

Snap To Guides
Layout menu
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you move an object to within a five pixel distance of guide line, the object
will automatically snap to lie exactly along the line.

You set the sensitivity of all guide lines using the Guide Options com-
mand. For more information, see Guide options below.

By default, Informed Designer snaps an object’s edge to a guide line.
However, you can snap the center of an object’s frame instead. This
option is set using the Guide Options command. For more information,
see Guide options below.

Fig. 4-15
Frame edge snapped to guide (left) vs. frame center (right)

While the Snap To Guides feature is on, a check appears beside the
corresponding menu item. Subsequently each time you draw, drag, or
resize an object, automatic snapping of its edges will occur. To turn the
snapping feature off, choose the Snap To Guides command again. The
menu item will be unchecked, allowing you to manipulate objects on a
pixel by pixel basis.

The Snap To Guides feature works regardless of whether or not the guide
lines are displayed.

Guide options

With the Guide Options command you can set the guide line options.
These options include the guide sensitivity, display options, alignment
options, and guide locking.

To set the guide line options, choose the Guide Options command from
the Layout menu. The dialog shown at the top of the next page appears:

Guide Options…
Layout menu
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Fig. 4-16
Guide Options dialog

Guide line sensitivity

You control the guide line sensitivity by typing the desired value in the
Sensitivity text entry box. The value that you enter specifies how close
together an object and a guide line must lie before snapping will occur.
For example, if you enter a value of ten, an object must lie ten pixels or
less from a guide line before snapping will occur (of course, the Snap To
Guides feature must be on).

Display options

With the ‘Draw guides’ feature, you can specify whether guide lines are
drawn above or below the objects on your form. Select ‘Behind objects’
to draw guide lines below objects. Alternately, choose ‘In front of
objects’ to draw guide lines above objects.

Snapping options

With the Guide Options dialog, you can choose between two methods of
snapping. If you select the ‘Center of object frame’ option, the center of
an object’s frame will snap to the guide lines. Alternately, if you choose
the ‘Edge of object frame’ option, the edge of an object’s frame will snap
to the guides instead.

If you’re using guide lines to align adjacent objects, the ‘Center of object
frame’ option is more appropriate. This way, the frames of adjacent
objects will overlap.

Guide lines
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Fig. 4-17
Snapping frame centers

On the other hand, if you want to align a set of objects along a horizontal
or vertical path, then it’s more useful to snap the objects along their frame
edges.

Fig. 4-18
Aligning fields along their right edges

Locking the guide lines

If you want to lock the guide lines, check the Lock Guides check box on
the Guide Options dialog. This prevents you from accidentally moving
the guide lines while you’re editing your form.
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View scale

While editing your form, you can change the view scale of the drawing
window. Changing the view scale allows you to view more or less of the
drawing area in the drawing window. By reducing the view scale you can
see and work with a larger area of the form. By enlarging the view scale
you can work with your form close up for greater precision.

Informed Designer provides you with a set of commands and a tool that
allow you to change the view scale of the drawing window. You can vary
the view scale anywhere from 25% through to 1600% of the drawing
area’s actual size.

Changing the view scale

You change the view scale of the drawing window by using the Zoom
tool or any of the window scaling commands found in the Layout menu.
Informed Designer allows you to view a form at 25, 50, 100, 200, 400,
800, and 1600 percent of its actual size.

View scale

Fig. 4-19
A form viewed at 25% (left) and 1600% (right) of its actual size
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When you change the view scale, the elements of your form are enlarged
or reduced accordingly. However, Informed Designer’s drawing aids such
as the rulers, grid lines, guide lines and object handles always remain the
same size.

The current view scale of the drawing window can be seen in the infor-
mation box near the lower-left corner of the drawing window.

The Zoom tool

The Zoom tool (the ‘magnifying glass’) enlarges or reduces the view
scale of your form. To use the Zoom tool, first select it from the tool
palette and position the pointer at the position of interest on the drawing
window. Click the mouse button once to bring your form to the next
larger scale (from 100 to 200 percent, for example). The information box
at the lower-left corner of the drawing window will change to indicate the
current view scale.

When enlarging a drawing with the Zoom tool, the area on the drawing
that lies under the Zoom tool will be centered in the drawing window
when you click the mouse button.

The area under the zoom tool…

Fig. 4-20
Before clicking the Zoom tool

View scale information

The Reduce and Enlarge com-
mands also change the view
scale. See below for more
information.

Zoom tool
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…is centered in the drawing window when you click the mouse.

Fig. 4-21
After clicking the Zoom tool

Similarly, you can reduce the current view scale of the drawing window
by clicking the Zoom tool in the drawing window while holding down the
Option key.

To change the view scale of the drawing window to its actual size, simply
double-click the Zoom tool on the tool palette. This changes the drawing
window’s view to 100% (actual size).

The view scaling commands

Like the Zoom tool, the view scaling commands provide you with a
means of enlarging and reducing the view scale of the drawing window.
With the scaling commands, the same range of views are supported (from
25 to 1600 percent).

Actual Size

The Actual Size command sets the view scale to 100%. As its name
suggests, using the Actual Size command scales the drawing window to
its actual printed size. To use the Actual Size command, select it from the
Layout menu. The information box in the lower left corner of the drawing
window will show 100%.

Zooming out 
with the 
Zoom tool

View scale

The Actual Size command also
changes the view scale to 100%.
See below for more information.

The view scaling commands 
(from the Layout menu)

Actual Size
Layout menu
Command-1
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Fit To Window

To fit the drawing area entirely in the drawing window, select the Fit To
Window command from the Layout menu. The amount of scaling
required is determined automatically based on the size of the drawing
area and the current size of the drawing window. When you choose this
command, Informed Designer always tries to make the form as large as
possible while still ensuring that it appears completely in the drawing
window.

Fig. 4-22
Fitting a form to the drawing window

Subsequently resizing the drawing window (either manually or by
clicking the window’s zoom box) doesn’t automatically change the view
scale. To once again fit the drawing area in the drawing window, you
must choose the Fit To Window command again.

Fit To Window
Layout menu

Note Even if the drawing area doesn’t fit entirely in the drawing window
at the 25% view scale, the Fit To Window command will never
reduce the view scale below 25%.
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Enlarge

The Enlarge command enlarges the view scale to the next larger scale.
This command is enabled only if the current view scale is less than
1600%. To enlarge the view scale, select Enlarge from the Layout menu.
The information box in the lower-left corner of the drawing window
changes to indicate the new view scale.

Reduce

The Reduce command reduces the view scale to the next smaller scale.
This command is enabled only if the current view scale is greater than
25%. To reduce the view scale, select Reduce from the Layout menu.

Drawing accuracy

Drawing accuracy refers to the level of precision with which you can size
and position objects on your form. The higher the drawing accuracy, the
more control you have over an object’s exact size and position.

Drawing accuracy is measured in dots per inch (dpi). The number of dots
per inch corresponds directly to how accurately you can position or size
an object within a one inch distance. For example, if the drawing accu-
racy were 72 dpi, the smallest distance that you could move an object
would be 1/72nd of an inch.

72 dots

Fig. 4-23
72 dpi drawing accuracy

The drawing accuracy of your Macintosh screen—sometimes called
screen resolution—is 72 dpi. This means that in any direction, there are
72 dots, or pixels, from one inch to the next. Therefore, when the view
scale of the drawing window is 100% (actual size), moving an object
from one pixel to the next will move the object a distance of 1/72nd of an
inch. You can change the view scale of the drawing window using either
the Zoom tool or the view scale commands in the Layout menu. See View
scale for more information.

Reduce
Layout menu
Command-<

Enlarge
Layout menu
Command->

Drawing accuracy
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If you change the view scale of the drawing window, you effectively
change the drawing accuracy as well. Each time you enlarge the view
scale, the drawing accuracy doubles. This is because although everything
becomes twice as large, you can still move an object one screen pixel at a
time (which is now half the distance). If you enlarge the view scale from
actual size to 200%, the drawing accuracy changes from 72 to 144 dpi.
The smallest distance that you can move or resize an object changes from
1/72nd to 1/144th of an inch.

Informed Designer allows a maximum drawing accuracy of 1152 dpi.
This means that you can change the position or size of an object by a
distance as small as 1/1152nd of an inch. In order to obtain this level of
precision, you have to change the view scale of the drawing window to
1600%.

Limiting the drawing accuracy

Even though precise drawing accuracy is often necessary to position
objects exactly on your form, you should be aware of possible—and often
unexpected—alignment problems that can result when you manipulate
objects at different view scales.

Suppose that you enlarge the view scale of the drawing window to 400%
and draw a thin vertical line three pixels to the right of one inch. Since the
drawing accuracy is 288 dpi at 400%, the distance of three screen pixels
is 3/288ths of an inch.

Important You can select a maximum drawing accuracy by choosing a
setting from the ‘Drawing accuracy’ pop-up menu on the Grid
Options dialog. Informed Designer will limit the drawing accuracy to
this setting, even if you change the view to a larger scale. See
Limiting the drawing accuracy below.
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288 dots

2 dots past one inch

Fig. 4-24
Drawing a line at 288 dpi drawing accuracy

After drawing the line, let’s say that you change the view scale back to
actual size and draw another line over top of the first one. Since the
maximum drawing accuracy is only 72 dpi when the view scale is 100%,
you wouldn’t be able to position the second line as accurately as the first.
Even though the two lines would appear to be at the same position, their
exact locations would be different. This would become apparent if you
enlarged the view scale, or if you printed the form on a high resolution
output device.

Fig. 4-25
Two lines at 100% (left) and 400% (right)

To avoid this problem, Informed Designer allows you to limit the
drawing accuracy. You can choose a maximum drawing accuracy using
the ‘Drawing accuracy’ pop-up menu on the Grid Options dialog.

Drawing accuracy

Grid Options…
Layout menu
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Fig. 4-26
Choosing a drawing accuracy

When you limit the drawing accuracy, Informed Designer restricts the
placement of objects to the corresponding resolution. For example, if you
choose a maximum drawing accuracy of 72 dpi, Informed Designer won’t
allow you to move an object less than 1/72nd of an inch, even if you
enlarge the view scale to 200% or more.

By restricting the drawing accuracy to 72 dpi, you could avoid the
alignment problem discussed above. When you’d try to draw the first line
at three pixels to the right of one inch, Informed Designer would force the
position of the line to 1 and 1/72nd of an inch—an even multiple of the
drawing accuracy. At the 100% view scale, you could then draw the
second line precisely on top of the first.
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This chapter describes Informed Designer’s drawing tools. You’ll learn
about the different types of objects and the options that control their
appearance. You’ll also learn how to draw and manipulate objects using
the drawing tools. Figure 5-1 below shows Informed Designer’s tool
palette.

Line tool

Text tool

Rectangle tool

Table tool

Oval tool

Arc tool

Polygon tool

Field tool

Fig. 5-1
The tool palette

This chapter provides information about object types and their appearance
attributes. For information about changing an object’s appearance, see
Changing an object’s appearance.

The tool palette

The tool palette provides access to Informed Designer’s drawing tools. In
addition to the drawing tools, the tool palette also contains the Pointer
tool and the Zoom tool.
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Pointer tool

Drawing tools

Zoom tool

Title bar

Close box

Fig. 5-2
Parts of the tool palette

The Pointer tool selects, deselects, repositions, and resizes objects on
your form. The Zoom tool changes the view scale of the drawing win-
dow. For more information about the Pointer tool, see Selecting objects.
For information about the Zoom tool, see Changing the view scale.

Like any palette, you can show or hide the tool palette and drag it to a
different position on your screen. To show the tool palette, choose the
Show Tools command in the Layout menu. This command changes to
Hide Tools when the tool palette is displayed. Choosing Hide Tools
closes the tool palette. You can also hide the tool palette by clicking its
close box in the title bar. To move the tool palette on your screen, click
and drag its title bar to a new position.

You select a tool by clicking it on the tool palette. When a tool is se-
lected, it’s highlighted—that is, the tool appears black.

Since you use the Pointer tool often, Informed Designer offers two
shortcuts for selecting it. First, pressing the key located at the top-left of
your keyboard will toggle the current tool between the Pointer tool and
the last drawing tool used. Depending on which style of keyboard you’re
using, this key will be either the Escape key or the reverse quote (`) key.

The second shortcut allows you to temporarily select the Pointer tool
while using any other tool. While using a drawing tool, you can press the

Show/Hide Tools
Layout menu

Escape key
` key

Option key
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Option key to select the Pointer tool. As long as you hold down the
Option key, the Pointer tool will remain in effect. When you release the
Option key, the current drawing tool will become active again. This
shortcut is useful if you want to quickly move or resize an object while
you’re using the drawing tools.

The Text tool

Use the Text tool to draw text or edit text objects. You can also use the
Text tool to edit the titles of fields and tables. Select the Text tool by
clicking it on the tool palette.

As a shortcut, you can select the Text tool by pressing the Tab key once.
In addition to selecting the Text tool, pressing Tab will also select the
characters of the first text, field, or table object on your form (based on
top-left to bottom-right position). If a text, field, or table object is
selected, pressing Tab will select the characters of that object instead.

Drawing a caption

To draw a caption (a title or heading), select the Text tool and position the
pointer where you want the caption to start; the pointer changes to an I-
beam. Then click the mouse and start typing.

Fig. 5-3
Drawing a caption

While you type, you can begin a new line by pressing the Return key. If
you try to type past the edge of the drawing area, your text will automati-
cally wrap to the next line. When you finish typing, press Enter or select
another tool; Informed Designer selects the object as a whole (that is, the
object will show handles at its corners).

Unlike paragraphs of text (see next section), the dimensions of a caption
automatically change when you edit it. For example, if you insert new
words or change the object’s font size, Informed Designer will automati-
cally adjust the object’s width and height to fit tightly around the text.
However, once you’ve resized the object using the Pointer tool, its
dimensions will no longer adjust automatically.

Text tool

I-beam pointer
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Drawing a paragraph of text

You can specify the margins of a text object by drawing a rectangle with
the Text tool before you begin typing. This is useful for drawing para-
graphs of text.

To create a paragraph, select the Text tool and position the pointer where
you want the top and left margins to be. Then click and drag to draw a
rectangle. As you drag, a rectangular outline appears, shrinking and
expanding to follow the movement of the mouse. Release the mouse
button when the outline is the right size. Then you can start typing your
paragraph.

Fig. 5-4
Drawing a text rectangle

When text reaches the edge of the object’s rectangle, it will automatically
wrap to the start of the next line. If you type past the bottom edge of the
rectangle, Informed Designer will extend the edge to accommodate any
additional lines.

When you finish typing, press Enter or select another tool. The bottom
edge of the object’s rectangle will automatically snap up to the bottom
edge of the last line of text and the object will be selected.

If you hold down the Option key while pressing Enter, the object’s right
edge will snap to fit tightly around the width of the longest line of text.
This will happen if the initial width of the paragraph is wider than the
longest line that you type.

Drawing text in a box

Informed Designer makes it easy to draw text inside a box. Instead of
drawing a rectangle with the Text tool (as described above in Drawing a
paragraph of text), simply select a rectangle object with the Pointer tool
and start typing. The text you type will automatically align itself inside
the rectangle.

Click…

…drag

…release…

…and type.

The Text tool
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Fig. 5-5
Typing in a box

As before, when you finish typing, press Enter or select another tool.
Informed Designer will snap the bottom edge of the object’s rectangle to
the bottom edge of the last line of text, then select the object as a whole.

As in the case of drawing a paragraph, holding down the Option key
while pressing Enter will snap the right edge of the object to fit closely
against the longest line of text.

Editing text

Use the Text tool to edit the words or characters of an existing text object.
Field, table, and column titles are edited the same way.

To edit a text object or title, select the Text tool and click the text that you
want to edit. Then begin typing. Use these standard Macintosh editing
techniques to change the text:

Select with the Pointer tool…

…and start typing.

Note This feature works only when a single rectangle object is selected.
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❏ type to insert characters,

❏ backspace to remove characters,

❏ click and drag to select text,

❏ select and type to replace text,

❏ select and backspace (or use the Clear command) to remove text.

If you’re unfamiliar with the standard editing techniques outlined above,
please consult your Macintosh Owner’s Guide.

As always, when you finish typing, press Enter or select another tool.
Informed Designer will snap the bottom edge of the object’s rectangle to
the bottom edge of the last line of text, then select the object as a whole.
If you hold down the Option key while pressing Enter, the right edge of
the object will adjust automatically to fit around the longest line of text.

Text dimensions

The dimensions of a text object determine the maximum width of each
line. When you draw a paragraph of text (see Drawing a paragraph of
text), or when you draw text in a box (see Drawing text in a box), the
width of the text object is fixed. This means that as you type, the text
automatically wraps to stay inside its preset width. There’s no need to
press the Return key at the end of each line. If you draw a caption by
clicking and typing, the width of the text object is determined by the
length of the longest line that you type. You’ll start a new line only if you
type past the end of the drawing area or if you press the Return key.

Note You can also edit text by using Clipboard commands. See Cutting
and Copying text and Pasting text for more information.

The Text tool



5 - 8 Chapter 5: Drawing tools

Whenever you edit a caption, the width of the text object will change
freely to fit around the longest line. If you resize the text object with the
Pointer tool, the object becomes a paragraph of text with a fixed width. If
you want to change a paragraph of text to a caption, simply hold down the
Option key when you press the Enter key after editing the text. The
object’s width will expand or contract to fix around the object’s longest
line.

The appearance of text

The appearance of text is controlled by changing attributes such as the
font, font size, type style, alignment, and leading. Some attributes apply
to entire text objects, whereas others apply to individual characters.
Individual characters each have the following attributes: font, font size,
and type style (with the exception of white type). Each text object (as a
whole) has these attributes: white type, leading, horizontal alignment,
color, and pen shade (see Using shaded text below). For a complete
description of text attributes and how to set them, see Type settings. See
Paint settings for information about the color attribute.

When you draw a new text object, its type attributes and color are initially
set to the current default settings for the Text tool. For example, if the
default font is Times, each new text object that you draw will be Times.
For instructions on changing the default text attributes, see Changing
default settings.

Using shaded text

Forms often contain lightly shaded text that’s positioned under blanks to
bring special instructions to the filler’s attention. For example, the parts
of a form that are for office use only might be indicated so by using this
technique. An example is shown below.

Fig. 5-6
Example of shaded text
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You can shade a text object by selecting an appropriate pen setting. Like
any object that has a pen setting, you change the shading of a text object
by first selecting the object (or objects), then choosing a different setting
either from the Pen submenu under Style, or by using the Paint command.

Fig. 5-7
Paint Settings dialog

You can’t shade the text titles of fields, tables, and table columns.
Only the text of text objects can be shaded.

Like other objects that have a pen setting, you can’t set the pen shade of a
text object to ‘Block’. This setting is not available. Also, if a text object is
shaded, selecting the White Type type style attribute will reverse the
shade through any overlapping objects. For example, a text object with a
25% pen shade and the White Type attribute selected will appear with a
75% pen shade when placed over a black box.

The Line tool

Use the Line tool to draw lines on your form. Select the Line tool by
clicking it on the tool palette; the pointer changes to a cross.

To draw a line, position the pointer where you want the line to start. Then
click and drag the pointer to where you want the line to end, and release
the mouse button. The new line is drawn and selected.

Note

Line tool Cross pointer

The Line tool
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Click…

…drag…

…and release…

…the new line is 
automatically 

selected.

Fig. 5-8
Drawing a line

If you hold down the Shift key while drawing, the new line will be
constrained to the horizontal or vertical axis, or diagonally at 45, 135,
225, or 315 degrees.

The appearance of lines

The appearance of lines can be changed by changing attributes such as
the pen shade and line width. More specifically, each line has the follow-
ing attributes: pen shade, line width, line style, and color. Figure 5-9
below illustrates these attributes.

Pen shades:

Line widths:

Line styles:

50% 75% 100%

1 pt. 4 pt. 6 pt.

Plain Dashed Double

Fig. 5-9
Line attributes

The pen shade determines the darkness of the line. Changing the line
width changes the line’s thickness. Line styles include plain, dashed, and
various double line styles. Each line can also be colored. For a complete
description of line attributes and how to change them, see Paint settings.

When you draw a new line, its pen shade, line width, line style, and color
attributes are initially set to the current default settings for the Line tool.
For example, if the default line width for lines is 1 point, each new line
that you draw will be 1 point wide. For instructions on changing the
default line attributes, see Changing default settings.
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Rectangle tool Cross pointer

The Rectangle tool

Use the Rectangle tool to draw rectangles or boxes on your form. Select
the Rectangle tool by clicking it on the tool palette; the pointer changes to
a cross.

To draw a rectangle, position the pointer where you want a corner to start.
Then click and drag the pointer to the opposite corner and release the
mouse button. While dragging, a gray frame follows the movement of the
mouse. When you release the mouse button the new rectangle is drawn
and selected.

Click…

…drag…

…release…

…the rectangle 
is automatically 
selected.

Fig. 5-10
Drawing a rectangle

If you hold down the Shift key while drawing, the new rectangle will be
constrained to a square (all sides equal length).

The appearance of rectangles

The appearance of rectangles can be changed by changing attributes such
as the pen shade, fill shade, and line width. More specifically, each
rectangle has the following attributes: pen shade, fill shade, line width,
line style, color, and corner rounding. Figure 5-11 below illustrates these
attributes.

The Rectangle tool
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Oval tool Cross pointer

Fig. 5-11
Rectangle attributes

The pen shade determines the darkness of the rectangle’s frame. The
rectangle’s interior is drawn with the selected fill shade. Changing the
line width changes the frame’s thickness. Line styles (also used to draw
the rectangle’s frame) include plain, dashed, and various double line
styles. Each rectangle can also be colored. For a complete description of
the pen shade, fill shade, line width, line style, and color attributes and
how to change them, see Paint settings. For more information about
rounding corners, see Rounded corners.

When you draw a new rectangle, its appearance attributes are initially set
to the current default settings for the Rectangle tool. For example, if the
default fill shade for rectangles is 50%, each new rectangle that you draw
will be automatically filled with a 50% shade. For instructions on
changing the default rectangle attributes, see Changing default settings.

The Oval tool

Use the Oval tool to draw ovals and circles on your form. Select the Oval
tool by clicking it on the tool palette; the pointer changes to a cross.

To draw an oval, position the pointer where you want the oval to begin.
Then click and drag until the oval is the right size. An outline of the oval

Pen shades:

40% 50% 100%

Fill shades:
25% 50% 100%

Line widths:

1 point 2 points 4 points

Line styles:
Plain Dashed Double

Corners:

None All Some
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will appear and follow the movement of the mouse. When the oval is the
right size, release the mouse button. The new oval is drawn and selected.

Click…

…drag…

…release…

The new oval is 
automatically 
selected.

Fig. 5-12
Drawing an oval

If you hold down the Shift key as you draw, the new oval will be con-
strained to a circle.

The appearance of ovals

All ovals have pen shade, fill shade, line width, and color attributes. You
can change the appearance of an oval by changing any of these attributes.
These attributes are shown below in Figure 5-13.

Pen shades:

25% 60% 100%

Fill shades:

25% 75% 100%

Line widths:
1 point 2 points 4 points

Fig. 5-13
Oval attributes

The pen shade determines the darkness of the oval’s frame. The oval’s
interior is drawn with the selected fill shade. Changing the line width
changes the frame’s thickness. Each oval can also be colored. For a
complete description of the pen shade, fill shade, line width, and color
attributes and how to change them, see Paint settings.

As with lines and rectangles, newly drawn ovals inherit the default
attributes of the Oval tool. For example, if the default line width of the

The Oval tool
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Arc tool Cross pointer

Oval tool is 2 points, each new oval that you draw will have a frame
that’s two points thick. For instructions on changing the default oval
attributes, see Changing default settings.

The Arc tool

Use the Arc tool to draw arcs on your form. Select the arc tool by clicking
it on the tool palette; the pointer changes to a cross.

To draw an arc, position the pointer where you want the arc to begin.
Click and drag to the opposite end of the object. An outline of the arc will
appear and follow the movement of the mouse. When the arc is the right
size, release the mouse button. The new arc is drawn and selected.

Click…

…drag…

…release…

…the new arc is 
automatically 

selected.

Fig. 5-14
Drawing an arc

The initial motion of the mouse determines the direction and curvature of
the arc. For example, dragging the mouse up and to the right creates an
arc that slopes upward along the horizontal axis, while dragging the
mouse to the right and then up creates an arc that slopes upward along the
vertical axis. This is illustrated below.

You get this when 
you drag up and 
to the right.

You get this 
when you 
drag to the 
right and then 
up.

Fig. 5-15
Arc curvature
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The appearance of arcs

The appearance of arcs can be changed by changing attributes such as the
pen shade, fill shade, and line width. More specifically, each arc has the
following attributes: pen shade, fill shade, line width, and color. Figure 5-
14 below illustrates these attributes.

Fill shades:
40% 50% 90%

Pen shades:
60% 75% 100%

Line widths:
1/2 point 1 point 2 points

Fig. 5-16
Arc attributes

The pen shade determines the darkness of the arc. The arc’s interior (a
quarter oval), is filled with the selected fill shade. Changing the line
width changes the arc’s thickness. As well, each arc can be colored. For a
complete description of the pen shade, fill shade, line width, and color
attributes and how to change them, see Paint settings.

When you draw a new arc, its pen shade, fill shade, line width, and color
attributes are initially set to the current default settings for the Arc tool.
For example, if the default line width for arcs is 2 points, each new arc
that you draw will be 2 points thick. For instructions on changing the
default arc attributes, see Changing default settings.

The Polygon tool

Use the Polygon tool to draw polygons on your form. Select the polygon
tool by clicking it on the tool palette; the pointer changes to a cross.

To draw a polygon, move the pointer to where you want the first side to
start. Then click and release the mouse button. Move the pointer to the
end of the first line segment and click the mouse button to create the first
side of the polygon. Create the remaining sides of the polygon by

Polygon tool Cross pointer

The Polygon tool
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alternately positioning the pointer and clicking until the polygon has the
shape that you want.

…position to the end of 
the first line segment…

Click…

…alternate clicking and 
positioning to create the sides…

…drag near the starting point 
and click to close the polygon…

…the new polygon is 
automatically selected.

Fig. 5-17
Drawing a polygon

When creating the last side of the polygon, you can either join it with the
first side, or leave the polygon open. To join the last side with the first,
simply click once near the first end point of the polygon’s first side.
Informed Designer will automatically close and select the polygon. To
leave the polygon open, position the pointer where you want the last side
to end, then double-click the mouse button.

If you hold down the Shift key while positioning the pointer to create a
side, Informed Designer will constrain the side to lie on either of the
horizontal or vertical axes, or diagonally at 45, 135, 225, or 315 degrees.

The appearance of polygons

The appearance of polygons can be changed by changing attributes such
as the pen shade and line width. More specifically, each polygon has the
following attributes: pen shade, fill shade, line width, and color. Figure 6-
16 below illustrates these attributes.
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Fig. 5-18
Polygon attributes

The pen shade determines the darkness of the polygon’s sides. The fill
shade is used to draw the interior of the polygon. Changing the line width
changes the width of the sides. Each polygon can also be colored. For a
complete description of polygon attributes and how to change them, see
Paint settings.

When you draw a new polygon, its pen shade, fill shade, line width, and
color attributes are initially set to the current default settings for the
Polygon tool. For example, if the default line width for polygons is 1
point, the sides of each new polygon that you draw will be 1 point wide.
For instructions on changing the default polygon attributes, see Changing
default settings.

Reshaping a polygon

As with all objects, you can select, reposition, and resize a polygon using
the Pointer tool. However, when you resize a polygon, the relative
position of each vertex (the joining of two sides) always remains the
same. Notice that handles appear only on the corners of the smallest
rectangle that fits around the polygon.

Pen shades:

75%40% 100%

Fill shades:

25%10% 50%

Line widths:

1 point2 points 6 points

The Polygon tool
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Fig. 5-19
Resizing polygons

To change the position of a particular vertex, use the Reshape Polygon
command. First select the polygon with the Pointer tool, then choose
Reshape Polygon from the Arrange menu. Handles will appear at each
vertex of the polygon.

…drag…

…release

Click…

Fig. 5-20
Reshaping a polygon

Again using the Pointer tool, click and drag any vertex. The polygon will
remain in reshape mode until you deselect it.

The Field tool

Fields are graphic objects that hold information. Each field contains a
cell—a holding place for data. When you fill out a form, you enter
information into each cell.

Unlike other graphic objects such as lines, rectangles, and ovals; fields
are composed of various elements or parts. These parts automatically
appear when you draw a field, making it easy for you to draw the
graphics that commonly surround a cell. The structure of a field is shown
on the next page.

Reshape Polygon
Arrange menu
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Fig. 5-21
Parts of a field

There are a variety of options that you can use to change the general
appearance of a field. For example, you can show a field’s title on any
side of its cell, or you can hide the title altogether. You can turn the rule
lines and combs on or off, and you can change their appearance too.
Figure 5-22 below shows a variety of fields drawn with the Field tool.

Fig. 5-22
Sample fields

This section discusses the graphic attributes of fields. You’ll learn how to
draw a field and change its appearance. As well, you’ll learn how to
select and manipulate the parts of a field. For information about setting up
a cell’s data intelligence attributes, see the Data intelligence  manual.

Note Throughout this section you’ll learn how to select and manipulate
the parts of a field using the Field tool. For convenience, Informed
Designer allows you to use either the Field tool or Table tool for this
purpose.

Cell section

Title divider

Comb lines

Rule lines

Title section

The Field tool
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Drawing a field

To draw a field, select the Field tool by clicking it on the tool palette.
Position the pointer on the drawing area; the pointer changes to a cross.
Click where you want a corner to start and drag to the opposite corner.
When you release the mouse button, the field is drawn and selected.

Click…

…release…

…drag…
…the new field is 
automatically 
selected.

Fig. 5-23
Drawing a field

If you hold down the Shift key while drawing, the dimensions of the new
field will be constrained to a square (all sides will be of equal length).

Drawing over top of fields

The parts of a field are selected by clicking them with the field tool. You
can also change the size of a section by clicking and dragging its edge or
the title divider. Since the Field tool is also used for drawing new fields,
an option must be used if you want to draw a new field over top of an
existing field. To draw a new field over top of—or immediately adjacent
to—another field, hold down the Command and Options keys while
drawing.

The appearance of fields

As already mentioned, a field consists of various parts that are automati-
cally drawn, positioned, and resized as the field is manipulated. You can
change the appearance of a field by changing the position, size, or visual
attributes of each of its parts. You use the Field tool to select a part, or
change the dimensions of a part by dragging. The Field command allows
you to control the options associated with each part.

Field tool Cross pointer
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Fig. 5-24
The Field dialog

Although the Field command is referred to throughout this section, a
complete description of its use is not covered here. See Field settings
instead.

The title section

The title section commonly describes the information in a field’s cell. It
consists of a frame and the accompanying title text. To select the title
section, click it with the Field tool. An inset frame in the title section will
shimmer.

You can position the title section on any side of a field’s cell, or you can
hide it altogether. Use the Field command to choose an orientation for the
title section. Figure 5-25 below shows 5 fields, each with a different
position for the title section.

With the Field tool selected, the
pointer will look like an arrow while
over the title section.

The Field tool
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Title on top of field Title on the bottom

Title to the left Check box with title on the right

Combed field with 
no title showing

Fig. 5-25
Different positions for the title section

To edit the title text, use the Text tool and the appropriate text editing
techniques (see Editing text for more information). Like all text objects,
the title text has font, font size, type style, leading, and alignment
attributes. Use the Type command in the Settings menu or the various
Style submenus to change these attributes. See Type settings for more
information.

The title section has many of a rectangle’s visual attributes. For example,
you can change the pen and fill shades and adjust the thickness of the title
section’s frame; or you can change the amount of rounding on each
corner. Before choosing a setting, make sure that you first select the title
section by clicking it with the Field tool. For a complete description of
the pen shade, fill shade, and line width attributes, see Paint settings. For
information about rounding corners, see Rounded corners.

The title divider

If a field’s title section is on, the field will also have a title divider. The
title divider divides the field into two sections: the title section and the
cell section.

Like other parts of a field, you can select the title divider by clicking it
with the Field tool; the line will shimmer. Once you select the title
divider, you can change its appearance by changing the pen shade or line

As a shortcut, you can double-
click a field’s title section with the
Field tool to choose the Type
command.

Note Unlike other text objects, field titles can be vertically aligned within
the title section. See Type settings for more information.
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width. If you want to hide the line altogether, change its pen shade to
none. For information about the pen shade and line width attributes, see
Paint settings.

To change the height of the title section, use the Field tool to drag the title
divider in the appropriate direction (up/down or left/right, depending on
position of the field’s title). You can also click and drag the top edge of
the title section. See Resizing parts of a field later in this section.

The cell section

Like the blank on a form, the cell section represents the area of a field
where you enter information. It consists of a cell, a frame, and optional
rule lines and combs. To select the cell section, click it with the Field
tool. An inset frame in the cell will shimmer.

Even though you can’t see a cell’s text until you actually fill out the form,
Informed Designer allows you to specify the cell’s type characteristics
during the design process. When you fill out a form, each cell value will
be displayed with its preset type settings.

Fig. 5-26
Different cell type styles

Like the title section, you can choose the font, font size, type style,
leading, and alignment for each cell in each field. To change the type
attributes of a cell, first select it with the Field tool, then use the Type
command or the Style submenus to choose a different setting. For a
complete description of each type attribute, see Type settings.

Informed Designer allows you to show or hide the cells in fields and
tables. Choose the Show Cell Names command from the Layout menu to
display the cell names and their tab positions. When they’re showing, the
corresponding menu command becomes Hide Cell Names. Choose this
command to hide the cell names and tab positions.

When visible, a cell’s name and tab order are displayed using the current
type attributes of the cell. If you change a type attribute (for example,

The pointer changes when its over
the title divider.

As a shortcut, you can choose the
Paint command by double-
clicking the title divider with the
Field tool.

Show/Hide Cell Names
Layout menu

Note the appearance of the
pointer when it’s over the cell
section.

The Field tool
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choose a different font or font size), the cell’s name and tab position will
change to reflect the new setting.

Tab position Cell name

Fig. 5-27
A cell’s name and tab position

You can also use Informed Designer’s test facility to enter sample cell
values. This allows you to see what a filled in cell will look like and to
ensure that you’ve chosen the correct type settings. For information about
Informed Designer’s test mode, see Testing your form in the Data
Intelligence manual.

A field’s cell section also has many of the visual attributes of a rectangle.
You can change the pen and fill shades, and adjust the thickness of the
cell’s frame. You can also change the amount of rounding on each corner.
Before choosing a setting, make sure that you select the cell section first.
For a complete description of pen shade, fill shade, and line width
attributes, see Paint settings. For information about rounding corners, see
Rounded corners.

The rule lines

Each field cell can use optional rule lines; these control the vertical
spacing of information in a cell. You turn rule lines on and off using the
Field command (see Field settings).

Fig. 5-28
Field with (left) and without (right) rule lines

When rule lines are on, you can select them by clicking any rule line with
the Field tool. The lines will shimmer when they’re selected. You can set
the rule lines’ spacing by using the Field command or by clicking and
dragging any rule line with the Field tool.
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…release

Click and 
drag…

Fig. 5-29
Adjusting the rule line spacing

You can also change the appearance of the rule lines by changing their
pen shade and line width attributes. To do this, select the rule lines, then
use the Paint command or the Pen and Line Width submenus to choose a
different setting. For more information, see Paint settings.

Combs

Combs are the lines that divide a field into separate sections. Use the
Field command to turn them on or off and to control the height of each
individual comb line (see Field settings for more information).

Fig. 5-30
Combed field

The appearance of comb lines can be changed by choosing different pen
shades and line widths. To change the appearance of the comb lines, first
select any comb line by clicking it with the Field tool; all the comb lines
will shimmer when they’re selected. Then use the Paint command or the
Pen and Line Width submenus to select a different setting.

If the rule lines are turned on (see previous section), comb lines will
appear separately on each rule line. If the rule lines are turned off, then
only one set of comb lines appears in the cell section.

The pointer changes when it’s
over a rule line.

Note When rule lines are on, the leading of a cell’s information is con-
trolled by the rule line spacing and not by the leading type attrib-
ute.

The pointer changes when it’s
over a comb line.

The Field tool
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Fig. 5-31
Comb lines with rule lines off (left) and on (right)

When you fill out a combed field, Informed Designer will automatically
position each character you type in the proper spaces.

Fig. 5-32
Entering data to a field before (left) and after (right) tabbing

If rule lines and combs are turned on, and there are two or more lines in
the field, you must press Return at the end of each line when you enter
information in the cell. Otherwise, the characters that don’t fit on the line
will disappear when you move to the next cell.

Resizing parts of a field

After drawing a field, you can change its size using either the Pointer tool
or the Field tool. If you use the Pointer tool, the object is resized as a
whole. This means that the sizes of the title and cell sections will remain
proportional to each other. Resizing a field with the Pointer tool is
described in Resizing fields and tables.

You can resize the parts of a field using the Field tool. A part is resized
by dragging any of its edges in any direction. The pointer changes when
it’s over an edge.

Click and 
drag the 
top edge…

…the size 
of the title 
section 
remains the 
same.

Fig. 5-33
Resizing the cell section of a field.



5 - 27

When resizing fields, Informed Designer preserves the height of the title
section. To change the title height, hold down the Command key while
resizing.

If the rule lines are on, the Command key has a special purpose when
resizing the cell section with the Field tool. If you hold down the Com-
mand key, the bottom edge of the cell section will snap to the bottom of
each line as dragging occurs. This makes it easy to resize the cell section
to an exact multiple of rule lines.

The default appearance of fields

When you draw a new field, its initial appearance is determined by the
current default settings for the Field tool. For example, if the default
position of the title section is on the left, each new field that you draw
will have its title on the left. For instructions on changing the Field tool
defaults, see Changing field and table default settings.

The Table tool

Like fields, tables are graphic object that you use to hold information.
Each table contains one or more columns and each column contains a
cell—a holding place for data. When you fill out a form, you enter
information into each cell.

Unlike other graphic objects such as lines, rectangles, and ovals, tables
are composed of various elements—or parts—that automatically appear
when you draw a table. This makes it easy to draw a table without having
to draw the individual lines and titles that give a table its appearance. The
structure of a table is shown below.

The Table tool
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Fig. 5-34
Parts of a table

There are a variety of options that allow you to change the general
appearance of any table. For example, you can show or hide the table title
or column titles, or fill the alternating column rows with a shade. Figure
5-35 below shows a variety of tables drawn with the Table tool.

Rows 
alternately 
fiiled

Single 
column

Table title 
hidden

Fig. 5-35
Sample tables

In this section you’ll learn about the graphical aspect of tables; that is,
you’ll learn how to draw tables and change their appearance with the
Table tool. As well you’ll learn about selecting and manipulating parts of

Title dividers

Row lines

Column title sections

Column sections

Table title section
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tables. For information about the data intelligence attributes of table cells,
see chapter 1 in the Data intelligence manual.

Drawing a table

To draw a table, select the Table tool by clicking it on the tool palette.
Then position the pointer in the drawing area; the pointer changes to a
cross. Click where you want a corner of the table to start and drag to the
opposite corner. When you release the mouse button, the table is drawn
(without any columns) and selected.

Click…

…drag…

…release…

…the new
table is auto-
matically 
selected.

Fig. 5-36
Drawing a table

If you hold down the Shift key while you draw, the new table’s dimen-
sions will be constrained to a square (all sides will be of equal length).

Placing columns

Initially, a table doesn’t contain any columns (the interior of a new table
is gray). To place a column in a new table, click in the gray area with the
Table tool at the position where you want the new column to end. You
can drag while holding down the mouse button to see the width of the
column below the bottom edge of the table.

Note Throughout this section you’ll learn how to select and manipulate
the parts of a table using the Table tool. For convenience, Informed
Designer allows you to use either the Table tool or Field tool for this
purpose.

Table tool Cross pointer

The Table tool
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Click and drag in 
the gray area…

…the column is created when 
you release the mouse button.

Fig. 5-37
Placing a column

When you release the mouse button, the new column is created. Each
column has an optional title, a title divider (if the column title is on), and
a column cell. To place additional columns, continue clicking in the gray
area of the table.

To place the last column of a table, either click in the gray area to create
the column and drag its right edge until it lines up with the right edge of
the table, or simply click anywhere in the remaining gray area while
holding down the Command key. If you hold down the Command key,
Informed Designer will automatically snap the column’s right edge to the
right edge of the table.

Once you’ve completely filled a table with columns, you can place
additional columns using one of two different techniques. For more
information, please see Adding new columns to an existing table later in
this chapter.

Changing a column’s width

Once you create a column, you can change its width by clicking and
dragging either of its sides. Remember, if you drag the left side of the
leftmost column or the right side of the rightmost column, you’ll change
the width of the table too.

The pointer changes when it’s
over a column’s edge.
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Click and drag the 
column's edge to 
change its width.

Click drag…

Fig. 5-38
Changing a column’s width

If you change a column’s width by dragging a side that lies between two
columns, the widths of both columns will change. As you drag, Informed
Designer will display the width of the affected columns below the bottom
edge of the table. The measurements are shown using the current ruler
units. Informed Designer will constrain the pointer so that you don’t
make a column too narrow.

If you hold down the Command key while dragging a column’s side, only
the width of the column to the left (if there is one) will change. This
allows you to slide columns in either direction. You can use this option to
move columns to the left in a full table so that new columns can be
created.

Adding new columns to an existing table

Once you’ve completely filled a table with columns, you can add addi-
tional columns in one of two ways:

❏ by first making room in the table for another column

❏ by splitting one column into two.

You can make room for a new column either by extending the right edge
of the table or by making the width of an existing column smaller. As
you’ll learn in Resizing parts of a table, extending the right edge of a
table by default extends the right edge of the last column as well. How-
ever, if you hold down the Command key while extending a table’s right
edge, the size of the last column doesn’t change.

The Table tool
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Hold down the 
Command key as 
you click and 
drag…

…to create 
room for more 
columns.

Fig. 5-39
Making room for a new column

Similarly, if you press the Command key while shrinking the width of an
existing column, only the width of the column to the left (if there is one)
will change. The columns on the right will slide to make more room in
the table. The table will then contain a gray area in which you can create
a new column (see Placing columns earlier in this chapter).

You can also create a new column by splitting an existing column into
two. To split a column, simply click in its interior with the Field or Table
tool while pressing the Command key.

click with Table tool
while pressing Command

new column is inserted to 
the right of the pointer

Fig. 5-40
Splitting a column

If the existing column is too narrow to be split, Informed Designer will
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sound a beep.

Changing a column’s position

Informed Designer allows you to change the ordering of columns in a
table. To move a column, first click it or click its title with the Table tool.
Then choose the Move Left or Move Right command from the Move
Column submenu under the Arrange menu. The column is swapped with
the one to its immediate right or left.

Fig. 5-41

Moving a column to the left

Once a column reaches either end of the table, choosing a command to
move it further in that direction does nothing.

Distributing columns

Often you might want to make the width of all columns in a table the
same. Although you can do this manually by adjusting the size of each
column, Informed Designer provides a command to distribute columns
automatically.

Whenever one or more columns in a table are selected, the Distribute
command in the Arrange menu changes to Distribute Columns. Choose
this command to evenly distribute all columns in the table.

Fig. 5-42

Distribute Columns
Arrange menu

For information about selecting
parts of a table, see The appear-
ance of tables.

Left
Right

Arrange menu
Move Column submenu
Command- ← or →

For information about selecting
parts of a table, see The appear-
ance of tables.

The Table tool

If you select Cell2 and 
choose Move Left…

…it will change positions 
with Cell1.
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Before (above) and after (below) distributing columns

If there’s only one column in your table, the Distribute Columns com-
mand makes the column as wide as the entire table.

Removing a column

You can remove a column the same way you remove any object on your
form: select it, then choose the Clear command or press either of the
Delete or Backspace keys. The table is selected after you remove the
column.

Fig. 5-43
Before (above) and after (below) removing a selected column

Any columns to the right of the deleted column are moved left to take up
the space originally occupied by the deleted column.
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With the Table tool selected, the
pointer changes when it’s over a
title section.

The appearance of tables

A table consists of various parts that are automatically drawn, positioned,
and resized as the table is manipulated. The appearance of a table can be
changed by changing the position, size, or visual attributes of each part.
The Table tool is used to select a part or change the dimensions of a part
by dragging. The Table command allows you to control the options
associated with each part.

Fig. 5-44
Table dialog

Although the Table command is referred to throughout this section, a
complete description of its use is not covered here. See Table settings
instead.

The title sections

Each table has a table title and a column title for each column. A title
section commonly contains a descriptive identifier of the information
stored in the table or a column. A title section consists of a frame and the
title’s text. To select a title section, click it with the Table tool. An inset
frame in the section will shimmer.

The title sections of a table can be turned on or off using the Table
command. Figure 5-45 below shows three different tables with different
title sections showing.

The Table tool
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Table title and column 
titles showing.

Table title showing. No title sections 
showing.

Fig. 5-45
Tables with various title sections.

To edit the text of a table title, use the Text tool and the appropriate text
editing techniques (see Editing text for more information). Like all text
objects, the title section has font, font size, type style, leading, and
alignment attributes. Use the Type command in the Settings menu or the
Style submenus to change these attributes.

A table’s title section has many of the visual attributes of a rectangle. You
can change the pen and fill shades, and adjust the thickness of the title’s
frame. You can also change the amount of rounding on each corner.
Before choosing a setting, make sure that you select the title section first
by clicking it with the Table tool. For a complete description of the pen
shade, fill shade, and line width attributes, see Paint settings. For infor-
mation about rounding corners, see Rounded corners.

The title dividers

If any of the title sections are on, the table will also have title dividers.
These are the lines that divide either the table title from the columns, or
the column titles from the column cells.

Like other parts of a table, you can select a title divider by clicking it with
the Table tool; the line will shimmer. Once you’ve select a title divider,
you can change its pen shade or line width. If you want to hide the line
altogether, change its pen shade to none. For information about the pen
shade and line width attributes, see Paint settings.

As a shortcut, you can double-
click a title section with the Table
tool to choose the Type com-
mand.

Note Unlike text objects, title sections can also be vertically aligned. For
more information about type attributes, see Type settings.

The pointer changes when its over
the title divider.

As a shortcut, you can choose the
Paint command by double-
clicking a title divider with the
Table tool.
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To change a title section’s height, use the Table tool to drag the title
divider up or down. If you drag a column’s title divider, Informed
Designer will automatically adjust the dividers of all other columns as
well. You can also click and drag the top edge of the table’s title section.
See Resizing parts of a table later in this section.

The column sections

Like blanks on a form, the column sections are the parts of a table where
you enter information. Each column section has a column cell (which is
divided into rows) and a frame. To select a column section, click it with
the Table tool. An inset frame in the column section will shimmer.

Fig. 5-46
Table with its leftmost column selected

Even though you can’t see a column’s text until you fill out the form,
Informed Designer allows you to specify a column’s type characteristics
as you design your form. When you fill out your form, the values in any
column will appear with the type settings that you chose for that column.

Fig. 5-47
Different Type styles in different columns

Like the title sections of a table, you can choose the font, font size, type
style, leading, and alignment for each column in a table. To change the
type attributes of a column, first select the column with the Table tool.
Then use either the Type command or the Style submenus to choose a
different setting. When you choose a different setting, the type style of

Note the appearance of the
pointer when it’s over a column
section.

The Table tool
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the cell’s name and tab order in the selected column will change to reflect
the new setting. For a complete description of each type attribute, see
Type settings.

A column section also has many of the visual attributes of a rectangle.
You can change the pen and fill shades, and adjust the thickness of the
column’s frame. You can also change the amount of rounding on each
corner. Before choosing a setting, make sure that you select the column
section first. For a complete description of the pen shade, fill shade, and
line width attributes, see Paint settings. For information about rounding
corners, see Rounded corners.

The row lines

The row lines in a table determine the spacing of each column. You can
select the row lines by clicking any of them with the Table tool. The lines
will shimmer when they’re selected.

You can change the spacing of the row lines by using the Table command
or by clicking and dragging any row line with the Table tool. Informed
Designer will make sure that you don’t make the row height too small.

Fig. 5-48
Changing the spacing of row lines

You can change the appearance of the row lines by changing their pen
shade and line width attributes. To do this, select the row lines and then
use the Paint command or the Pen and Line Width submenus to choose a
different setting. You can also change the appearance of each alternating
row by filling them with a shade. Do this by selecting the row lines and
choosing the appropriate fill shade.

Click and drag in 
either direction to 
change the row 
spacing.

The pointer changes when it’s
over a row line.
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Fig. 5-49
Table with alternating rows filled

For more information about pen shade, fill shade, and line width attrib-
utes, see Paint settings.

Resizing parts of a table

After drawing a table, you can change its size by using the Pointer tool or
the Table tool. If you use the Pointer tool, the object is resized as a whole.
This means that the sizes of the title and column sections will remain
proportional to each other. Resizing a table with the Pointer tool is
described in Resizing fields and tables.

You can resize the parts of a table using the Table tool. A part is resized
by dragging any of its edges in any direction. The pointer changes when
it’s over an edge.

Fig. 5-50
Dragging the top edge of a table

When resizing tables, Informed Designer preserves the height of the title
section. To change the title height, hold down the Command key while
resizing.

Click and drag with 
the Table tool to 
resize individual 
table parts.

The Table tool
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The Command key has a special purpose when adjusting the bottom edge
of a table with the Table tool. If you hold down the Command key, the
bottom edge of the table will snap to each row line as dragging occurs.
This makes it easy to resize a table’s height to an exact multiple of rows.

Drawing over top of tables

The parts of a table are selected by clicking them with the Table tool. You
can also change the size of a table section by clicking and dragging edges
or divider lines. Since the Table tool is also used for drawing new tables,
an option must be used if you want to draw a new table over top of an
existing table. To draw a new table over top of (or immediately adjacent
to) another table, hold down the Command and Options keys while
drawing.

The default appearance of tables

When you draw a new table, its initial appearance is determined by the
current default settings for the Table tool. For example, if the default font
for the Table tool is Helvetica, then the font used for any subsequently
drawn tables will be Helvetica. For instructions on changing the Table
tool defaults, see Changing field and table default settings.
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After drawing an object, you can change its appearance by changing any
of its visual attributes. A visual attribute is a setting that controls a
particular characteristic of an object. Each different type of object has a
different set of visual attributes. For example, line objects have pen
shade, line width, line style, and color attributes. Changing any of these
attributes changes a line’s appearance.

In this chapter you’ll learn how to change an object’s visual attributes by
using a variety of Informed Designer’s commands. You’ll also learn how
to change the settings for new objects. For more information about
objects and how to draw them, see Drawing tools in chapter 5.

Overview

You change an object by selecting it and choosing a different setting from
either a settings dialog or a style submenu. The first five commands in the
Settings menu group the different attributes into five general categories.
Figure 6-1 below summarizes these commands.

Fig. 6-1
Settings commands

When you choose any of the above commands, a dialog appears showing
the current settings of any selected object. For example, Figure 6-2 below
shows the paint attributes of a red object with a 1 point, 100% frame, and
a 50% interior.

Controls table attributes.

Controls paint attributes.

Controls field attributes.

Controls roundness of corners.

Controls type attributes.
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Fig. 6-2
Sample Paint settings dialog

You can choose a different setting by clicking the various controls on the
dialog or by entering new values in the different text entry boxes.
Clicking OK dismisses the dialog and changes the selected object. You
can cancel the dialog by clicking Cancel instead.

When you choose a settings command, Informed Designer enables only
the controls that correspond to the attributes that apply to the selected
object (or objects). For example, if you select a line and choose the Paint
command, the fill shade and graduation controls will be disabled because
lines don’t have these attributes. When a control is disabled, it appears
gray and you can’t click it.

Using submenus

In addition to the commands available in the Settings menu, you can also
choose new settings using the Style menu. Each command in the Style
menu is a submenu with settings for a particular attribute. Not all attrib-
utes are available in the submenus and, for some attributes, you can
choose only from a few standard settings.

It’s often more convenient to use a submenu when you want to change
only one attribute of an object. For example, rather than using the Paint
command to choose a different pen shade, you could select a new setting
from the Pen submenu instead.

To use a submenu, first choose the command by clicking and dragging
with the mouse until the command name is selected (the name turns
black). A submenu will appear to the right of the command name. While

Overview

Style submenus

Submenus are sometimes called
hierarchical menus.
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still holding down the mouse button, drag the pointer over the desired
setting and release the mouse button.

Fig. 6-3
Choosing from a submenu

When you release the mouse button, the new setting is chosen and the
selected object (or objects) is changed. A check appears next to the
current setting.

Informed Designer will disable a Style command if the corresponding
attribute doesn’t apply to the selected object. For example, if you select a
text object, the Pen, Fill, Line Width, and Line Style submenus will be
disabled because text objects don’t have those attributes.

Changing multiple objects

Informed Designer allows you to change more than one object at a time.
Simply select the objects that you want to change and use a settings
command or submenu as described above. For information about select-
ing more than one object, see Selecting multiple objects.

If you choose a settings command while two or more objects are selected,
Informed Designer will show you only the current settings that are
common to all of the selected objects. If an attribute is set differently
among the selected objects, the controls that you use to set the attribute
will show a blank value. For example, suppose that you select three lines,



6 - 5

two of which have a pen shade of 50% and the other 100%. Suppose also
that the line width, line style, and color attributes are the same for all
three lines. If you choose the Paint command, this dialog will appear:

Fig. 6-4
Sample paint settings

The Pen text entry box is blank. This indicates that the pen shade setting
is different among the selected objects. You can choose a setting by
typing a new value then clicking OK to dismiss the dialog. The attribute
is changed to the new setting for each of the selected objects. If you leave
the setting blank, Informed Designer won’t change the attribute.

Dialogs use a variety of controls to present different attributes. These
include text entry boxes, check boxes, radio buttons, pop-up menus, and
scrolling lists. Figure 6-5 on the following page illustrates how a blank or
empty value is shown using each type of control.

Overview



6 - 6 Chapter 6: Changing an object’s appearance

Pop-up menus 
don't show any 
values.

Text entry boxes 
don't show any 
values.

Radio buttons 
don't show any 
choices. Check boxes 

appear gray.

Scrolling lists 
don't show any 
choices.

Fig. 6-5
Blank controls

Once you select a new setting (by clicking a control or entering a value in
a text entry box), there’s no way to change the setting back to the blank
value. If you want to avoid changing the attribute, you must cancel the
command by clicking Cancel instead of OK.

Like the settings commands, the Style submenus also show the current
settings of any selected objects. If a check appears in a submenu, you
know that the corresponding attribute has the same setting for each
selected object. If a setting isn’t common to all the selected objects, no
check will appear in the attribute’s submenu. To choose a new setting,
simply make your choice from the submenu.

Changing default settings

When you draw a new object, Informed Designer sets its visual attributes
to the current default settings. A default setting is automatically selected
when a new object is drawn. For example, if the default line width
attribute for lines is set to 1 point, each new line that you draw will (by
default) be 1 point wide.

When you create a new document, Informed Designer assigns it a
predefined list of default settings. These settings are listed in Appendix B.
You can change the default settings so that new objects automatically
appear with your preferred settings. For example, suppose that before

Submenu with no common setting.
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drawing a form you know that the font of all text objects will be Times.
Rather than changing the font each time you draw a new text object,
simply change the default font for the Text tool to Times before you start
drawing. Each subsequent text object that you draw will be Times.

To change a default setting, first deselect all objects on your form, then
choose a different setting in the normal way—by using the commands in
the Style or Settings menus. With the Pointer tool selected, default
settings are changed for all drawing tools. If a particular drawing tool is
selected, the default settings are changed for that tool only.

When you use a settings command, the fact that you’re changing the
default settings will be noted in the dialog’s title. Figure 6-6 below shows
the Type command being used to change the default settings for the Text
tool.

Fig. 6-6
Default type settings dialog

You can also use the Style submenus to change default settings. If no
objects are selected, these submenus will show the current default settings
for all tools if the Pointer tool is selected, or for the currently selected
drawing tool. Choosing a different setting changes the current default.

Overview
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Setting field and table defaults

There’s a second way to change the default settings for the Field and
Table tools. If you double-click either of these tools on the tool palette,
Informed Designer will present a list of default styles to choose from.

Fig. 6-7
Default Field Styles dialog

Fig. 6-8
Default Table Styles dialog

After you make your choice, click OK to change the default settings. To
cancel the command, click Cancel instead.
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Locking an object’s settings

You can prevent the settings of an object from being accidentally changed
by locking the settings. You lock an object’s settings using the Object
command. Select the object whose settings you’d like to lock, then
choose Object from the Settings menu. The Object dialog appears.

Fig. 6-9
Locking an object’s settings

Click the Settings check box below the Lock heading, then click OK to
dismiss the Object dialog. To cancel the Object command, click Cancel
instead.

When an object’s settings are locked, Informed Designer ignores any
requests to change the object’s appearance. When you choose a different
attribute setting—for example, a new pen shade—only those selected
object’s whose settings are not locked are affected.

For information about the other settings available on the Object dialog,
see Locking an object’s position, Using object guides, and Objects and
printing.

Paint settings

All objects have paint attributes. Paint attributes determine an object’s
color and the appearance of its lines and shaded areas. This section
describes paint attributes and how to select them. For information about
drawing objects, see Drawing tools in chapter 5.

Paint settings

Object…
Settings menu
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Informed Designer offers two methods for changing paint attributes: the
Paint command in the Settings menu, and the Pen, Fill, Color, Line
Width, and Line Style submenus under Style. To use the Paint command,
select the object or part that you want to change, then choose the com-
mand. This dialog will appear:

Fig. 6-10
Paint Settings dialog

Choose a setting by clicking a control or entering a new value in a text
entry box. Then click OK or press Return to commit the change and
dismiss the dialog. To cancel the command, click Cancel instead.

The Pen, Fill, Color, Line Width, and Line Style submenus offer a
convenient method for changing a single paint attribute. To choose an
attribute, select the object or part that you want to change, then make your
selection from the appropriate submenu.

Fig. 6-11
Style menu and Paint submenus

Paint…
Settings
Command-M

For information about selecting
objects, see Selecting objects.

Fill Shade control

Pen Shade control

Graduation controls

Shade palette

Line Width
controls

Line Style
controls

Color
control
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For information about using submenus, see Using submenus. The
following sections describe each paint attribute.

Pen shade

The pen shade determines the darkness of lines and the frames of
enclosed objects. All types of objects  have a pen shade attribute.

The pen shade can be ‘None’ or a shade of gray. The ‘None’ shade is
invisible and transparent. A shade of gray is specified as a percentage of
black; the higher the percentage, the darker the shade. 0% is white and
100% is black. Below are various objects with different pen shades.

Fig. 6-12
Sample pen shades

To choose a pen shade, enter your choice on the Paint dialog or select a
standard shade from the Pen submenu. When you use the Paint command,
you can choose any pen shade by either typing in the Pen text entry box
or clicking anywhere on the shade palette.

Fig. 6-13
Changing the pen shade

Before you click the shade palette, make sure that the current value in the
Pen text entry box is selected. You can move from one text entry box to
the next by pressing the Tab key.

100%50%25%40%

…or clicking here

Change the pen shade 
by typing here…

Paint settings

Pen
Style menu
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Fill shade

The fill shade determines the appearance of a shape’s interior. You can
fill any enclosed object with your choice of fill shade.

The fill shade can be ‘None’, ‘Block’, or any shade of gray. The ‘None’
shade is invisible and transparent. The ‘Block’ shade is a pattern that’s
useful for covering areas of a form where typing must be hidden. A shade
of gray is specified as a percentage of black; the higher the percentage,
the darker the shade. 0% is white and 100% is black. Figure 6-14 below
shows examples of different fill shades.

Fig. 6-14
Sample fill shades

To choose a fill shade, enter your choice on the Paint dialog or select a
standard shade from the Fill submenu. When you use the Paint command,
you can choose a fill shade by either typing in the Fill text entry box or by
clicking anywhere on the shade palette (see Figure 6-13 above). Before
you click the shade palette, make sure that current value in the Fill text
entry box is selected.

Graduated fills

The fill shades of rectangles, fields, and tables can be graduated. A shade
that’s graduated blends from one value to another. Below are examples
of different graduated fills.

Fill
Style menu

25% 50% 75% 10%
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Rectangle 
graduated from 
right to left

Rectangle 
graduated from 
bottom to top.

Table with columns 
graduated from left 
to right.

Field with cell 
graduated from 
top to bottom.

Fig. 6-15
Objects with graduated fills

To create a graduated fill, enter the starting shade value in the Fill text
entry box on the Paint dialog. Then click the ‘Graduate to’ check box and
enter the ending shade value in the corresponding entry box.

Fig. 6-16
Choosing a graduated fill

You can’t choose a graduated fill with the Fill submenu.

The graduation direction is the direction in which the shade changes.
You can choose either ‘Left to right’ or ‘Top to bottom’ by clicking the
appropriate choice. You can achieve ‘right to left’ or ‘bottom to top’

Starting value 
goes here.

Ending value 
goes here.

Choose the graduation 
direction here.

Paint settings
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graduations by switching the values in the Fill and ‘Graduate to’ text
entry boxes.

Like the Pen and Fill shade values, you can enter a value in the ‘Graduate
to’ text entry box by clicking anywhere on the shade palette. The ‘None’
and ‘Block’ shades are not permitted when you use the ‘Graduate to’
option.

Line width

Each line and enclosed shape has a line width. The line width determines
the thickness of a line or a shape’s boundary. You can choose a line width
as small as 0.001 points and as large as 999 points.

Fig. 6-17
Sample line widths

Use the Paint command or the Line Width submenu to select a line width.
When you use the Paint command you can enter a line width by typing a
value in the Width text entry box, or by selecting a standard width from
the Width pop-up menu.

Fig. 6-18
Choosing a line width

Line Width
Style menu

6 points 4 points 2 points

Field

1 point

To change the line width, select 
a value from the popup menu…

…or type a value into 
the text entry box.
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Although you can choose a very thin line width, the thinnest printable line
width depends on the resolution of your printer. If you’re using an
ImageWriter printer, the thinnest printable line is 1 point, whereas if
you’re using a 300 dpi (dots per inch) laser printer, the thinnest printable
line is one quarter of a point. Higher resolution imagesetters can print
lines that are even thinner.

Line Style

Lines and rectangle frames can be drawn using a variety of line styles.
Line styles are grouped into two types: solid or dashed, and single or
double. Different line styles are shown below.

Fig. 6-19
Lines styles

To choose a line style, make your selection from either of the two Line
Style pop-up menus on the Paint dialog, or from the Line Style submenu.
The Line Style submenu is divided into two sections. The top section
contains the solid and dashed styles and the bottom section contains the
single and double styles.

You can combine different line styles with other attributes such as pen
shades and line widths. For example, you could choose a double-dashed
line style with a 50% pen shade.

The thickness and spacing of double lines is determined by the line width
that you choose. For the style where both lines are the same width, the
width of the lines and the space between them is the line width you enter.
For the styles where one line is thin and the other is thick, the width of the
thin line and the space between the two is the line width you enter. The
width of the thick line is twice the width of the thin line.

Dashed Double

Paint settings

Line Style
Style menu
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Color

Each object you create can be any color. You can change the color of
objects so they appear colored on your screen and in color when printed
on a color printer. You can also use Informed Designer’s color support to
print spot color overlays. For information about colors and how to define
them, see Defining colors. For information about spot color, see Spot
color.

To choose a color, select your choice from either the Color pop-up menu
on the Paint dialog or the Color submenu.

Type settings

You change the appearance of text by changing attributes such as the
font, font size, and type style. In addition to text objects, field and table
titles also have type attributes. For information about drawing and editing
text, see The Text tool. For information about fields and tables, see The
Field tool and The Table tool, respectively.

Informed Designer offers two methods for changing type attributes: the
Type command in the Settings menu, and the Font, Size, Type Style,
Alignment, and Leading submenus under Style. To use the Type com-
mand, select the object or characters that you want to change, then choose
the command. The Type dialog shown on the next page appears:

Important Only entire objects can be colored. This means that you can’t color
parts of a field or table differently, nor can you choose a separate
color for the pen and fill shades of an object.

Color
Style menu

Type…
Settings menu
Command-T

Font
Size
Type Style
Alignment
Leading

Style menu

For information about selecting
text, see Editing text.
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Fig. 6-20
Type Settings dialog

Choose a setting by clicking a control or entering a new value in a text
entry box. Then click OK or press Return to dismiss the dialog. To cancel
the command, click Cancel instead.

The Font, Size, Type Style, Alignment, and Leading submenus offer a
convenient method for changing a single type attribute. To choose an
attribute, select the object or characters that you want to change, then
make your selection from the appropriate submenu.

Fig. 6-21
Style menu and type submenus

For information about using submenus, see Using submenus. The
following sections describe each type attribute.

These control
the style of
text.

These control 
the alignment.

These  control the 
font, and font size.

Sample text 
appears here.

These control 
the leading.
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Font

Each font is identified by its name and a unique typeface. Only fonts that
are installed in your Macintosh system will appear both in the Type
dialog’s scrolling list and in the Font submenu. Use the Font/DA Mover
application supplied with your Macintosh computer to add and remove
fonts to and from your system file. For more information about this utility
application, please see your Macintosh Owner’s Guide.

To choose a font, click its name in the Font scrolling list on the Type
dialog, or select it from the Font submenu.

Font size

Font sizes range anywhere from 1 through 999 points. To choose a font
size, select your choice from the Size scrolling list on the Type dialog or
type directly in the text entry box below it. You can also choose a size
from the Size submenu.

9 point, 12 point, 18 point, 24 point
Fig. 6-22
Different font sizes

For the currently selected font, Informed Designer will show you which
font sizes are in your system file. Only those sizes in your system file
appear in the Size scrolling list on the Type dialog, and only those sizes
are outlined in the Sizes submenu. Font sizes installed in your system file
appear clearly on your screen. All other sizes are scaled screen fonts,
which may not look as good on the screen as they do when printed.

Type style

Type style refers to the style of a font. The appearance of each font can
vary by choosing from up to nine different type styles.

Times

Avant Garde

Helvetica

Courier
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Underline OutlineOutline ShadowShadow

White TypeCondensed Ex t e n d e d

Plain Bold Italic

Fig. 6-23
Type styles

Each type style can be used individually or combined with others. For
example, you could make a heading bold and then underline it for
emphasis.

To change the type style, click the corresponding check boxes on the
Type dialog, or choose a style from the Type Style submenu. If you
choose the Plain type style, all other type styles are turned off.

Leading

Leading refers to the amount of space between lines of text. By default,
Informed Designer automatically separates one line from the next by
enough space to hold the largest font size used in that line.

Fig. 6-24
Automatic leading

Warning When you select white type on text object, the text will disappear
until you drag it over top of a contrasting object. When you select
white type on a field or table title, Informed Designer will automati-
cally change the section’s fill shade to black (100%) if its current
setting is white (0%).

Note With the exception of White Type, all type styles can be applied to
individual characters in a text object.  The White Type style always
affects an entire text object or title.

Type settings

When you choose automatic 
leading,each line is spaced 
according to the largest 
font size used in that 
line of text.
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To choose automatic leading, click the radio button labelled Automatic on
the Type dialog or select Auto in the Leading submenu.

Alternately, you can enter a specific leading value if you want line
spacing to be consistent. When you use a fixed amount of leading, all
lines are spaced equally.

Fig. 6-25
Leading by points

When you use the Type dialog, click the ‘Leading by’ radio button, then
enter (in points) the leading amount in the text entry box. You can also
choose a leading value from the Leading submenu. The Leading submenu
lists only a few common choices.

Alignment

Alignment refers to the relative positioning of lines within a text object or
title section. You can align text along its left or right edge, or along its
center. You can also justify text so that both the left and right edges align.
Figure 6-26 below illustrates left, right, center, and justify alignment.

You can left 
align a text 
object.

You can right 
align a text 

object.

You can align a 
text object on 

its center.

Or you can justify a 
text object so that 
both sides align.

Fig. 6-26
Left, right, center, and justify alignment

Unlike text objects, the titles and cells of field and table objects can also
be aligned vertically.

This is a sample
of twelve point leading.
All the lines  are spaced
equally apart.

This is a sample

of eighteen point 

leading

Note While you edit justified text, the text will appear left aligned. Only
when you finish typing (and press Enter or choose a different tool)
does the text object display justified.
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Fig. 6-27
Vertical alignment

Alignment is controlled by clicking the appropriate radio button below
‘Alignment’ on the Type dialog, or by selecting a choice from the
Alignment submenu.

Rounded corners

You can round the corners of rectangles and rectangular parts of fields
and tables. Informed Designer allows you to round individual corners
separately. This means that each corner can have a different amount of
rounding.

Fig. 6-28
Objects with rounded corners

A corner can have up to 2 inches of rounding. The amount of rounding
corresponds to the distance between the rectangle’s edge and the end of
the arc that forms the corner. The corner shown below has 0.5 inches of
rounding.

Fig. 6-29
Corner with 1/2 inch rounding

To round an object’s corners, first select the object or part that you want
to change. Then choose the Corners command from the Settings menu.
The dialog on the following page appears:

Rounded corners

0.5 "

0.5 "

Corners…
Settings menu

For information about selecting
objects, see Selecting objects.
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Fig. 6-30
Rounded Corners dialog

To round all of an object’s corners, click the ‘All corners’ radio button
and enter a value in the corresponding text entry box. To round individual
corners, click the ‘Individual corners’ button and enter values in the text
entry boxes at each corner of the sample rectangle. After entering your
choice, click OK or press Return. To cancel the Corners command, click
Cancel instead.

The rounding values are always displayed in the current ruler units.
However, you can enter the values in any units you like; Informed
Designer will automatically convert the value for you. After you enter a
value, press the Tab key. Informed Designer will update the sample
rectangle to reflect the new value that you entered.

Field settings

You can change the appearance of fields with the Field tool or with the
Field command. Use the Field tool to draw a field and manipulate its
parts. You use the Field command to control the options associated with
fields. This section describes the Field command. For information about
drawing fields and the parts of fields, see The Field tool.

To use the Field command, select the field that you want to change, then,
from the Settings menu, choose Field. The Field Settings dialog appears:

For more information about
entering measurements and unit
conversion, see Appendix  B,
Entering measurements.
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Fig. 6-31
Field Settings dialog

The Field dialog is divided into three sections: Title, Rule lines, and
Combs. The Sample section displays the choices that you make. After
changing the settings, click OK.  Your changes are made to the selected
field. To remove the dialog and  cancel your changes,  click Cancel. The
controls on the Field dialog are described in the following sections.

Title

Click the Title check box to turn the field title on or off. When the title is
on you can choose its position by clicking any of the Top, Left, Bottom,
or Right choices.

Rule lines

You can divide a field into lines using the rule lines option. Click the
Rule lines check box to turn this option on or off. When rule lines are on
you can specify the line spacing using the controls on the Field dialog, or
by clicking and dragging any line using the Field tool. See The rule lines
for information about manipulating rule lines with the Field tool.

You can enter the rule line spacing using one of three methods. Choose a
method by clicking the ‘Line separation’, ‘Lines per inch’, or ‘Lines in
field’ radio button. Enter a value in the text entry box below the radio
buttons. When you use the ‘Line separation’ option, enter the actual

Field settings

Field with rule lines
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distance that you want between each rule line. Enter either the number of
lines per inch or the number of lines in the field, respectively, when you
use the other two options. Values are displayed in the current ruler units,
but you can enter values in any units you like; Informed Designer will
perform the conversion for you.

Combs

You can use comb lines to divide the character spacing of a field into
equally spaced sections. Click the Combs check box to turn comb lines on
or off. When the combs are on, you can enter the number of divisions in
the text entry box provided. Furthermore, you can adjust the height of
each comb line individually. To do this, click the Set Heights button. The
Comb Heights dialog will appear.

Fig. 6-32
Comb Heights dialog

Using this dialog you can click and select each comb divider in the
scrolling list, then enter a different value in the text entry box below the
list. To change more than one divider line, select each one while holding
down the Command key, then enter the new value.

You can measure comb heights in either percentage of cell height, or
points. If you use the percentage of cell height option, the comb heights
will automatically adjust when you resize the field’s cell. Choose an
option by clicking either of the ‘%’ or ‘Points’ radio buttons.

Click OK when you’re finished changing the comb heights. To cancel all
changes, click Cancel instead.

Combed field

For more information about
entering measurements and unit
conversion, see Appendix B,
Entering measurements.
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Table settings

You can change the appearance of tables using either the Table tool or the
Table command. Use the Table tool to draw a table and manipulate its
parts. You use the Table command to control the options associated with
tables. This section describes the Table command. For information about
drawing tables and the parts of tables, see The Table tool.

To use the Table command, select the table that you want to change, then
choose the command from the Settings menu. The Table dialog will
appear.

Fig. 6-33
Table Settings dialog

The Table dialog is divided into two sections: the rows and titles. A
sample table illustrates the choices that you make. After changing the
settings, click OK to change the selected Table. To cancel the Table
command, click Cancel instead. The controls on the Table dialog are
described below.

Rows

Each table is divided into rows. You can change the distance between
each row by clicking and dragging any row line with the Table tool, or by
entering a value on the Table dialog.
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You can enter the row spacing using one of three methods. Choose a
method by clicking the ‘Row separation’, ‘Rows per inch’, or ‘Rows in
table’ radio button. The small diagram below the radio buttons changes to
illustrate your choice. Enter a value in the text entry box below the small
diagram. When using the ‘Row separation’ option, enter the actual
distance that you want between each row line. When you use the other
two options, enter either the number of rows per inch, or the number of
rows in the table, respectively. Values  are displayed with the current
ruler units, but you can enter values in any units you like; Informed
Designer will perform the conversion for you.

Titles

You can show or hide the title of a table or its columns. Click either of the
‘Show table title’ or ‘Show column headings’ check boxes to turn the
corresponding sections on or off. The sample table changes to show your
choices.

For more information about
entering measurements and unit
conversion, see Appendix B,
Entering measurements.
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Informed Designer provides a wide variety of commands and features
that allow you to manipulate objects. In this chapter you’ll learn how to
select, reposition, and resize objects with the Pointer tool. You’ll learn
how to use the Specs palette and the Clipboard, as well as the commands
summarized below.

Fig. 7-1
Arrange menu and associated object manipulation commands

Selecting objects

Before you can manipulate an object on your form, you must select it
first. With Informed Designer, you can select objects in one of two ways:
by using the Pointer tool, or by using the object selection commands
(Select All and Select Same) in the Edit menu.

When more than one object on your drawing is selected, all
subsquent object manipulations that you perform are applied to
all of those objects. Make sure that you select the right objects
before you choose a command.

Important

Duplicates objects once.

Duplicates objects  more than once.

Aligns objects.

Distributes objects and columns.

Resizes objects.

Rotates objects (except fields and tables).

Groups objects.
Ungroups objects.
Moves an object closer in the drawing.
Brings objects to the front of a drawing.

Moves objects to the back of a drawing.
Moves an object back farther in the drawing.

Reshapes Polygons.
Moves columns.



7 - 3Selecting objects

Using the Pointer tool

The Pointer tool selects objects in a variety of ways. Before you can use
the Pointer tool, you must first select it on the tool palette.

Since the Pointer tool is used quite regularly, Informed Designer offers a
shortcut for selecting it. In addition to clicking it on the tool palette, you
can select the Pointer tool by pressing the key located at the top-left
corner of your keyboard (either Escape or ‘`’). You can also select it by
holding down the Option key. See The tool palette for more information.

Selecting a single object

You can select a single object in one of two ways:

❏ Click the object
Position the pointer over the object you want to select and click the
mouse button. Handles appear on the object’s corners to indicate that
it’s selected.

Fig. 7-2
Clicking an object

❏ Draw a selection rectangle
Position the pointer outside of the object, then click and drag the
mouse to surround the object with a selection rectangle. When the
object is completely enclosed, release the mouse button.

When you select a text, field, or table object with the Pointer tool,
the entire object is selected as a whole. To select individual compo-
nents of these objects, see The appearance of fields and The
appearance of tables.

Note
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Fig. 7-3
Drawing a selection rectangle

Selecting multiple objects

You can select multiple objects in one of two ways:

❏ Shift-click individual objects.
To select objects by Shift-clicking, hold down the Shift key as you
click the individual objects. Holding down the Shift key causes any
previously selected objects to remain selected.

❏ Draw a selection rectangle.
Position the pointer outside of the objects that you want to select, then
click and drag the mouse to completely enclose them. This technique
is useful when the objects you want to select are positioned near each
other on your form.

Forcing a selection rectangle

Often you might want to draw a selection rectangle to select one or more
objects that are positioned above other objects on your form. If the
objects behind those that you want to select cover other areas of your
form, you might unintentionally select and drag one of them when you
attempt to draw the selection rectangle.

You can avoid this from happening by holding down the Option key or
the Option and Command keys together while drawing the selection
rectangle. The Pointer tool will act as though there are no objects under
the position where you click to begin drawing the selection rectangle.
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…hold down the Option or the 
Option and Command keys while 
drawing a selection rectangle.

To select objects on top of others…

Fig. 7-4
Forcing a selection rectangle

If you hold down the Option key to force a selection rectangle, all objects
that are completely enclosed within the rectangle will be selected when
you release the mouse button. If you hold down the Option and Command
keys instead, all objects that intersect the drawn rectangle will be se-
lected.

Selecting through objects

When you click the pointer to select an object, the front most object that
lies below the pointer is selected. Often you might want to select an
object that is obscured by other objects. Instead of moving these objects
to reveal the object that you want to select, use the Command key to
select through an object. Each time you select while pressing the Com-
mand key, the object immediately behind the one currently selected is
chosen.

For example, if you draw an oval over top of a rectangle and select the
oval, then clicking the oval while holding down the Command key causes
the rectangle to be selected instead.

Selecting objects
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Click the selected object while 
pressing the Command key…

Fig. 7-5
Selecting through an object

When selecting through an object, the pointer must be positioned over the
region where the two overlapping objects intersect.

The Select All and Select Same commands

You can use the Select All and Select Same commands to select objects
on the current page of your form.

Select All

The Select All command selects all the objects on the current page of
your form. Functionally, this command is equivalent to selecting all
objects with the Pointer tool. To use the Select All command, choose it
from the Edit menu.

Select Same

The Select Same command selects all objects of given type. For example,
if a box and a line are currently selected, then the Select Same command
will select all other boxes and lines on the current page of your form.

To use the Select Same command, first select one or more objects on your
form. Then choose Select Same from the Edit menu. Informed Designer
will select all remaining objects on the current page of your form that are
of the same type as the ones you originally chose.

…selects the object behind it.

Select All
Edit menu
Command-A

Select Same
Edit menu
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The Select Same command works differently when you edit fields or
tables. If you’re editing a field or a table and a part of that object is
selected (such as a cell or dividing line), then the Select Same command
will select the same parts in all other fields or tables on the current page
of your form.

Choose the Select Same command…

Selected title

…to select the same components on all other fields.

Fig. 7-6
Selecting the same parts of all fields

Deselecting objects

To deselect all currently selected objects on your form, click on an area of
your form that contains no objects, or double-click the Pointer tool on the
tool palette.

To deselect a particular object on your form, click the object with the
Pointer tool while holding down the Shift key. All other currently se-
lected objects will remain selected.

Clearing objects

To clear an object from your form, first select it. Then clear it by using
one of these methods:

Deselecting objects
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❏ Choose Clear from the Edit menu, or press the Backspace key.
This method is most common.

❏ Use the Cut command from the Edit menu.
The Cut command places the selected object on the Clipboard and
then clears it from your form.

Repositioning objects

After drawing an object, you may want to reposition it to a different
location on the page. An object is repositioned by dragging it with the
Pointer tool. Informed Designer gives you the choice of how the object is
displayed as you drag.

Click and 
drag…

…release

Fig. 7-7
Dragging an object

If you click and drag an object immediately, an outline of the object will
appear; the outline will follow the movement of the mouse as you drag
(see Figure 7-7). When you release the mouse button, the object will be
drawn at its new position.

Alternately, if you pause briefly before dragging the mouse, the pointer
and all handles will disappear and the object will be drawn in detail as
you drag. This method is particularly useful for repositioning text because
the text itself remains visible as you drag the mouse.

Clear
Edit menu

Cut
Edit menu
Command-X

Note When editing a table with the Table tool, using the Clear command
will clear a selected column and not the entire table. For more
information, see Removing a column.
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You can constrain the direction of dragging by holding down the Shift
key. The object’s motion will be constrained in either the horizontal or
vertical direction depending on the initial motion of the mouse.

Locking an object’s position

You can lock an object’s position to prevent the object from being moved
or resized accidentally. To lock an object’s position, select the object,
then choose the Object command from the Settings menu. The Object
dialog appears.

Fig. 7-8
Locking an object’s position

Check the Position check box under the Lock heading. Click OK to
dismiss the Object dialog.

When you attempt to reposition or resize a locked object by dragging
with the Pointer tool, Informed Designer will change the pointer to a lock.
This indicates that the object is locked and cannot be dragged. When you
use commands that reposition or resize objects, any objects that are
locked are not affected.

For information about the other settings available on the Object dialog,
see Locking an object’s settings, Objects and printing, and Using object
guides.

Note The Nudge, Align, and Distribute commands, as well as the Specs
palette, can be used to reposition objects. For more information,
see Resizing with the specs palette, Nudging objects, Aligning
objects, and Distributing objects.

Lock pointer

Object…
Settings menu

Repositioning objects
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Resizing objects

A selected object can be resized by using any of the following 3 methods:

❏ Pointer tool

❏ Resize command

❏ Specs palette.

This section describes how to resize objects using all three of these
methods.

Resizing with the Pointer tool

You resize a selected object by clicking and dragging any of its handles
with the Pointer tool. As you drag, Informed Designer draws a gray
outline of the object, which shrinks and expands with the movement of
the mouse to indicate the object’s changing size. If you pause briefly after
clicking a handle, Informed Designer will hide the pointer as you drag.

Click…

drag…

…release

Fig. 7-9
Resizing an object

Resizing lines

You resize a line by selecting it, then clicking and dragging one of its end
point handles.
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Click…

…drag…

…release.

Fig. 7-10
Resizing a line

If you hold down the Shift key while resizing a line, the line will be
constrained along the vertical, horizontal, or diagonal (45°) directions,
depending on the position of the mouse as dragging occurs.

Resizing boxes, ovals, arcs, and polygons

You resize boxes, ovals, arcs, and polygons by clicking and dragging any
corner handle of the object.

If you hold the Shift key down while dragging, resizing is constrained
along the horizontal, vertical, or diagonal axes depending on the move-
ment of the mouse. Resizing horizontally or vertically scales the object in
that direction only. If you hold down the Shift key while resizing diago-
nally, the new object is scaled equally in both directions, resulting in a
new size that’s proportional to the original. As you drag while holding
down the Shift key, the information box displays the current scaling
percentage.

Fig. 7-11
Scaling percentage

When resizing a polygon with the Pointer tool, Informed Designer scales
the object in the same way as described above. More specifically, In-
formed Designer resizes the smallest possible rectangle that completely
encloses the selected polygon. As always, you can resize a polygon in any
direction, and if you hold down the Shift key, the operation is constrained
to the horizontal or vertical axis, or proportionally. To reposition indi-
vidual vertices of a polygon, use the Reshape Polygon command in the
Arrange menu. For more information see Reshaping a polygon.

Resizing objects
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Resizing text

You resize text objects the same way that you resize boxes, ovals,
rectangles, and polygons—by clicking and dragging a handle.

  

Fig. 7-12
Before (left) and after (right) resizing text

When you resize a text object, Informed Designer automatically
reformats the type inside the object to fit the object’s new size.

If you resize a text object too small, Informed Designer will automatically
extend its bottom edge so that all text in the object is visible. Likewise, if
you make a text object too long, Informed Designer will snap its bottom
edge up to the last line of text.

Resizing fields and tables

When you resize a field or table using the Pointer tool, Informed Designer
adjusts the size of the object while preserving the spacing of the title
sections.  An example is shown on the next page.
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Fig. 7-13
Resizing a table

When you drag the edge of a field or table, any title sections move as
well. If you hold down the Command key while dragging the edge of a
title section, the size of the section changes. You can also change the size
of a title section by clicking and dragging the section’s dividing line with
the Field or Table tool.

Holding down the Shift key while resizing a field or table constrains the
motion of the resize operation to the vertical, horizontal, or diagonal axes,
depending on the motion of the mouse. Scaling diagonally results in an
object that is resized proportionally to the original. As you hold down the
Shift key and drag, the Information box displays the current scaling
percentage. For more information, please see Resizing parts of a field and
Resizing parts of a table in chapter 5.

Resizing multiple objects

Often you will want to resize more than one object by the same amount.
For example, you might want to change the height of three adjacent
fields. Informed Designer allows you to select more than one object, and
then resize them all with one motion. Simply select each object, then

click
drag

Resizing a field or table with the Pointer tool ...

... doesn’t change the size of title sections.

Resizing objects
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resize one of them to the desired size. All selected objects will be resized
by the same amount.

select then click and 
drag to resize ...

all selected objects 
are resized equally

the size of the title section 
remains the same ...

Fig. 7-14
Before and after resizing three fields

As multiple objects are resized, Informed Designer will constrain the new
size to ensure that any object doesn’t become too small or too large.

Resizing with the Resize command

The Resize command resizes one or more selected objects.

You resize an object in one of three ways: explicitly (by specifying the
object’s new dimensions), by example (by pointing and clicking on
another object of the desired size), or to its original size (available for
imported graphic objects.

To resize an object, first select it and then choose the Resize command
from the Arrange menu. You’ll see this dialog:

Fig. 7-15
Resize dialog

The width and height of the selected object can be resized independently.
Do this by checking either of the ‘Resize width to’ or ‘Resize height to’
check boxes.

Resize…
Arrange menu
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If you select the Inches radio button, you can specify the new width or
height of the selected object in the corresponding text entry boxes. For
example, you might enter a value of 5 inches for the height and 3 inches
for the width of a selected object. The unit of measurement corresponds
to the current ruler setting. However, you can enter the value in any units
you like; Informed Designer does the conversion for you.

Similarly, if you select the Percentage option, the selected object is
resized to a percentage relative to its current size. For example, you might
want to scale an object to half its present size. Simply enter ‘50’ into each
text box. Click OK to perform the resize. Click Cancel to cancel the
command and return to editing your form.

The resize ‘By example’ option allows you to change the size of an object
to the size of a different object on your form. To use this method, follow
the instructions below.

1. Select the object that you want to resize.

2. Choose Resize from the Arrange menu, select the ‘By example’ option,
then click OK.

3. With the pointing hand, click the object that’s the correct size. The size of
the selected object will change to match the size of the object you click.

The resize ‘To original size’ option is available only if you’ve selected at
least one PICT, EPSF, or TIFF object. This option resizes the object to its
original pasted or imported size.

You can double-click a PICT, EPSF, or TIFF object with the Pointer tool
to resize it to its original size.

Errors when resizing

When using the Resize command, Informed Designer won’t allow you to
reduce the size of an object below its minimum size (for example, setting

For more information about entering
measurements and unit conversion,
see Appendix B, Entering measure-
ments.

Resizing objects
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the width of a box to zero inches). If you try, the following error message
appears:

Fig. 7-16
Objects too small error

Likewise, you can’t enlarge an object larger than the size of the drawing
area. If you try, the following error message appears:

Fig. 7-17
Objects too large error

If either of these errors occur, Informed Designer will report the error and
cancel the Resize command. Click OK to dismiss the error dialog.

Resizing with the specs palette

The specs (specifications) palette is a drawing aid that can help you resize
and reposition objects on your form. Use the specs palette to position or
resize an object if you know its exact dimensions.
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Fig. 7-18
The specs palette

The specs palette displays coordinate information pertaining to the mouse
and any currently selected objects. Like the tool palette, the specs palette
can be displayed, hidden, or dragged, but not resized. When visible, the
specs palette always displays the mouse’s current position, unless the
mouse is over the specs palette or outside of the drawing window.

When the specs palette is displayed, the units of measurement correspond
to those currently set on the ruler.

Using the specs palette

To use the specs palette, first display it by selecting the Show Specs
command from the Layout menu. When the specs palette is visible, the
corresponding menu command becomes Hide Specs. Select this com-
mand or click the palette’s close box to hide the specs palette.

Resizing an object

You can resize an object by changing any of the parameters displayed in
the text entry boxes on the specs palette.

Click and type here

Fig. 7-19
Typing on the specs palette

To change an object’s parameters, click and select the appropriate text
entry box with the mouse, then type a new value. Enter the new value in

Show/Hide Specs
Layout menu
Command-E

For more information about
entering measurements and unit
conversion, see Appendix B,
Entering measurements.

Resizing objects

Specification 
of the 
currently 
selected 
object

Current 
mouse 
position

Close box Click and drag here to 
move the specs palette
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any units you like; Informed Designer performs the appropriate unit
conversion for you. Then press the Tab, Shift-Tab, Return, or Enter key.
The new value will be applied to the selected objects. Depending on
which key you press, one of the following will happen.

❏ Pressing Tab or Return will move you to the next text entry box on the
specs palette.

❏ Pressing Shift-Tab will move you to the previous text entry box on the
specs palette.

❏ Pressing the Enter key will take you off the specs palette.

The new value is applied to the selected objects immediately.

When you alter any of the Top, Left, Bottom, or Right parameters, the
object’s corresponding edge always reflects the change. If you change the
Height or Width parameters, the change will always affect the bottom or
right edge. For example, if the width of a table is five inches, and you
type ‘6’ into the Width text box on the specs palette, the right edge of the
table will be extended by one inch. This is similar to using the Nudge
commands to resize objects.

If more than one object is selected, the specs palette shows only the
values that are common to all objects. This means that a text entry box
will be blank if its value is different for each of the selected objects. For
example, if two objects of the same width are selected, the specs palette
will show the corresponding width. However, only if their edges are
aligned exactly will values appear in the top, left, right and bottom text
entry boxes.

Figure 7-20 below shows the specs palette and four selected objects.
Since the dimensions and position of each object is different, all text entry
boxes show blank values. Figure 7-21 shows the same objects after
entering a left value of ‘2.0’. The left edge of each selected object is
moved to the two inch mark on the horizontal ruler.
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When you type on the specs palette…

Fig. 7-20
Selected objects and the specs palette

…the change is applied to all selected objects.

Fig. 7-21
Resizing objects with the specs palette

As with all other resizing operations, you can’t enter values that would
reduce the size of an object below its minimum, or enlarge an object so
that it lies partially off the drawing area. If you try to enter a value that is
too large or too small, Informed Designer will warn you (with a beep) and
leave the original value unchanged.

Repositioning an object

You can also use the specs palette to reposition an object to an exact
location on the drawing area. Suppose that you want to position a field’s
upper left corner at exactly two inches to the right and down from the
ruler’s zero point. First display the specs palette and select the appropriate
field. Then drag the object with the mouse until the Top and Left param-
eters on the specs palette both show two inches.

Resizing objects
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…until the specs palette looks like this:

Drag the object around…

Fig. 7-22
Repositioning with the specs palette

As with all object positioning operations, Informed Designer won’t allow
you to drag an object off the drawing area.

Duplicating objects

Often you’ll want to create new objects that are similar, if not identical, to
other objects on your form. Rather than redrawing an object by hand,
Informed Designer provides you with a pair of commands that allow you
to create one or more duplicates of an existing object.

Duplicate

The Duplicate command duplicates one or more selected objects. It’s
useful for making a single copy of an object.

To duplicate an object, first select it and then choose the Duplicate
command from the Arrange menu. For each selected object, Informed
Designer places a copy directly to the right of the original. The original
object is deselected and the new object is selected.

Duplicate
Arrange menu
Command-D

Note The Align command allows you to move an object by typing an
exact location. See Moving objects on your form for more informa-
tion.
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Fig. 7-23
Object before (above) and after duplicating (below)

If you hold down the Option key while choosing the Duplicate command,
the duplicate object will be directly below the original. If you reposition a
duplicated object and immediately duplicate it again, Informed Designer
uses the distance between the copy and the original as the offset for the
next copy.

Duplicated objects are never positioned partially on the drawing area. If
the position of a newly duplicated object places it off the edge of the
drawing area, Informed Designer readjusts the object’s position as
necessary to place it entirely on the drawing area.

Replicate

The Replicate command duplicates one or more selected objects an
arbitrary number of times. Replicated objects are created at evenly spaced
intervals that you can set.

To replicate an object, first select it and then choose the Replicate
command from the Arrange menu. This dialog will appear:

Fig. 7-24
Replicate dialog

Use the ‘Number of duplicates’ text entry box to specify the number of
copies that you want to make, then enter the horizontal and vertical
offsets in the ‘Offset by’ text entry boxes. These values indicate the
distance between each subsequent duplicate. You can specify the offsets
in any units you like; Informed Designer performs the appropriate unit
conversion for you. These measurements default to 1/4 inch, 1/2 cm, 1
pica, or 18 points, depending on the ruler’s current setting.

Duplicating objects

Replicate…
Arrange menu

For more information about
entering measurements and unit
conversion, see Appendix B,
Entering measurements.
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After you enter the appropriate values, click OK to perform the command
or click Cancel to discontinue the operation and return to editing your
form.

You can enter negative offsets as well. A negative offset causes a new
object to be placed in the opposite direction of a positive offset. This
means that positive horizontal and vertical offsets would place a duplicate
object below and to the right of the original, whereas corresponding
negative offsets would place a duplicate above and to the left instead.

As with the Duplicate command, replicated objects are never positioned
partially on the drawing area. Informed Designer always readjusts an
object’s position, if necessary, to place it entirely on the drawing.

Duplicating cells

When you duplicate cells on a form (either field cells or table cells), you
should be aware of the following situations and how Informed Designer
handles each one.

Naming conventions

If you duplicate a cell, the new cell can’t take the same name as the
original (all cell names must be unique). Informed Designer uses these
conventions to name duplicated cells:

❏ A number (starting with 1) is appended to the original cell name.
After appending a number, if the resulting cell name is already in use,
the appended number is incremented by 1 (as many times as neces-
sary) until a unique name is obtained.

For example, when duplicating the cell called ‘Phone’, Informed
Designer will name the new cell ‘Phone1’. If a cell called ‘Phone1’
already exists, ‘Phone2’ will be used instead (and so on).

❏ If the original cell name already ends with a number, that number is
incremented by one.
Rather than appending another number to the original name, the
existing number is incremented by one instead (as many times as
necessary) until a unique name is obtained.

For example, when duplicating the cell called ‘Cell1’, the new name
‘Cell2’ will be used (not ‘Cell11’). If a ‘Cell2’ already exists on the
form, then ‘Cell3’ will be used (and so on).
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❏ If the resulting name is longer than fifteen characters, Informed Designer
will remove the character that immediately precedes the appended
number.
For example, the duplicate of the cell ‘Abcdefghijklmn9’ will be
named ‘Abcdefghijklm10’.

Tab position

Each newly duplicated cell receives the next available tab position. For
example, if there are fifteen cells on your form with tab positions one
through fifteen, and two of those cells are duplicated, the two new cells
will have tab positions sixteen and seventeen. Of course, you can always
change the tab position if you like.

Formulas

If you’re duplicating a cell that has a calculation, default, or check
formula, and that formula refers to cells that are also being duplicated
(remember their names will change), then when you perform the duplica-
tion, the formula will be adjusted so that all cell references refer to the
duplicate cells rather than the originals.

For example, suppose that your form has two cells, cell1 and cell2, and
that the value of cell2 takes the value of cell1 (cell2 = cell1). If you
duplicate the two cells together, then you’ll get cell3 and cell4 where the
value of cell4 is calculated as the value of cell3 and not the value of cell1
(cell4 = cell3).

Aligning objects

Often you’ll want to align one or more objects on your form, either to
each other, or along the lines of the drawing grid. Informed Designer’s
Align command allows you to easily align objects to each other, to the
drawing grid, or to a specific position on your form. You can also use the
Align command to center a single object on the drawing area.

To align a set of objects, first select them and then choose the Align
command from the Arrange menu. This dialog will appear:

Align…
Arrange menu

Aligning objects
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Fig. 7-25
Align dialog

Objects may be aligned to themselves, or along the drawing grid. The
default alignment is shown above.

After you’ve specified how the alignment should take place, click OK to
perform the alignment, or click Cancel to cancel the operation and return
to editing your form.

Aligning objects to each other

To align a set of objects to each other, click the ‘To each other’ radio
button and choose the axes that will participate in the alignment. You can
align objects along one or both axes.

If you check the Align Horizontal box, then the alignment will take place
along the horizontal axis—that is, in the left-to-right direction. Click the
Left radio button to align the objects along the left side of the leftmost
selected object. Click the Right radio button to align the objects along the
right side of the rightmost selected object. If you click the Center radio
button, the objects’ centers will be aligned along a path that lies roughly
halfway between the leftmost and rightmost selected objects.



7 - 25

Fig. 7-26
Objects before and after alignment (using default settings)

Similarly, you can check the Align Vertical box to perform the alignment
along the vertical axis. The Top radio button aligns the objects along the
top edge of the topmost selected object. The Bottom radio button aligns
the objects along the bottom edge of the lowest selected object. The
Center radio button aligns the objects’ centers along a path that lies
roughly halfway between the uppermost and lowest selected objects.

Aligning an object to the drawing area

The align ‘To each other’ option is available if you’ve selected more than
one object to align. With only a single object selected, the ‘To each other’
option changes to ‘To drawing’. Use this option to align an object to the
edge or center of the drawing area. Click the ‘Align Horizontal’ or ‘Align
vertical’ check box (or both) to choose which direction to align in. Then
choose the drawing edge or center to align to by clicking the appropriate
radio button (Left/Center/Right, or Top/Center/Bottom).

Moving objects on your form

When aligning objects to each other, you can optionally move the se-
lected objects to a specified position on the drawing area by checking the
‘Move to’ check box and entering the desired coordinates. Enter the
coordinates in any units that you like; Informed Designer performs the
appropriate unit conversion for you.

When an object is moved using this option, the edge or center of the
object is moved to the specified coordinate (as indicated by the Left/
Center/Right and Top/Center/Bottom radio buttons).

Aligning objects to the grid

To align a set of objects along the drawing grid, select the ‘To grid’ radio
button. When you click OK, the upper left corner of all selected objects
will ‘snap’ to the nearest grid lines, whichever are active.

For more information about
entering measurements and unit
conversion, see Appendix B,
Entering measurements.

For more information about the
grid, see The grid.

Aligning objects
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When you align 
an object to the 
grid…

…its upper left 
corner is snapped 
to the nearest grid 
lines.

Fig. 7-27
Aligning an object to the grid

Using object guides

Object guides make it easy to align objects next to each other. Unlike the
Align command, object guides help you align objects visually—that is, by
dragging them on the drawing window.

Object guides work just like guide lines. They appear as gray lines that
have a magnetic attraction. When you drag an object towards a guide, the
object’s edge will snap to the guide once it’s within a certain range.

end point will snap to
the corner

Fig. 7-28
Using object guides

Informed Designer always positions object guides along the sides or end
points of an object. For text objects, guides appear along each base line of
the text as well.
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Fig. 7-29
Object guides

You turn object guides on using the Object command. Select the object
that you want to align to, then choose the Object command in the Settings
menu. The Object Settings dialog appears:

Fig. 7-30
Object dialog

You can choose either short or long object guides. Short guides extend
about a half inch from the edge of the object, whereas long guides extend
the complete width or height of the drawing window. After selecting your
choice, click OK to dismiss the Object dialog. To cancel the Object
command, click Cancel instead.

Like guide lines, object guides have sensitivity and display attributes.
These attributes are controlled using the Guide Options command. For
more information, see Guide options.

For information about the other settings available on the Object dialog,
see Locking an object’s settings, Locking an object’s position, and
Objects and printing.

Object…
Settings menu

Aligning objects
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Distributing objects

Often you’ll need to evenly space a set of objects across an area of your
form. You might be separating related fields of information, or you might
be redistributing a set of newly replicated objects. Rather than tediously
placing each object by hand, Informed Designer provides a simple and
efficient way to do this.

The Distribute command evenly distributes a set of selected objects along
an arbitrary path. This path is determined by you and may be specified in
one of two ways: visually (with the help of the mouse), or by a specified
value.

To distribute a set of objects, first select them and then choose the
Distribute command from the Arrange menu.  This dialog will appear:

Fig. 7-31
Distribute dialog

Distributing objects visually

When you distribute a set of objects visually, you align them along a path
that’s determined with the mouse.

To distribute a set of objects visually, select the Visually radio button and
click OK to continue. You’ll see the drawing window again with the
selected objects in distribute mode. The selected objects will assume an
initial distribution path where they are offset (in both directions) from

Distribute…
Arrange menu

Note While editing a table, you can use the Distribute command to
evenly distribute the table’s columns. For more information, see
Distributing columns.
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each other by a fixed amount. The line of distribution depends on the
initial placement of the selected objects. All objects remain selected, but
on the upper-left corners of the topmost and lowest objects, you’ll see a
circular handle.

Select objects and 
choose the Distribute 
command…

…after clicking OK, the 
selected objects 
assume an initial 
distribution…

Circular handles

Fig. 7-32
After selecting the Distribute visually command

Using the mouse, perform the distribution by clicking and dragging on
either of the circular handles. While you hold the mouse button down, an
outline of the selected objects appears, indicating the position of the
objects as the mouse is moved. When you achieve the desired distribu-
tion, release the mouse button. The objects remain selected and will be
distributed along their new path.

Distributing objects
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…click and drag on a 
circular handle to 
distribute…

Drag

…when you release the 
mouse, the objects 
assume their final 
position.

Fig. 7-33
Performing the distribution

If you hold down the Shift key while adjusting the path, the resulting path
will be constrained to the horizontal, vertical, or diagonal (45°) axes.

While the objects are in distribute mode, you can move or resize the
objects normally using the Pointer tool. The selected objects will remain
in distribute mode until they’re deselected.

Distribute by value

If you know exactly how far apart you want to distribute a set of selected
objects, use the ‘By value’ option. If you check this option, you can
directly specify the vertical and horizontal offsets with which to distribute
the objects. Select either of the Horizontal or Vertical check boxes (or
both) and type the desired values into the associated text entry boxes.
Enter the values in any units you like; Informed Designer does the
conversion for you.

When performing the distribution, Informed Designer will separate all
objects along their upper-left corners by the given offsets. Positive
vertical and horizontal offsets place each subsequent object down and to

For more information about
entering measurements and unit
conversion, see Appendix B,
Entering measurements.
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the right. The same negative offsets place each object above and to the
left. Click OK to perform the distribution or click Cancel to discontinue
the operation.

Regardless of the which distribution method you choose, you can’t
distribute an object off the edge of the drawing area. If the new position
of an object places it partially off the drawing area, Informed Designer
will adjust its position so that it appears entirely on the drawing area.

Rotating objects

Use the Rotate command to rotate one or more selected objects. Objects
can be rotated 360 degrees in 90 degree increments.

All object types can be rotated with the exception of fields and tables. If
you select a field or a table, or if a set of selected objects contains a field
or a table, the Rotate command is disabled.

To rotate an object, first select it then, from the Arrange menu, choose the
Rotate command. The selected object is automatically rotated 90 degrees.

Fig. 7-34
Object before and after rotation

The Rotate command is useful for placing vertical text on your form. To
rotate text, select it with the Pointer or Text tool. From the Arrange menu,
choose the Rotate command.

A rotated text object can be edited in the usual manner. When you click
the object with the Text tool, Informed Designer will rotate the text
upright (back to zero degrees), and allow you to edit the text. When you
press Enter or deselect the object, it will return to its rotated orientation.

Rotate
Arrange menu
Command-H

Rotating objects
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Grouping and ungrouping objects

There may be times when you want the ability to treat a set of objects as a
single object. For example, suppose that you’ve drawn a logo on your
form, and the logo consists of a collection of individual lines, rectangles,
and text objects. Grouping these objects together allows you to treat the
logo as if it were a single object. Informed Designer gives you this ability
with the Group and Ungroup commands.

Grouping objects

The Group command forms a single object that’s composed of a set of
selected objects.

To group a set of objects, first select them and then choose the Group
command from the Arrange menu. Informed Designer surrounds the
objects with handles at each corner of group’s smallest enclosing rectan-
gle.

Fig. 7-35
Objects before (left) and after (right) grouping

Since a grouped set of objects is treated as a single object, it’s manipu-
lated accordingly. This means that you can perform any operation on a
grouped object (such as selecting, moving, or resizing) that can be
performed on an individual object.

All commands to manipulate a group, with the exception of resizing and
rotating, function exactly as though the objects in the group were selected
individually before using the command. For example, changing the font
of a selected group will set the font for all text, field, and table objects in
the group.

When you resize a grouped object, Informed Designer ensures that the
size and relative spacing of the individual objects that make up the group

Group
Arrange menu
Command-G

Note If a group contains a locked object, then the group itself behaves
as If it were locked. For more information about locking objects, see
Locking an object’s position.
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remain unchanged. Note that this is unlike resizing multiple selected
objects where each object is resized by the same amount and the position
of each object doesn’t change. Figure 7-36 below illustrates how a
grouped and ungrouped set of objects are resized.

Resizing 4 selected objects

Resizing a group consisting 
of the same objects

Fig. 7-36
Resizing groups

When you rotate a grouped object, rather than rotating each object in the
group about its center (without moving its position), the group as a single
object is rotated about its center.

Rotating 3 selected objects

Rotating a group consisting 
of the same objects

Fig. 7-37
Rotating groups

To manipulate a single object within a group, first ungroup the group (see
next section), change the object, then regroup the objects.

Ungrouping objects

The Ungroup command separates a grouped object into the individual
objects that comprise it. Ungroup is the opposite of the Group command.

To ungroup a grouped object, first select it and then choose the Ungroup
command from the Arrange menu. All objects that comprised the group
will be individually selected.

The Ungroup command is useful when you need to work with a single

Ungroup
Arrange menu
Command-U

Grouping and ungrouping objects
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object within a grouped object. For example, you might want to edit a text
object that’s part of a grouped object. Use the Ungroup command to
ungroup the object. After editing the text, use the Group command to
regroup the objects.

Moving objects through the drawing plane

In an Informed document, each object resides in its own layer on the
drawing plane. This means that all objects have a relative front to back
ordering—or stacking order—on your drawing.

Often while editing a form, you might need to change an object’s stacking
order. For example, some objects might be partially obscured by others or
you might want to bring an object to the front of a drawing so you can
edit it more easily. With the object layering commands (Bring Closer,
Bring To Front, Send Farther, and Send To Back), Informed Designer
gives you the ability to easily manipulate an object’s front-to-back
ordering.

Bring Forward

The Bring Forward command moves one or more selected objects closer
to the front of the drawing plane.

To move an object closer in the drawing plane, first select it and then
choose the Bring Forward command from the Arrange menu. The
selected object is moved in front of the object immediately above it. The
object remains selected.

Fig. 7-38
Selected object (circle) brought forward in the drawing plane

If you apply the Bring Closer command to a set of objects, then each
object in the set is moved in front of the object that lies immediately
above it. However, the relative stacking order of the selected objects
doesn’t change.

Bring Forward
Arrange menu
Command-F
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Bring To Front

The Bring To Front command moves an object directly to the front of the
drawing.

To bring an object to the front of the drawing, first select it and then
choose the Bring To Front command.

Fig. 7-39
Object before (left) and after (right) Bring To Front

If two or more objects are selected, they are moved as a group to the front
of the drawing. Their relative stacking order is not changed.

Send Backward

The Send Backward command moves one or more selected objects
farther back in the drawing plane.

To move an object backward in the drawing plane, first select it and then
choose the Send Backward command from the Arrange menu. The
selected object is moved behind the object immediately below it. The
object remains selected.

Fig. 7-40
Selected object before (left) and after (right) Send Backward

If you apply the Send Backward command to a set of objects, each object
in the set is moved behind the object that lies immediately below it. The
relative front-to-back order of the selected objects is left unchanged.

Bring To Front
Arrange menu

Send Backward
Arrange menu
Command-B

Moving objects through the drawing plane
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Send To Back

The Send To Back command moves one or more selected objects to the
back of the drawing.

To send an object to the back of the drawing, first select it and then
choose the Send To Back command from the Arrange menu.

Fig. 7-41
Object before (left) and after (right) Send To Back.

If you select two or more objects, they’re moved to the back of the
drawing as a group. Their relative stacking order, however, is always
preserved.

Nudging objects

As in all drawing, it’s important to position objects accurately on your
form. Although the mouse is often accurate enough, there are times when
you’d like greater precision over object placement combined with greater
ease of manipulation.

With the Nudge keys, Informed Designer allows you to move and resize
objects precisely without using the mouse. Use the Nudge keys whenever
you’re doing detailed work or whenever you want maximum control over
object sizing and placement.

Nudging an object’s position

To nudge an object, first select it and then type the appropriate Nudge key
(up, down, left, or right arrow). You can nudge more than one object at a
time by first selecting all objects and then typing the key.

When you nudge an object, you move it by a distance of 1 pixel at the
current view of the drawing window. If the current view is set to 100%,

Send To Back
Arrange menu

If you limit the drawing accuracy,
you might not be able to move an
object by a distance of 1 pixel. For
more information, see Drawing
accuracy.

Nudge keys
↑, ↓, ←, or →
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this means that each time you nudge an object, its position changes by a
distance of 1/72nd of an inch (because the Macintosh screen has a
resolution of 72 dots—or pixels—per inch). Similarly, if the current view
is set to 200%, nudging an object moves it 1/144th of an inch. At the
largest possible view (1600%), nudging an object repositions it by a
distance of 1/1152nd of an inch.

As with other positioning commands, you can’t nudge an object off the
edge of the drawing area. If you try to nudge an object beyond the
drawing edge, Informed Designer simply won’t move it.

Nudging an object’s size

You can also nudge the size of an object. First select the object and then
type the desired Nudge key (up, down, left, or right arrow) while holding
down the Option key. Instead of moving the object, the object’s bottom or
right edge will resize one pixel in the corresponding direction.

You can resize more than one object at a time by first selecting all objects
and then typing the nudge key while pressing Option.

As with all resizing commands, you can’t nudge the size of an object
below its minimum size or larger than its maximum size.

Objects and printing

In chapter 10, you’ll learn about printing forms and Informed Designer’s
print options. When you print your form while in test mode, Informed
Designer allows you to hide either the form’s layout or its data. The
layout of a form refers to the graphical objects such as lines, boxes, and
text labels. The form’s data refers to the information that you enter in
each cell to complete the form. For information about Informed Design-
er’s print options, see Printing in chapter 10.

By using the Object command, you can set additional print options for
any object. You can choose to hide an object so that it doesn’t print. This
is useful if you want an object to appear on the screen, but not on the
printed form. For example, you might want to label the different parts of
your form to help the person who fills it out.

Nudge keys (to resize objects)
Option-↑, ↓, ←, or →

Objects and printing
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Alternately, you can choose to always print an object, even if you print
your form with its layout hidden. This option is useful when using
preprinted forms. For example, you might want a graphical object—such
as your company logo—to print in addition to the form’s data.

To change the print options of an object, select the object, then choose the
Object command. The Object Settings dialog appears.

Fig. 7-42
Selecting print options for an object

Click either of the ‘Always print’ or ‘Never print’ check boxes. You can’t
use both options at the same time. After making your selection, click OK
to dismiss the Object dialog. To cancel the Object command, click Cancel
instead.

For information about the other settings available on the Object dialog,
see Locking an object’s position, Locking an object’s settings, and Using
object guides.

Using the Clipboard

The Clipboard is a temporary holding place for graphics and text. Com-
monly, you’ll use it to perform one of these functions:

❏ to move objects from one area of a drawing to another

❏ to move objects from one page of a form to another

❏ to move objects from one form to another

❏ to transfer artwork and text from other applications into Informed
Designer

❏ to transfer artwork created with Informed Designer into other
applications.
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You can use three commands to transfer objects to or from the Clipboard.
The Cut and Copy commands place objects onto the Clipboard. The Paste
command transfers the contents of the Clipboard onto your form. These
commands are described below.

You can display the contents of the Clipboard by choosing the Show
Clipboard command from the Edit menu. Informed Designer shows the
Clipboard content in a window.

Fig. 7-43
Clipboard window

Like any Macintosh window, you can position the Clipboard window
anywhere on your screen by clicking and dragging its title bar. You can
hide the Clipboard by clicking the window’s close box or by choosing the
Close command while the window is active.

Moving objects onto the Clipboard

Use the Cut or Copy commands to move objects onto the Clipboard.

To move an object onto the Clipboard, select it and choose either of the
Cut or Copy commands from the Edit menu. Your selection will be
transferred to the Clipboard. If you choose Cut, the selected objects will
also be removed from your form.

The Copy command is more commonly used to transfer objects to the
Clipboard. When you want to remove an object from your drawing, use
the Clear command instead. See Clearing objects.

Cutting or copying text

You can cut or copy a text object as you would any other object; how-
ever, depending how you select that text object (either with the Pointer
tool or with the Text tool), the contents of the Clipboard will be affected
differently.

❏ If you select a text object with the Pointer tool, the entire object will be
placed on the Clipboard when you cut or copy it.

Title bar

Close box

Clipboard contents

Cut
Copy

Edit menu
Command-X, C

Close
File menu
Command-W

Show Clipboard
Edit menu

Using the Clipboard
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Fig. 7-44
Selecting text with the Pointer tool

❏ If you select only certain characters of a text object with the Text tool,
only those characters are placed on the Clipboard.

Fig. 7-45
Selecting characters with the Text tool

For more information about selecting text, see Editing text.

Pasting objects from the Clipboard

To paste the contents of the Clipboard onto your drawing, select the Paste
command from the Edit menu. A copy of the Clipboard’s contents will be
positioned at the center of the drawing window.

Generally, you can paste three types of objects: objects created with
Informed Designer, PICT objects, and text.

If you hold the Option key down while choosing the Paste command,
Informed Designer will place the objects at their original positions (that
is, the position they were when you cut or copied them). This feature is
useful for copying objects from one page of a form to another. After
copying an object on one page, pasting it on another page while holding
down the Option key will ensure that it’s positioned at the same location
as the original.

Pasting Informed objects

When pasting objects created with Informed Designer, you should be
aware of the following conditions and how Informed Designer handles
each one.

❏ Objects larger than the drawing area are not pasted.
If the Clipboard contains objects that are larger than the drawing area,
Informed Designer won’t paste those objects onto your form. Instead,
you’ll see this warning:

Paste
Edit menu
Command-V
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Fig. 7-46
Objects too large to paste

If you click OK, the paste operation will continue, but only those
objects that fit entirely on the drawing area will be pasted. If you click
Cancel, the paste operation will be cancelled.

❏ Cells are renamed before they are pasted.
To prevent duplicate cell names from occurring on your form, cells on
the Clipboard are renamed (if necessary) before they’re pasted. The
naming conventions used to name the new cells are the same as those
used for duplicating or replicating existing cells. Likewise, a newly
pasted cell receives the next available tab position.

If a cell being pasted contains a formula that references a nonexistent
cell (you could have copied a cell from another form that refers to a
cell on that form), then you’ll be warned.

Fig. 7-47
Invalid  formula warning

When you click OK, Informed Designer will clear the invalid formula
before pasting the cell.

For more information about naming
new cells, tab position, and formulas,
see Duplicating cells.

Using the Clipboard
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Pasting graphic objects

A graphic object is treated as a single object and is pasted in the usual
manner. However, if the Clipboard contains a graphic object that’s larger
than the drawing area (in either direction), you’ll see this warning:

Fig. 7-48
Picture too large warning

If you click OK, the large graphic object will be reduced proportionally
and pasted onto your form. If you click the Cancel, the paste operation
will be cancelled.

Pasting text

You can paste text in two different ways: as a new text object, and as text
inserted into an existing text object.

❏ If you’re not editing a text object, the text on the Clipboard is pasted as a
new object.
The text will be pasted onto your form and centered on the drawing
window.

❏ If text is pasted while editing a text object, the text on the Clipboard will
be pasted starting at the insertion point of the selected text object.
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Using graphics
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Although Informed Designer provides you with a comprehensive set of
drawing tools, you might want to read in or import artwork originally
created with another Macintosh application. To support the integration of
different applications, various standard formats for storing graphical
information have evolved. Of these formats, Informed Designer supports
PICT, EPSF (Encapsulated PostScript Format), and TIFF (Tagged Image
File Format). Informed Designer also allows you to import text files as
well.

In addition to the Import features of Informed Designer, the publish and
subscribe features allow you to automatically update artwork on your
forms whenever the original changes.

This chapter describes both the import and the publish and subscribe
features of Informed Designer.

The Import command

Before you can import certain images into your form, the image’s import
extension must be installed on your hard disk. For example, to import a
TIFF image, the TIFF import extension must be installed. (Import
extensions are not required for importing text, PICT, or EPS images.) For
more information on extensions and details on how Informed Designer
imports different types of graphics, please see your Informed Extensions
manual.

To import artwork or text, choose the Import command from the File
menu. The import dialog appears:

Fig. 8-1
Import dialog

Import…
File menu
Command-I
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The dialog displays the names of all files that are stored in the supported
graphic type formats. The Graphic Type pop-up menu allows you to
select the types of graphic files displayed in the dialog. For example, you
can choose to display all the graphic types (All available), or specific
types (TIFF).  Use the Desktop and Eject buttons to view different files
on different volumes and disks. After you select the file that you want to
import, click the Import button (or double-click the file’s name). In-
formed Designer will read the graphics or text from the file, create a new
object to hold it, and center that object in the drawing window.

Once imported, you can manipulate the object (resize, reposition, and so
on) just as any other object created with Informed Designer. See Manipu-
lating objects in chapter 7 for more information.

Errors when importing

You should be aware of the following errors that can occur when you
import artwork or text.

❏ The graphic you’re importing is larger than the drawing area.
If the size of a selected graphic is larger than the current drawing area
in either direction, Informed Designer will warn you with the dialog
displayed on the following page:

Fig. 8-2
Imported graphic
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Fig. 8-3
Imported graphic too large

If you click OK to continue, the graphic will be imported, reduced
proportionally in size, and centered in the drawing window. To cancel
the Import command, click Cancel instead.

❏ The text object you are importing is too large to fit on your form.
If you are importing a text file that contains more text than will fit on
the drawing area, Informed Designer will warn you with this dialog:

Fig. 8-4
Too much text warning

If you click OK, the text will be imported, but some text may be lost.
To cancel the Import command, click Cancel instead.

Importing scanned forms

Instead of redrawing an existing form from scratch, Informed Designer
allows you to import the form’s scanned image. When you scan your
form, make sure that you save the image in either of the PICT or TIFF
formats. You can then use the Import command as described in the
previous section to import the scanned image and place it on the drawing
area. Use the Field and Table tools to draw cells over top of the blanks on
the form.

Although scanning technology has evolved considerably over the past
few years, there are still significant drawbacks in using the actual scanned
image of a form. The readability of small type sizes is often inadequate
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making it hard to read text on the screen. Even though the TIFF format is
capable of storing images at high resolutions, the screen still limits the
clarity of the image to 72 dpi (dots per inch).

Printing a scanned form also deserves careful consideration. If you print a
completed form with its scanned layout onto blank paper, you’ll find that
a scanned image stored in the PICT format is unclear and often unaccept-
able, even on 300 dpi laser printers. In order to produce quality results,
you must use the TIFF format. Unfortunately, with the TIFF format
comes longer print times and higher disk space requirements.

You’ll find that a scanned image is most useful as a tracing aid. After you
import a scanned image, you can use Informed Designer’s drawing tools
to accurately place the graphics and text on your form.

Publish and subscribe

With Informed Designer and System 7, you can automate the process of
updating artwork in one or more documents. In the past you would use
the Copy and Paste commands or the Import command to place artwork
on your form. Whenever the original changed, you would repeat the
process to update the changes on the form. By using the publish and
subscribe features, Informed Designer can automatically update artwork
on your forms whenever the original changes.

As explained in your Macintosh Reference manual, publishing and
subscribing to information is a two step process. First you select the
material that you want to make available in other documents—called a
publisher—and publish it. The material is saved in a file called an edition.
You then open a document and indicate where you want the material to
be placed. The placed material is called a subscriber. You can subscribe
to the material as many times as you like. Once you’ve subscribed to the
material, each subscriber will automatically update when the original
changes.

Importing scanned forms
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Purchase
Order

Invoice

Original artwork

Form documents

Fig. 8-5
Example of publish and subscribe

Automatic updating is available only in certain applications. Like In-
formed Designer, applications that offer this capability have commands
like ‘Create Publisher’ and ‘Subscribe to’ in the Publishing submenu
under Edit.

With Informed Designer, automatic updating is most often used for
company logos and artwork that’s common to several forms. When you
change the original logo or artwork, the changes are automatically
reflected in each of the forms. You can use Informed Designer—or any
other drawing program that offers publish and subscribe capabilities—to
draw and publish the logo or artwork. Then using Informed Designer, you
can subscribe to the material and position it appropriately on any form.
The commands that you use to publish and subscribe are described in the
following sections.

Creating a publisher

In order to make text and graphics in an Informed document available for
automatic updating in other documents and applications, you have to
create a publisher using Informed Designer. With the document contain-
ing the original material open, select the objects that you want to publish,

Publish and subscribe commands

Create Publisher...
Edit Menu
Publishing submenu
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then choose the Create Publisher command from the Publishing submenu
under Edit. The dialog box for publishing appears.

Fig. 8-6
Publishing dialog box

The Publishing dialog box shows you a preview of the material that
you’re publishing. Type a name for the new edition, specify where to
store it, then click the Publish button. The selected objects become a
publisher and the edition file is saved.

Fig. 8-7
Publisher and edition file

Publish and subscribe

Note When you publish objects using Informed Designer, a pictorial—
or PICT—version of the material is stored in the edition file. The
cells of field and table objects are ignored.
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A publisher is identified by a light gray border that encloses the published
objects (see Figure 8-9). In the drawing window, you can show and hide
these borders by choosing the Show Borders and Hide Borders com-
mands from the Publishing submenu under Edit. You can select, move,
and resize a publisher like any other object. If a publisher only partially
encloses an object, the object will appear cut off when the edition is
subscribed to.

If the publisher cuts off the logo ... ... the subscriber will be cut off too.

Fig. 8-8
Changing the position of a publisher

Once you’ve created a publisher, you can subscribe to the material in
other documents and other applications. By default, whenever you save a
document, any changes made to a publisher or the objects it encloses are
updated in the edition file. Subsequently, the next time you open a
document containing a subscriber of that edition, the subscriber is
automatically updated. Publisher and subscriber options allow you to turn
the automatic updating feature off.

Publisher options

Publishers have certain options that you can control such as automatic or
manual updating of edition files. To view or change a publisher’s options,
select the publisher, then choose the Publisher Options command from
the Publishing submenu under Edit. (This command changes to Sub-
scriber Options when you select a subscriber.)

Publisher Options…
Edit menu
Publishing submenu

Show/Hide Borders
Edit menu
Publishing submenu
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Fig. 8-9
Publisher Options dialog

The pop-up menu shows the name and location of the edition file. Other
controls let you cancel the publisher or change when the edition file is
updated.

Although automatic updating is an important convenience that publish
and subscribe offers, you may want to turn this feature off occasionally.
For example, suppose that you’re about to make several changes to your
company logo (which has been published and subscribed to in several
documents). Since you’ll be saving the logo document periodically during
the revision process, you might want to turn off automatic updating until
the final change is made.

To turn automatic updating off, click the Manually option on the pub-
lisher options dialog. With this option selected, the edition file is updated
only by clicking the Send Edition Now button. With the On Save option
selected instead, the edition file is updated each time you save the
document.

If you want to permanently cancel a publisher, click the Cancel Publisher
button. Cancelling a publisher removes the associated edition file. You
can also cancel a publisher by clearing the publisher box in the drawing
window (select the publisher then choose the Clear command from the
Edit menu or press the Delete key).

Warning Informed Manager DOES NOT automatically update subscrib-
ers, even if automatic updating is turned on. Only Informed
Designer offers automatic updating. The assumption here is that
once a form is complete and in circulation for use with Informed
Manager, you probably don’t want any of its subscribers to
update automatically when the original publishers change.

Publish and subscribe

You can also double-click
a publisher’s frame to
display the publisher
options.
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Creating a subscriber

Once you’ve created an edition by publishing material, you can place it
on any document at any position and at any size. With the document that
you want to place the material on open, choose the ‘Subscribe to’ com-
mand from the Publishing submenu under Edit. The dialog box for
subscribing appears.

Fig. 8-10
Subscribing dialog box

The dialog box shows a scrolling list of files and folders with the last
edition file that you created selected. A preview of the edition is shown
on the left. Select the edition that you’d like to subscribe to, then click the
Subscribe button. A subscriber is created and the material in the edition is
placed on your form.

Fig. 8-11
Subscriber

A subscriber is identified by a dark gray frame. In the drawing window,
you can show and hide these borders by choosing the Show Borders and
Hide Borders commands from the Publishing submenu under Edit. Like
any object on your form, you can select a subscriber by clicking it with
the Pointer tool. You can change the size and position of a subscriber the
way you normally do. You can also use commands that manipulate
objects—such as Duplicate, Replicate,

Show/Hide Borders
Edit menu
Publishing submenu
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Align—to change the position, size, and orientation of a subscriber. For
information about manipulating objects, please see chapter 7, Manipulat-
ing objects.

Once you’ve created a subscriber, Informed Designer will automatically
update it whenever the material in the edition file changes. Publisher and
subscriber options allow you to turn the automatic updating feature off.

Subscriber types

Different applications publish material using different standard formats
for text and graphics. Normally, if the material consists of graphics and
text (or graphics only), the PICT format is used. (PICT is the standard
format for Macintosh graphics.) The TEXT format is used for textual
information. Some programs publish material in both PICT and TEXT
formats. For example, a spreadsheet might publish a picture of a color
graph in PICT format along with the numerical data that the graph is
based on in TEXT format.

When you create a subscriber, Informed Designer determines which
formats are contained in the selected edition file. If both PICT and TEXT
formats are available, a dialog appears requesting that you select which
format you’d like to subscribe to.

Fig. 8-12
Selecting the subscriber type

Unlike pictures, textual subscribers have their own font, size, and style
information. You can change these attributes by selecting the subscriber
with the Pointer tool and choosing a different setting the way you nor-
mally do. This is often referred to as adorning the subscriber. For
information about the characteristics of text, please see The appearance
of text in chapter 5, Drawing tools.

Publish and subscribe



8 - 12 Chapter 8: Using graphics

Select the subscriber ... ... then choose a style.

Fig. 8-13
Changing the font and style of a text subscriber

The effect of changing an attribute of text is not lost when the subscriber
is updated with a new version of the edition. For example, if you sub-
scribe to some text and change its style to bold, when the subscriber is
later updated, the new text will remain bold.

Subscriber options

Like publishers, subscribers have various options that you can control. To
view or change a subscriber’s options, select the subscriber, then choose
the Subscriber Options command from the Publishing submenu under
Edit.

Fig. 8-14
Subscriber Options dialog

With automatic updating on, a subscriber is updated whenever the
material in the edition file changes. You can turn automatic updating off
by choosing the Manually option. With this option selected, a subscriber
is updated only by clicking the Get Edition Now button. If you want to
open the document that contains the original material, click the Open
Publisher button. Your Macintosh will run the application that was used
to create the original material and open the appropriate document.

If you want to cancel a subscriber permanently, click the Cancel Sub-
scriber button. Cancelling a subscriber detaches the artwork (a PICT
object) from the associated edition file. The remaining object acts as
though it was originally copied and pasted from the original document.

You can also double-click a
subscriber to display the
subscriber options.

Subscriber Options…
Edit menu
Publishing submenu
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Informed Designer allows you to use color to enhance your forms. You
can use color to:

❏ Print spot color overlays for commercial printing

❏ Print color forms on color printers

❏ Highlight areas on your form so that they stand out on the screen.

You should use color sparingly on your form. Excessive use of color can
often lead to unattractive results. You should also plan to ensure that a
selection of colors blend well when used together.

Informed Designer allows you to define up to 1,000 different colors.
However, the maximum number of colors that you can display on a color
screen or print on a color printer depends on the capabilities of the screen
or printing device.

If you’re using a black & white screen, all colors appear as black, white,
or as shades of gray. When you use a color screen, colors appear approxi-
mated. The color on your screen may not match exactly what appears
printed due to inaccuracies in the current color technology.

Defining colors

Before you begin designing your form, you should define the colors that
you’d like to use. Each time you create a new form, Informed Designer
automatically adds five colors for you: Registration, Black, Red, Green,
and Blue. ‘Registration’ is a special color used for printing spot color
overlays. See Spot color for more information.

Informed Designer stores your colors in a color chart. You can display
the Color Chart window by choosing the Color Chart command from the
Layout menu.

Color Chart
Layout menu
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Fig. 9-1
Color chart window

Like any Macintosh window, you can position the Color Chart window
anywhere on your screen by clicking and dragging its title bar. You can
hide the Color Chart by clicking the window’s close box or by choosing
the Close command while the window is active.

The Color Definition dialog

When you create a new color or change an existing color, you name your
color and change its value using the Color Definition dialog. This dialog
is shown below.

Fig. 9-2
Color Definition dialog

Close
File menu
Command-W

Scroll bar

Close box Title bar

Color model controls

Color name

Old sample color

New sample color

Defining colors
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You change a color’s name by typing a different name in the ‘Color
Name’ text entry box. Choose a descriptive name that identifies the color
or its use.

You can define a color value using one of three different color models:

❏ RGB

❏ CMYK

❏ HLS.

The RGB (Red, Green, Blue) model is used commonly with video display
technology. The CMYK (Cyan, Magenta, Yellow, Black) model is used
with four-color printing, and the HLS (Hue, Lightness, Saturation) model
is commonly used in graphic design.

To choose a color model, click the corresponding radio button on the
Color Definition dialog. The text entry boxes below will change accord-
ing to the selected model. Then enter the desired values for the color that
you’re defining or changing. As you type different values, the color is
shown near the bottom of the Color Definition dialog. When you change
a color, both the new and the original colors are shown.

You can also use Apple’s Color Picker to choose a color value. To use the
Color Picker, click the Pick Color button. The Apple color wheel will
appear.

Fig. 9-3
Apple color wheel
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To change the color, click and drag the pointer on the color wheel.
Moving the pointer around the wheel changes the hue value. Moving the
pointer toward or away from the center changes the saturation value. To
change the brightness level, click the scroll bar to the right of the color
wheel. After you’ve selected your color, click OK to dismiss the Color
Picker dialog. The color parameters are automatically set on the Color
Definition dialog. For more information about Apple’s color wheel,
please consult your Macintosh Owner’s Guide.

After you’ve named and selected the right color value, click OK to save
the color and dismiss the Color Definition dialog. To cancel any changes,
click Cancel instead.

Creating a new color

To create a new color, choose the New command from the File menu
while the Color Chart window is active. Informed Designer creates a new
color and displays it in the Color Definition dialog (see Figure 9-2). Use
the Color Definition dialog to name the new color and choose the color
value. For more information, see The Color Definition dialog earlier in
this chapter.

After you’ve entered the required parameters, click OK to save the color
and dismiss the Color Definition dialog. The new color is added to the
Color Chart window at the end of the list. If Informed Designer detects an
error, you’ll be notified with a message. To cancel creating the new color,
click Cancel instead.

Editing a color

To change a color’s name or value, select the color in the Color Chart by
clicking it with the pointer, then choose the Open command from the File
menu. Alternately, you can edit a color by double-clicking its name in the
Color Chart window. The selected color is displayed in the Color Defini-
tion dialog. For more information, see The Color Definition dialog earlier
in this chapter.

New
File menu
Command-N

Open…
File menu
Command-O

Defining colors
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Important You can’t change the color definition for the colors ‘Black’, ‘Red’,
‘Green’, ‘Blue’, and ‘Registration’. When you select one of these
colors, choosing the Open command will sound a beep.

Clear
Edit menu

After changing a color’s name or value, click OK on the Color Definition
dialog to save the changes. To cancel any changes, click Cancel instead.

In Coloring objects later in this chapter, you’ll learn how to change the
color of objects on your form. Once you’ve set the color of an object,
Informed Designer remembers the color by linking the object to the
corresponding entry in the Color Chart. If you subsequently change the
color’s definition, all existing objects of that color will also change.

Removing a color

To remove a color, first use the pointer to select the color in the Color
Chart window. Then choose the Clear command from the Edit menu. The
selected color is removed from the Color Chart. To remove more than one
color at a time, select each color (by Shift-clicking) and choose Clear.

When you remove a color that’s linked to existing objects on your form,
Informed Designer will automatically change those objects to black. For
example, if you remove a color called ‘Orange’, Informed Designer will
automatically change the color of all orange objects to black. You’ll see a
warning message first.

Fig. 9-4
Remove color warning

Click OK to remove the selected color. To cancel the Clear command,
click Cancel instead.
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Informed Designer won’t allow you to remove the first five colors from
the Color Chart. If you choose the Clear or Cut commands while any of
these colors are selected, you’ll see the message below.

Fig. 9-5
Can’t remove color message

Click OK to dismiss the dialog.

Using the Clipboard

With the Clipboard, you can easily transfer colors from one form to
another. To transfer a color from one form to another, follow these steps:

1. Open the form that contains the color that you’d like to transfer.

2. Display the Color Chart window by choosing the Color Chart command
from the Layout menu.

3. Select the color that you’d like to transfer.

4. Choose the Copy command from the Edit menu to copy the selected
color to the Clipboard.

5. Open the form that you’d like to transfer the color to.

6. Display the Color Chart window.

7. Choose the Paste Colors command from the Edit menu.

If you want to transfer more than one color, select each color before you
choose the Copy command in step 4 above.

Defining colors

Copy
Paste

Edit menu
Command-C, V
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Coloring objects

After you define your colors, you can change the color of any object by
using either the Paint command or the Color submenu. Select the object
(or objects) that you want to color, then pick a different color from the
Color submenu under Style, or choose the Paint command. When you use
the Paint command, you choose a different color from the Color pop-up
menu on the Paint dialog.

Fig. 9-6
Choosing a color from the Paint dialog

For more information about the Paint command and the Color submenu,
see Paint settings.

Informed Designer allows only one color per object. This means that you
can’t, for example, color the pen and fill shades of a rectangle differently
nor can you change the color of an individual section in a field or table.

Spot color

You can print a color form on black & white or color printers. You can
also produce spot color overlays for commercially printed forms. Spot
color refers to the printing process where separate ink is mixed for each
different color on a form.

When a form is printed using spot color, a different printing plate is
prepared for each different color on the form. Ink is mixed for each color
and applied to the paper stock by impressing each plate using the printing
press. To prepare each printing plate, a separate color overlay is provided
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abc forms

Tax
Total

Printed form

Tax
Total

abc forms

Tax
Total

Black

First color

Red

Second color

Spot color

for each color. Figure 9-7 below illustrates the color overlays for a two
color form.

Fig. 9-7
Overlays for a two color form

You can think of color overlays as transparent slides that, when placed
over top of each other, produce the composite image of your form.

Informed Designer can separate and print color overlays for you. When
you print your form, you can print color overlays and use a variety of
other printing features by clicking any of the check boxes in the lower
section of the Print Job dialog.

Fig. 9-8
LaserWriter Print Job dialog
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To print color overlays, click the ‘Spot Color Overlays’ check box. You
can optionally print registration marks, color names, and cutouts as well.
These are described in the following sections. For more information about
printing a form, see Printing in chapter 10.

Registration marks

It’s important that each color overlay of a form is aligned precisely with
the others to ensure that all colors are positioned accurately. Your
commercial printer aligns each overlay by lining up registration marks—
the circular symbols that are positioned at exactly the same place on each
overlay.

Informed Designer can print registration marks for you. Registration
marks appear centered outside of each edge of a form. Simply click the
‘Registration marks’ check box on the Print Job dialog when you print
your form.

When you set up the drawing area of your form, you must allow for
enough room between the drawing area and the edge of the page that it’s
printed on. See Allowing for crop marks, registration marks, and color
names for more information.

Color names

Each color overlay is printed on a separate sheet of paper. If you click the
‘Color Names’ check box on the Print Job dialog, Informed Designer will
print the appropriate color name below the bottom edge of each color
overlay (see Figure 9-7).

Cutouts

When you print color overlays, you can print overlapping colors with or
without cutouts. If two objects on your form are colored differently, they
will appear on separate color overlays. If these objects overlap, the two
colors will mix during the printing process to produce a third color. If you
don’t want different overlapping colors to mix, use the cutouts feature
when you print your form. Informed Designer will automatically ‘cut out’
objects that overlap on different overlays. Figures 9-9 and 9-10 below
illustrate a two color form printed with and without cutouts.

Registration mark
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abc forms

Total
First color

abc forms

Total
Second color

Fig. 9-9
Form with cutouts

abc forms

Total
First color

abc forms

Total
Second color

Fig. 9-10
Form without cutouts

To use the cutouts feature, click the Cutouts check box on the Print Job
dialog when you print your form.

Spot color
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This chapter describes printing with Informed Designer. You can print
your forms on any printer that works with a Macintosh computer. These
include Apple’s ImageWriter and LaserWriter printers, as well as other
PostScript compatible printers such as Linotronic and Varityper image-
setters. You select a printer using the Chooser desk accessory from the
Apple menu. For instructions on using the Chooser desk accessory, please
consult your Macintosh Owner’s Guide.

To print your form, choose the Print command in the File menu. The Print
Job dialog will appear.

Standard 
print 
options

Informed
Designer
print options

Fig. 10-1
Print Job dialog

The top portion of the Print Job dialog controls standard printing options
such as the number of copies, the range of pages to print, and the paper
feed choices. These options vary depending on which printer you’re
using. Please consult your printer’s manual for more information.

The lower portion of the Print Job dialog controls printing options
specific to Informed Designer. Depending on which mode you’re in
(design mode or test mode), Informed Designer will offer different
printing options. These options are described later in this chapter.

After you select your printing options, click OK to print your form.
Informed Designer will display the Print Progress dialog:
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Fig. 10-2
Print progress dialog

You can cancel printing at any time by clicking the Cancel button or by
pressing the Command-Period (.) keystroke combination.

Printing from design mode

In design mode, all of the print options except ‘Hide Layout’ and ‘Hide
Data’ are enabled.

You can print the grid, the guide lines, and the cells by clicking any of the
corresponding check boxes on the Print Job dialog. When you print your
form, Informed Designer will overlay the grid and the guide lines as they
appear in the drawing window on your screen. If you choose the ‘Print
Cells’ option, the name and tab position of each cell will appear in the
fields and tables on your form.

Tiling

When a form’s drawing area is larger than the selected paper size,
Informed Designer will tile the form onto multiple sheets of paper. For
example, suppose that you’re printing a tabloid size form (11" by 17") on
standard US letter sheets (8.5" by 11"). Informed Designer will produce
four sheets of paper for each copy of the form that you print. This process
is illustrated below.

Printing from design mode

Printing

If you have not registered your copy of Informed Designer, an "Informed" watermark will be printed on each form. Once you register and enter your serial number, the watermark will no longer appear.
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Tabloid drawing area 
(11” by 17”)

Four 8.5” by 11” sheets

Fig. 10-3
Printing a tabloid sized form on US letter sheets

When you set up your form’s drawing area, Informed Designer indicates
how tiling will occur by drawing gray ‘page break’ indicators on the
Drawing Setup dialog. Page break indicators also appear on the drawing
window. See Page size for more information.

If you select the manual tile print option, Informed Designer will print a
single sheet containing the area of your form that’s immediately below
and to the right of the zero point (the zero point is the position where the
zero mark on the horizontal and vertical rulers intersect). For forms that
are larger than the selected paper size, the manual tile option allows you
to print a particular area of your form without having to print the entire
form on multiple sheets.

To use the manual tile option, position the zero point just above and to the
left of the area on your form that you want to print. When you choose the
Print command, click the ‘Manual Tile’ check box on the Print Job
dialog. Figure 10-4 illustrates manual tiling.
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Drawing window

Printed page

Fig. 10-4
Manual tiling

If you printed the form above without the manual tile option, Informed
Designer would print four sheets instead of one. For information about
changing the zero point, see Ruler zero point.

Crop marks

When a commercial printer prints your form, the size of the paper stock
used is often larger than the size of the form itself. To indicate where to
trim a printed form, crop marks are printed at each corner.

Crop marks
ABC Company

Black

Fig. 10-5
Crop Marks

Printing from design mode
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Informed Designer can print crop marks for you automatically. Simply
click the ‘Crop Marks’ check box on the Print Job dialog.

Since crop marks appear outside the edge of a form, you must allow
enough space between the drawing area and the page edge when you
setup your form. Otherwise, crop marks won’t print. For more informa-
tion, see Allowing for crop marks, registration marks, and color names.

Spot color overlays

Chapter 9 describes Informed Designer’s color capabilities. You can print
a color form on a black & white or color printer, or you can print spot
color overlays to prepare your form for commercial printing. Spot color
refers to the printing process where a separate overlay is provided for
each different color on a form. See Spot color for a complete description
of spot color and the printing process.

If you check the ‘Spot Color Overlays’ check box on the Print Job dialog,
Informed Designer will print a separate overlay for each color on your
form. You can include the name of each color below the bottom edge of
each overlay by checking the ‘Color Names’ check box.

On your form, differently colored objects appear on separate color
overlays. If you check the Cutouts check box, Informed Designer will
‘cut out’ overlapping objects that are colored differently. See Cutouts for
more information.

It’s important that each color overlay is aligned precisely with the others
to ensure that all colors are positioned accurately. Color overlays are
aligned using registration marks—the circular symbols positioned at
exactly the same place on each overlay. If you check the ‘Registration
Marks’ check box, Informed Designer will print registration marks at the
middle of each edge of your printed form.
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Printing from test mode

As you design a form, you can test its calculations, formatting options,
and intelligent features with Informed Designer’s test mode. You can
enter cell values to make sure that you’ve selected the correct type
attributes. You can also print a completed form, allowing you to see how
your form looks when a person prints it with Informed Manager.

Two options are associated with printing a form in test mode (they’re also
available when you’re using Informed Manager). For printing onto
preprinted forms, Informed Designer allows you to hide your form’s
layout. The term layout refers to the graphic attributes of a form (i.e., the
lines, boxes, headings, and labels on a blank form). If you check the
‘Hide Layout’ check box, only the information in each cell will be
printed.

………
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…………… …

…………… …
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…………… …

…………… …

…………… …

…………… …
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………… …………

………
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…………… …

…………… …

…………… …

…………… …

………… …………

Fig. 10-6
Sample form with layout and data (left), and with layout hidden (right).

If you check the ‘Hide Data’ check box, Informed Designer will print
only your form’s layout. Use this option to print a blank copy of your
form.

For a complete description of Informed Designer’s test mode, see Testing
your form.

Printing from test mode

Note Even if you hide the layout, you can still print certain objects on your
form. For any selected object (in design mode), if you check ‘Print
always’ on the Object dialog (from the Settings menu), Informed
Designer will always print that object, regardless of whether you
hide the form’s layout or not. This is useful, for example, if you’d like
to print a logo on a preprinted form. See Objects and printing for
more information.
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Fractional character widths

On occasion, the inaccuracies between the resolution of the Macintosh
screen and PostScript laser printers will result in inconsistent type
spacing. This inconsistency is often more noticeable with larger, bolded
type faces where the spacing between words may appear too coarse. You
can correct this problem by selecting the ‘Fractional character widths’
option from the Preferences dialog. Informed Designer will then adjust
the spacing of text on the screen and on the printed form. You should use
this option only if you’re printing on a PostScript printer.

To display the Preferences dialog, choose Preferences from the Edit
menu:

Fig. 10-7
Fractional character widths

For information on the other options on this dialog, please see Faster
scrolling in chapter 4.
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With electronic mail, or e-mail, systems becoming more and more
common, applications are starting to take advantage of this enabling
technology. Rather than physically moving information from one person
to another or relying on floppy disks or file servers to do so, users can
now mail information electronically over a network.

An electronic mail system provides a variety of services for sending and
receiving information electronically, making it an effective tool for
moving information throughout an organization. Although this capability
is most valuable for routing completed forms for approval purposes
(using Informed Manager), the occasional need to send a form design to
another colleague makes e-mail a useful tool for forms designers as well.

In this chapter you’ll learn how to send and receive forms with Informed
Designer. You’ll also learn how to pre-configure a form so that address-
ing and sending completed forms for routing purposes using Informed
Manager is easier. The commands described in this chapter are those
available in the Mail submenu found in Informed Designer’s File menu.

Sends a form
Opens a mailed form

Sets Informed Manager
mail options

Fig. 11-1
File menu and mail commands

The remaining sections of this chapter assume that you’re familiar with
the electronic mail system used in your organization. You should also be
familiar with the content of form documents and Informed Designer’s
Save and Save As commands. See chapter 1, Manipulating documents,
for more information.
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A mail enabled application

Most e-mail systems allow you to include files when you send memos
and messages. It’s this capability that makes it possible for you to send
form documents to other individuals. A mail enabled application is an
application that provides you with direct access to e-mail services from
within the application’s environment. A mail enabled application, there-
fore, makes it very convenient for you to send and receive forms without
having to leave the application.

Informed Designer is a mail enabled application. It can interact with the
electronic mail systems listed below.

❏ Apple Computer’s PowerTalk  v1.0

❏ Microsoft Mail v3.0 or later

❏ CE Software’s QuickMail v2.5 or later.

Informed Designer interacts with an electronic mail system by communi-
cating with an Informed mail extension. A mail extension is a file that
contains the software which interfaces directly with the specific electronic
mail system.

sent to recipient 
by e-mail

Fig. 11-2
Informed Designer and mail extensions

New mail systems

In addition to the mail systems listed in this chapter, Informed now supports mailing forms with Eudora and cc:Mail. For more information  on how mailing forms has changed in version 1.4.3,  see the 1.4.3 Addendum.
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By using mail extensions we’re able to insulate Informed Designer from
the complexities of different e-mail systems. This allows us to introduce
support for new or different e-mail systems by simply developing new
mail extensions, therefore eliminating the need to release new versions of
Informed Designer. In fact, it’s likely that by the time you read this,
additional mail extensions will have been made available for mail ena-
bling Informed products with other electronic mail systems.

It’s important that you install only the Informed mail extension for the
electronic mail system used in your organization. For more information
about extensions and the correct installation procedures, please see your
Informed Extensions manual.

Menus and commands

Access to e-mail services is provided through the commands in the Mail
submenu of Informed Designer’s File menu.

Fig. 11-3
Mail commands

To send forms you use the Send command. Receiving forms, however,
works differently depending on which e-mail system you’re using. For
example, if you’re using Apple’s PowerTalk, you access mail directly
from your mailbox’s In Tray. With Microsoft Mail you can access mail
from within Informed Designer using the Open command in the Mail
submenu. Reading mail using QuickMail requires the use of the
QuickMail desk accessory.

Note In addition to electronic mail services, PowerTalk also provides
support for digital signatures. Installation of the Informed
PowerTalk  mail extension enables PowerTalk’s e-mail services only.
To enable PowerTalk’s digital signature support, you must install the
DigiSign  signature extension.
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The Open command is present in the Mail submenu only if you’re using
Microsoft Mail or another e-mail system that allows opening mail from
within applications.

Mail formats

When you send a form with Informed Designer, you can choose one of
several different data formats to use. Informed Designer supports three
different formats: Layout only, Layout & data, and Letter. The format
that you choose depends on who you’re sending the form to and how. The
Letter format is available only if you’re using the PowerTalk e-mail
system.

As its name implies, the ‘Layout & data’ format includes both the data of
the form and its layout. When you select this option, Informed Designer
sends the entire form document including all completed forms. For more
information about the content of form documents, please see chapter 1,
Manipulating documents.

The ‘Layout only’ data format is similar to the Layout & data option
except the data for the complete forms in the document is omitted. Use
this option when you want to send the form’s design only.

The Letter format is a special format that’s available only if you’re using
PowerTalk. A letter document is a document that applications such as
AppleMail can open. Informed Designer cannot open letter documents.

When you send a form as a letter, the actual content of the letter is an
image of the form. You should use the Letter format if you’re not sure
whether or not the person you’re sending a form to has Informed De-
signer. The recipient can open and view the form with AppleMail. You
should also use the Letter format if the form you’re sending will be
delivered to the recipient via an imaging device such as a fax machine or
a printer.

For more information about letter documents and the AppleMail applica-
tion, please see your PowerTalk User’s Guide.

Mail formats
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Sending forms

With a form document open, the Send command is available in the Mail
submenu. To send the form to another user, choose the Send command.

Informed Designer examines your Informed Extensions folder to deter-
mine which mail extension you’ve installed and invokes that extension to
send the form. If Informed Designer finds more than one mail extension
in your Informed Extensions folder, you’ll be asked to select which e-
mail system you’d like to use to send the form.

Fig. 11-4
Selecting a mail extension

Normally the above dialog will be avoided because your Informed
Extensions folder should contain only one mail extension which corre-
sponds to the electronic mail system that you use.

You’ll then be asked to address the form and specify various send
parameters. These parameters and the appearance of the addressing dialog
vary for each different e-mail system.

Sending with PowerTalk

If you’re using PowerTalk, after choosing the Send command you’ll see
the PowerTalk addressing dialog. You use this dialog to select the
recipients of the form, choose the appropriate data format, specify the
form’s subject, and change the identity of the sender.

Send…
File menu
Mail submenu
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Fig. 11-5
PowerTalk addressing dialog

The leftmost scrolling list is your window into catalog information. The
catalog contains users to which you can send mail. You can browse
through server-based catalogs or personal catalogs to find particular
users. To address the form, select a user in a catalog and click the ‘To’
button. To send a carbon copy, click ‘CC’ instead. The user’s name will
appear in the list of recipients. To remove a user from the recipients list,
select the user in that list, then click Remove.

With PowerTalk, you can send an actual form document or a letter
containing an image of the form. To send a form document, choose either
of the ‘Layout only’ or ‘Layout & data’ settings from the ‘Send:’ pop-up
menu. These format options are described earlier in Mail formats. You
should send a form document only if you’re sure that the person receiving
the form has Informed Designer.

Select the Letter setting to send a letter. The ability to send a form as a
letter means that you can send forms to users who do not have Informed
Designer. The recipient of a letter can open and view the form using
AppleMail. Also, be sure to use the Letter option if you know that the
form will be delivered via an imaging device such as a fax machine or a
printer.

For a detailed explanation of letter
documents, please see your
PowerTalk User’s Guide.

Sending forms
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Each form that you send using PowerTalk also has a subject. Informed
Designer automatically enters the form’s name as the subject for you.
You can change it if you like.

The Change Sender option allows you to send a form using your identity
on another person’s computer. When you click Change Sender a dialog
appears asking for your PowerShare account information. You use the
dialog to locate your PowerShare catalog and enter your name and
password. Once you have entered your account information, you can mail
the form to the recipient.

When you change the sender information you are not interfering with the
PowerShare account of the person whose computer you’re using. Your
sender identity is valid only for the specific form.

After addressing the form and specifying the format options, and subject,
click Send on the addressing dialog. Informed Designer will send the
form. To cancel the Send command, click Cancel instead.

Sending with Microsoft Mail

If you’re using Microsoft Mail, when you choose the Send command
you’ll be prompted to select whether you would like to send the form’s
layout only or include the data as well.

Fig. 11-6
Selecting the data format

Select the Layout only option to send the form’s layout only. To include
the completed forms contained in the document (if any), choose the
Layout & data option instead. For a description of these formats, please
see Mail formats earlier in this chapter. After selecting the format option,
click OK to continue. To cancel the Send command, click Cancel instead.

You’ll then see the Microsoft Mail send dialog. You use this dialog to
select the recipients of the form, enter a comment, and enclose any
additional files with the form.


For changes to the Microsoft Mail Send dialog, see the 1.4.3 Addendum.
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Fig. 11-7
Microsoft Mail send dialog

Chapter 5 of your Microsoft Mail User’s Guide describes how you
address mail. Depending on your Microsoft Mail preferences, you’ll
either choose a person from the list on the dialog shown above, or you’ll
click the Address button and select a person from the Address dialog.
You can send the form to one person or to as many people as you like.
Please refer to your Microsoft Mail User’s Guide for more information.

The subject of the form is filled in by Informed Designer. You can
change it if you like. You can also enter a comment in the large scrolling
area on the send dialog.

Once you’ve addressed the form and specified the subject and comment
(optional), click Send on the send dialog. Informed Designer will send the
form. To cancel the Send command, click Cancel instead.

Sending forms
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Pre-addressing with Microsoft Mail

Mail options, on page 11-12, describes how to pre-address a form so that
the Informed Manager user doesn’t have to manually address the form if
he or she always sends it to the same person. When you choose to pre-
address a form using Microsoft Mail, the Pre-address Microsoft Mail
dialog appears. This dialog is different from the standard Microsoft Mail
dialog that you see when sending forms:

Fig. 11-8
Pre-addressing Microsoft Mail

You use this dialog to pre-address a single form, or a collection of forms.
The information you enter into this dialog is the same as described above
for sending mail. You select the recipient(s) of the form, choose the
format, and you can specify the form’s subject.

The pop-up menu, above the left scrolling list, offers three different lists
from which you can pick the recipients of your mail. They are Address
Book, Local Users, and All Users. Address Book displays a personalized
list of the user and group names you’ve added to the Address Book. Local
Users displays only the users on your mail server. All Users displays all
users on all the mail servers connected to your network.

 To pre-address a form, select a recipient from the list, then click
‘» To »’, ‘» CC »’, or ‘» BCC »’. Clicking ‘» CC »’ or ‘» BCC »’, sends a
carbon copy or a blind carbon copy to the selected recipient. You can add
as many users as you like to the Recipients list. To remove a user from
the Recipients list, select the user’s name from the list, then click Re-
move.
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Sending with QuickMail

If you’re using QuickMail, after choosing the Send command you’ll see
the QuickMail addressing dialog. You use this dialog to select the
recipients of the form, choose the appropriate data format, and enter a
comment.

Fig. 11-9
QuickMail addressing dialog

QuickMail allows you to create multiple address books in order to better
organize large lists of users. On the addressing dialog, you select an
address book by choosing its name in the ‘Address Book:’ pop-up menu.
The users in the address book will appear in the Names scrolling list.

To address the form, select a user from the Names list, then click
‘» To »’, ‘» CC »’, or ‘» BCC »’. Clicking ‘» CC »’ or ‘» BCC »’,
respectively, sends a carbon copy or blind carbon copy to the selected
recipient. You can add as many users as you like to the Recipients list. To
remove a user from the Recipients list, select the user’s name in that list,
then click Remove.

You can also select a user by
typing the first letter of the sur-
name, or by pressing the up or
down arrow keys. Before typing,
be sure to select the list first.
Pressing the Tab key will move the
selection between the Names and
Recipients lists and the Comments
text entry box. Double-clicking a
user in the Names list adds that
user to the Recipients list. Double-
clicking a user in the Recipients list
removes that user from the
Recipients list.

Sending forms

Once you have pre-addressed the form, click OK. The Mail Options
dialog appears. Choose the confirmation option and click OK. The form
is now pre-addressed. For information about the Mail Options command,
please see Mail options later on in this chapter.
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Select the appropriate data format from the ‘Send:’ pop-up menu. The
available data formats are described in Mail formats earlier in this
chapter. You can enter a comment in the text entry box provided.

After addressing the form and specifying the other send parameters, click
Send to send the form. To cancel the Send command, click Cancel
instead.

Mail options

Informed Designer allows you to select different mail options to pre-
configure a form for use with Informed Manager. In situations where you
know in advance where the Informed Manager user will be sending
completed forms, you can pre-address the form yourself. For example, in
small organizations or departments, accounting forms such as purchase
requisitions or time cards often travel directly to a specific individual in
accounting.

Choose the Mail Options command from the Mail submenu to display the
Mail Options dialog for the currently active form.

Fig. 11-10
Mail Options dialog

If you select the ‘address manually’ option, each time a completed form is
sent using Informed Manager, the user will have to manually address the
form. To pre-address the form, select the pre-address option instead.

Mail Options…
File menu
Mail submenu
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Fig. 11-11
Pre-addressing the form

Select the e-mail system with which forms will be sent by choosing its
name from the ‘pre-address using:’ pop-up menu. Normally this pop-up
menu will contain only one entry which corresponds to the e-mail system
you use.

Next, click Address. Informed Designer will invoke the selected mail
extension to prompt you for the necessary addressing information. The
specific addressing parameters and the appearance of the addressing
dialog vary depending on which e-mail system you’re using.

The settings and recipients that you select will be stored with the form.
These settings will be selected automatically by Informed Manager each
time the user chooses the Send command. For an explanation of the send
parameters and addressing dialog, please see chapter 7 of your Informed
Manager Reference manual.

The confirmation options below the Address button determine whether or
not Informed Manager will display the addressing dialog each time the
user sends a completed form. If you choose the ‘User confirms address
before sending’ option, Informed Manager will display the addressing
dialog with the pre-addressed settings selected each time a form is sent.
This gives the user a chance to confirm or override these settings before
sending the form. If you choose the ‘Form sent immediately without
confirmation’ option instead, Informed Manager will send the form
immediately without requesting confirmation.

As the form designer, you have the option of locking the mail options so
that the Informed Manager user can’t change them. This feature is useful
in situations where it is very important that the user always send forms to

You can reverse the effect of the
confirmation option by holding
down the Option key when
choosing the Send command.

Note Some mail extensions do not support pre-addressing. If the selected
mail extension does not support pre-addressing, you’ll see a mes-
sage indicating so when you click the Address button.

Sending forms
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a particular user or address. To lock the mail options, select the ‘Informed
Manager users cannot change mail options’ check box. With this option
selected, the Mail Options command will be unavailable to the Informed
Manager user.

After selecting your send options, click OK on the Mail Options dialog.
The settings will be saved in the form document. To cancel the Mail
Options command, click Cancel instead.

Addressing on the form

Informed Manager also supports automatic addressing if the completed
form itself contains the required addressing information. If the name of
the person to which a completed form is being sent appears in a cell on
the form, Informed Manager can use this information to automatically
address the form so that the user doesn’t have to.

For example, consider an order form that’s filled out by various telephone
sales reps and mailed directly to one of five different order processing
people. By entering the name of the order processing person on the form
itself, Informed Manager can automatically address the form when the
user chooses to send it. Figure 11-12 shows what this order form might
look like.

ABC Company Inc.
12345 - 123 Street
New York, New York
47736

Order Form

Order Number:

Order Processor:

Shipping

Total

Sold To Ship To

Part Qty Description Price Amount

Fig. 11-12
Sample order form

Whenever the user mails a single form, Informed Manager looks for a cell
named ‘Mail Send To’. If such a cell exists, the form is automatically
addressed to the name in that cell. For example, if you fill out an order

Order processor’s name 
goes here.  Cell’s name 
is ‘Mail Send To’.
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form and enter ‘John Smith’ as the order processor, Informed Manager
will automatically address the form to ‘John Smith’. If John Smith is not
a valid mail user, the form will be left unaddressed.

If you pre-address a form (see Mail options) and, at the same time,
configure a cell for addressing on the form, Informed Manager will
automatically address the form to both the ‘pre-addressed’ user (or users)
as well as the address entered on the form.

Opening mailed forms

When someone sends you a form, your electronic mail system will notify
you that mail has arrived. Each electronic mail system offers its own
notification options ranging from simple audible tones, to more visual
methods of notification such as the display of a dialog or window.

The way that you open a mailed form varies depending on which e-mail
system you use and the format with which the form was sent. Some e-
mail systems allow you to open mail directly from within an application
whereas others require that you use the e-mail system itself to extract the
mailed item before opening it.

Using Informed Designer’s Open command

If your e-mail system supports opening mail from within other applica-
tions, you can do so with Informed Designer by choosing the Open
command from the Mail submenu.

When you choose the Open command, Informed Designer examines the
contents of your Informed Extensions folder to determine which mail
extension you’ve installed. If only one mail extension is found, Informed
Designer will automatically invoke that extension to open the mail. If two
or more mail extensions are found, you’ll be asked to select one.

Note Addressing on the form does not work with all e-mail systems. For
example, PowerTalk requires that a name include the full catalog
path name as well as other catalog parameters. You cannot simply
enter the user’s name alone.

Open…
File menu
Mail submenu

Opening mailed forms
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Fig. 11-13
Selecting a mail extension

Normally the dialog shown above will be avoided because your Informed
Extensions folder should contain only one mail extension corresponding
to the electronic mail system that you use. If you’ve installed more than
one mail extension, select the desired e-mail system from the pop-up
menu, then click OK. Clicking Cancel will cancel the Open command.

After clicking OK, the selected mail extension is invoked to open a
mailed form. Like addressing forms, the method for selecting and open-
ing mailed forms varies depending on which electronic mail system you
use. The details about how this is done using the different electronic mail
systems are provided in the next few sections of this chapter.

When you select a form to open, Informed Designer will open it into its
own form window. When you later close the form, you’ll be asked if
you’d like to save the document.

Fig. 11-14
Save form prompt

Clicking Cancel cancels the Close command. If you click Don’t Save, the
form will be closed without saving it on your hard disk. Any changes that
you’ve made since opening the mailed form will be lost. The original
unchanged form will remain in your e-mail’s mailbox. If you click Save
to save the document, you’ll be asked to specify where you’d like to store
the form on your hard disk.



11 - 17

Fig. 11-15
Standard Save dialog

Use the various controls to find and open the disk or folder in which
you’d like to store the form. Change the name if you like, then click Save
to save the form.

Opening mailed forms manually

For e-mail systems, such as QuickMail, that do not allow other applica-
tions to open mail directly, mailed forms must be opened manually. This
is done by first copying the enclosed form document from the mail
message to your hard disk, then opening the document the way you
normally would. For information about copying enclosed files from mail
messages, please refer to the user guide that came with your electronic
mail system.

Opening forms mailed with PowerTalk

With PowerTalk, mail sent to you arrives and appears in your mailbox’s
In Tray. Your In Tray, in many ways, is similar to a folder on your hard
disk. Items that appear in your In Tray correspond to actual documents
that can be manipulated like other documents. You can click and drag
items to copy them to other places or to move them to the Trash. You can
double-click an item to open it.

Opening mailed forms
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Depending on which format options the sender chose, a mailed form will
arrive as one of the following:

❏ a form document

❏ a letter document containing an image of the form

The following sections explain how to open forms that are mailed to you
in each of the two different formats listed above.

Form documents

A form document contains the form’s data along with its layout. When
you open a form document with Informed Designer, the form appears in
its own form window. You can open a form document from your In Tray
by simply double-clicking its icon.

Information that resides in your In Tray cannot be changed and saved
back in your In Tray. As a result, if you open and change a form docu-
ment from within your In Tray, when you close the document you’ll be
asked if you’d like to save the changes made.

Fig. 11-16
Save changes prompt

To save changes, click Save. On the Save dialog, specify the location to
store the document and a name with which to call it.
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Fig. 11-17
Save dialog

The copy that you save on your hard disk will contain the changes you
made since opening the form, whereas the original will remain unchanged
in your In Tray.

Letter documents

With PowerTalk, the sender of a form can choose to send a forms as a
letter. A letter document is a special type of document that applications
such as AppleMail can open and read. Although Informed Designer can
create letter documents, it cannot open them.

The advantage of sending a form as a letter is that the person receiving
the form doesn’t require Informed Designer to open it. When you double-
click a letter document, your Macintosh will run AppleMail, open the
document, then display an image of the form.

Opening mailed forms
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Fig. 11-18
Letter document containing an image of a form

Unlike forms that are sent as form documents, the image of a form in a
letter document cannot be edited.

Opening forms mailed with Microsoft Mail

With Microsoft Mail, you can open mailed forms either manually, or
directly from within Informed Designer. See Opening mailed forms
manually and Using Informed Designer’s Open command earlier in this
chapter for more information.

To open a mailed form from within Informed Designer, choose the Open
command from the Mail submenu. Informed Designer will display a list
of all mail items that contain a form document.

Open…
Mail submenu
File menu



11 - 21

Fig. 11-19
List of mailed forms

Select the item that you want to open by clicking it in the list, then click
Open or press Return. Informed Designer will open and read the enclosed
form document. The form will appear in its own form window. Informed
Designer will then display the comments associated with the form.

Fig. 11-20
Form comments

To close the comments window, click its close box. When you close the
form, you’ll be asked if you’d like to save the form. You save the form in
the normal way.

Opening mailed forms
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Opening forms mailed with QuickMail

Due to restrictions in the programming tools provided by CE Software,
the ability to open mail from within an application is not available for
QuickMail users. Therefore, forms mailed to you using QuickMail must
be opened manually. For information about opening forms manually,
please see Using Informed Designer’s Open command earlier in this
chapter.
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As described in chapter 6, Changing an object’s appearance, Informed
Designer remembers the default settings for each of the drawing tools. A
default setting is a setting that’s automatically selected for new objects.
For more information, see Changing default settings.

When you create a new document, Informed Designer automatically
selects a standard set of default settings for each drawing tool. These
settings are listed in Table A-1. If you want to store your own set of
default settings, use stationery documents. See Informed documents for
more information.

Table A - 1
Default settings

Tool Attribute Default setting

Text font Helvetica
font size 10
type style plain
alignment left
leading auto
color black

Line line width 1 point
pen shade 100%
line style plain
color black

Rectangle line width 1 point
pen shade 100%
fill shade 0%
line style plain
corners square
color black

Oval line width 1 point
pen shade 100%
fill shade 0%
color black

Arc line width 1 point
pen shade 100%
fill shade none
color black
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Table A - 1 (continued)
Default settings

Tool Attribute Default setting

Polygon line width 1 point
pen shade 100%
fill shade 0%
color black

Field title font Helvetica
title font size 10
title type style plain
title alignment horizontal center
title alignment vertical center
title leading auto
cell font Helvetica
cell font size 10
cell type style plain
cell alignment horizontal left
cell alignment vertical top
cell leading auto
pen shade 100%
fill shade 0%
line width 1 point
line style plain
title on
title position top
corners square
cell type character (no options)
color black

Table title font Helvetica
title font size 10
title type style plain
title alignment horizontal center
title alignment vertical center
title leading auto
cell font Helvetica
cell font size 10
cell type style plain
cell alignment horizontal left

Default settings
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Table A - 1 (continued)
Default settings

Tool Attribute Default setting

cell alignment vertical top
cell leading auto
pen shade 100%
fill shade 0%
line width 1 point
line style plain
title on
column titles on
corners square
cell type character (no options)
color black
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To use many of Informed Designer’s object manipulation commands,
you’re often requested to enter measurements for parameters such as the
size or position of an object. For example, when you duplicate objects
using the Replicate command, you specify the distance between each
duplicate by typing measurements in the Offset text entry boxes on the
Replicate dialog.

Fig. B - 1
Replicate dialog

Informed Designer makes it easy to enter measurements. Although
measurements are displayed using your choice of ruler units, you can
enter a measurement in any units you like. You can also type fractional
values such as ‘1/2’ or ‘3/8’. The remaining sections of this appendix
describe these features of Informed Designer.

Accuracy

When you draw a form with Informed Designer, you can size and posi-
tion objects with a maximum precision of 1/1152nds of an inch. Measure-
ments are displayed using four decimal places of precision. The ‘Drawing
accuracy’ setting on the Grid Options dialog lets you change the maxi-
mum precision (see Drawing accuracy in chapter 4 for more informa-
tion).

Whenever you enter a measurement, Informed Designer rounds the value
to the closest multiple of the current drawing accuracy setting. For
example, if the drawing accuracy is set to 1/1152 dpi (dots per inch) and
you type the value 1.0010, Informed Designer will round the value to
1.0009. This is because 1.0009 is the closest multiple of 1/1152.
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Measurement units

Informed Designer displays measurements using your choice of ruler
units. For example, if you’ve set the rulers to display picas, all measure-
ments will display in picas. You can change the ruler units by selecting a
different setting on the Ruler Options dialog. For more information about
ruler options, please see Rulers in chapter 4.

When you enter a measurement, you can specify the unit of measure by
appending an abbreviated suffix to the value you type. For example, if the
current ruler unit setting is inches and you want to enter a value in points,
simply append a space and the letters ‘pt’ to the numeric value that you
type. Informed Designer will automatically convert the value to inches
when you press the Tab key.

Fig. B - 2
Entering 12 points

The complete list of unit abbreviations is shown below in Table B - 1.

Table B - 1
Unit abbreviations

Unit Abbreviation

inches in
centimeters cm
picas pc
points pt

Entering fractions

Although fractional numbers are displayed in floating point form (1.5, for
example), you can also enter fractions by typing the numerator and
denominator separated by the slash symbol (/). For example, instead of
typing ‘5.375’, you could also enter ‘5 3/8’. Informed Designer will
automatically convert the value to its decimal form when you press the
Tab key.
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Fig. B - 3
Entering a fractional number
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This section contains a list of shortcuts and hidden features. These
include features that don’t appear in menus or dialog boxes.

Table C-1
Shortcuts

Category Key/Feature Description

Startup hold down the Option key opens a document during startup

Tool palette Escape/reverse quote (`) key toggles between Pointer tool and drawing tool
Option key selects Pointer tool while pressed
Tab key selects Text tool and first selected text object or title

Pointer tool double-click tool deselects all objects
Shift-click object selects multiple objects
Command-click object selects object behind
Option-click forces selection rectangle

selects objects completely enclosed
Option-Command-click forces selection rectangle

selects intersecting objects
click & drag drags outline of object(s) with pointer
click, pause & drag drags object detail with pointer
double-click text object Type command
double-click line object Paint command
double-click rectangle object Paint command
double-click oval object Paint command
double-click arc object Paint command
double-click field object Field command
double-click table object Table command
Shift-resize constrains horizontally, vertically, proportionally, or

diagonally at 45, 135, 225, or 315 degrees

Text tool double-click tool default type settings
Shift-draw constrains dimensions to square
Tab key selects first text object or title
Enter key completes text editing
Option-Enter key completes text editing and adjusts object width to fit

text
Option key selects Pointer tool while pressed
Option-Command-click draws overtop of text

Line tool double-click tool default line settings
Shift-draw constrains horizontally, vertically, or diagonally at

45, 135, 225, or 315 degrees
Option key selects Pointer tool while pressed
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Table C-1 (continued)
Shortcuts

Category Key/Feature Description

Rectangle tool double-click tool default rectangle settings
Shift-draw constrains to square
Option key selects Pointer tool while pressed

Oval tool double-click tool default oval settings
Shift-draw constrains to circle
Option key selects Pointer tool while pressed

Arc tool double-click tool default arc settings
Shift-draw constrains to quarter circle
Option key selects Pointer tool while pressed

Polygon tool double-click tool default polygon settings
Shift-draw constrains edge horizontally, vertically, or diagonally

at 45, 135, 225, or 315 degrees
Option key selects Pointer tool while pressed

Field tool double-click tool default field styles
Shift-draw constrains to square
Option-Command-click draws overtop of a field
double-click title section Type command
double-click cell section Cell command
double-click title divider Paint command
Command-drag bottom edge snaps edge to rule line
Option key selects Pointer tool while pressed

Table tool double-click tool default table styles
Shift-draw constrains to square
Option-Command-click draws overtop of a table
double-click title section Type command
double-click column cell section Cell command
double-click title divider Paint command
Command-drag bottom edge snaps edge to row lines
click in gray creates new column
Command-click in gray creates last column
Command-click in column splits one column into two
Command-drag column divider moves columns on right
Command-drag right edge extends right edge without changing width of last

column
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Table C-1 (continued)
Shortcuts

Category Key/Feature Description

Zoom tool click Enlarge command
Option-click Reduce command
double-click tool Actual Size command

Imported pictures double-click reverts to original size

Paste command Option-Paste positions pasted objects at original location

Changing pages double-click numbered page go to page dialog
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active window: The frontmost window on the desktop; the window
where the next action will take place. An active window’s title bar is
highlighted.

alignment: The orientation of text within a particular area.

annotation: A note that’s attached to a form.

Arc tool: The tool that you use to draw arcs on a form. The arc tool is on
Informed Designer’s tool palette.

arithmetic operators: Operators that calculate mathematical results.

attribute: Refers to the settings that control the appearance and general
look of an object.

auto-incrementing number: A number that is automatically advanced to
the next value each time you create a new form. Use auto-incrementing
numbers to automatically number forms such as statements and invoices.

balloon help: A System 7 feature that displays help messages in balloons
on your screen.

boolean: A data type that has a value of true or false.

boolean operators: Operators that test for more than one condition.

Box tool: See Rectangle tool.

calculation: A  formula that a cell uses to obtain its value. Usually a
calculation uses the values of other cells on a form.

cell: An area on a form that is used to hold data. Each field contains a
cell, and each column in a table contains a cell.

cell type: Refers to the kind of information that a cell can hold. Informed
recognizes eight different cell types: text, character, number, name, date,
time, boolean, and picture.

character format: A sequence of characters that rigidly defines the
length and format of a valid cell value.

check formula: A formula that verifies the correctness of data in a cell.
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choices  palette: The palette that provides a list of common choices for a
data cell on a form. You can create a list of choices for any cell on a form.

close box: The small, white box on the left side of the active window’s
title bar. Click the close box to close the active window.

CMYK: An acronym which stands for Cyan, Magenta, Yellow, Black.
CMYK is a color model that is commonly used in four-color printing.

color chart window: The window that displays all of the colors available
in an Informed document. Use the color chart window to add, remove,
and change the colors in a form.

comb: A line that divides the cell section of a field. Combs in a field ease
manual entry of data on forms, and make it easy to distinguish the
individual numbers or letters of an entry.

comparison operators: Operators that compare values.

concatenate: To combine two text values into one.

constant: A value that doesn’t change. You use constants in calculation,
default, and check formulas.

constrain: To limit the action or the effect of the Pointer tool, or any of
Informed Designer’s drawing tools. This is usually accomplished by
holding down the Shift key while using the tool.

crop mark: The small lines that indicate the page edge of a form. These
marks aid a commercial printer in trimming a printed form.

crosshairs: See ruler crosshairs.

cutout: The process that prevents overlapping colors from interfering
with each other on spot color overlays.

data type: See cell type.

default value: Refers to the initial value of a cell on a form. When you
create a new form, default cell values are entered for you. You specify the
default value of a cell using the Value command.

Phone



D - 4 Glossary

default settings: The appearance of new objects is determined by default
settings. Change the default settings to change what newly created objects
look like.

design mode: Design mode refers to the mode that you’re in when you
edit the layout of a form. Informed Designer has two modes: design mode
and test mode.

dialog: A box that contains a message. Usually a dialog requests informa-
tion or warns you of a potential error.

digital signature: A digital signature allows you to sign data on a form.
The signature verifies the integrity of the data. If the data is changed, the
signature is invalidated.

document name: The name of a document as it appears in the title bar of
its drawing window.

drawing area: The area in which you draw and manipulate a form; the
visible working area of a form in the drawing window.

drawing offset: The distance between the edge of the drawing area and
the edge of the physical page.

drawing plane: The plane that an Informed Designer object sits in. Each
object’s position in the drawing plane determines the front-to-back
ordering of all objects.

drawing size: The actual size of the drawing area. You change the
drawing size with the Drawing Setup command.

drawing window: The window on your screen that contains the layout of
a form.

EPSF: An acronym for Encapsulated PostScript Format. A type of file
format that contains PostScript information. Use the Import command to
import EPSF files.

electronic mail: An automated system for sending and receiving mail on
a computer network.

enclosing rectangle: A rectangle that encloses an area, an object, or a set
of objects on a form.
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field: A graphic object that is used to hold information. Generally, a field
consists of a title section, a dividing line, and a cell section where
information is stored.

field tool: The tool that you use to draw fields on a form. The Field tool
is on Informed Designer’s tool palette.

fill shade: The shade used to draw the interior of an object.

format: Determines the style that a value is displayed in. For example,
the format of a date determines the ordering and appearance of the day,
month, and year parts in a date value.

form document: A document created with the Informed Designer
application. A form document contains the layout of a form plus a
database of completed forms.

function: A predefined procedure that manipulates information on a form
to produce a new result. Informed Designer supports a wide variety of
functions that you can use in calculation, default, and check formulas.

graduate: To blend a shade from one darkness to another.

grid: An array of imaginary lines, separated at regularly spaced intervals
on the drawing area of a form. You use the grid to place and size objects
uniformly on a form.

grid axis: Refers to one or both of the horizontal and vertical grid
directions. With Informed Designer, the grid axis in each direction is
independent of the other.

guide lines: Lines that helps you align objects on a form.

handles: Small square boxes at each corner of an object’s enclosing
rectangle. An object’s handles are visible when the object is selected.

help message: A message to someone filling out a form (usually from the
form designer) that clarifies the information needed in a particular cell on
the form.

hierarchical menu: See submenu.
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HLS: An acronym which stands for Hue, Lightness, Saturation. HLS is a
color model that’s commonly used in graphic design.

home position: See ruler home position.

i-beam: The type of pointer that you use to edit text.

import: To transfer information from a standard format into a Macintosh
application. You can import graphics stored in the PICT, EPSF, Post-
Script, and TIFF formats. You can also import textual information.

index: A pre-sorted list of cell values that Informed Manager maintains
automatically.

information box: The rectangular box at the bottom-left corner of
Informed Designer’s drawing window. The information box displays the
current view scale of the drawing window, the scaling percentage of a
resize operation, or the progress of a time consuming task.

key: See index.

layout: The design of a form. The organization of graphic objects and
intelligent features on a form.

leading: The amount of vertical space between lines of text. Leading
values are usually measured in points.

Line tool: The tool that you use to draw lines on a form. The Line tool is
on Informed Designer’s tool palette.

literal: A formatting character such as a dash or parenthesis.

lookup: A link from one form to another which allows a form to ‘lookup’
information in one form from another.

master page: A special page that holds graphics that are common to all
pages in a form. Use the master page to hold logos, headers, and footer.

multipart page: A page on a form that prints more than once. Pages that
require more than one copy are multipart pages. Each numbered page in a
form can have up to 99 parts.
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nudge: To resize or reposition an object by a distance of one pixel on the
screen.

operand: The value that an operator uses to calculate a result.

operator: A symbol that performs an operation between one or two
values. Some types operators include addition (+), subtraction (-), and
multiplication (*).

Oval tool: The tool that you use to draw circles and ovals on a form. The
Oval tool is on Informed Designer’s tool palette.

page controls: The controls that you use to change pages in a form.

page size: The actual size of the page on which a form is printed. The
page size is different from the drawing size.

pen shade: The shade used to draw the frame of an object.

PICT: A graphic format that you can cut and paste between forms and
other Macintosh applications. You can import PICT documents using the
Import command.

Pointer tool: The tool that you use to select, deselect, reposition, and
resize objects on a form. The Pointer tool is shaped like an arrow. It’s
available on Informed Designer’s tool palette.

Polygon tool: The tool that you use to draw polygons on a form. The
Polygon tool is on Informed Designer’s tool palette.

PostScript: The page description language supported by many laser
printers and imagesetters. Informed Designer is compatible with Post-
Script printers.

Quick-Tab: A feature that lets you move between sections of a form. Use
the quick-tab feature to bypass the normal tab order of a form.

Rectangle tool: The tool that you use to draw boxes and rectangles on a
form. The Rectangle tool is on Informed Designer’s tool palette.

registration marks: The circular marks that a commercial printer uses to
line up spot color overlays.
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RGB: An acronym which stands for Red, Green, Blue. RGB is a color
model which is commonly used with video display technology.

rulers: A drawing aid that helps you measure and align objects on a
form.

ruler crosshairs: The light gray lines that appear on each of the horizon-
tal and vertical rulers. They indicate the position of the mouse and the
position of objects relative to the rulers.

ruler home position: Represents a defined position of the ruler zero
point. Informed Designer allows you to set this position at the top left or
right edge of the drawing or page.

ruler zero point: The intersection of the each zero mark on the horizon-
tal and vertical rulers.

scroll bars: The rectangular bars that appear along the right and bottom
edges of the drawing window. Clicking the scroll bars allows you to view
different areas of a form.

scroll box: The white box in a scroll bar. Click and drag the scroll box to
view different areas of a form.

selection rectangle: A rectangle that you draw with the Pointer tool to
select objects on a form.

sensitivity area: The area around a guide line where the magnetic
attraction is active.

shade: The darkness of the interior of an object on a form. The shade is
expressed as a percentage between 0 (white) and 100 (black).

size box: The size box allows you to change the size of the drawing
window. Resize the drawing window by clicking and dragging the size
box.

snapping: The process of automatically aligning—or ‘snapping’—
objects to the grid lines or guide lines on a form.
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specs palette: The palette that displays the exact position of an object and
the pointer. You can enter exact dimensions to change the size of an
object.

spot color: Refers to the commercial printing process where a separate
overlay is provided for each different color on a form.

spot color overlay: An individual color component of a form that’s
printed using the spot color technique.

stacking order: The relative front-to-back ordering of objects on a form.

stationery document: A type of Informed document used to hold
templates or personal preferences. When you open a stationery document,
it opens into a new untitled window.

submenu: A menu contained within an application menu. A submenu
provides additional choices.

tab order: The order that you tab from one cell to the next to fill out a
form. The tab position of each cell on a form determines the tab order.

tab position: The position of a cell within the tab order.

table: A graphic object used to hold information. A table is made up of a
title section and one or more columns. Each column contains an optional
title and a column cell.

Table tool: The tool you use to draw tables on a form. The Table tool is
on Informed Designer’s tool palette.

test mode: The mode of Informed Designer that you use to test a form. In
test mode you can test the intelligent features of a form.

text entry box: A box on a dialog that you type values into.

Text tool: The tool that you use to draw and edit text objects on a form.
The Text tool is on Informed Designer’s tool palette.
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TIFF: An acronym for Tagged Image File Format. A type of file format
that can be imported into an Informed Designer document. TIFF files
commonly contain scanned images.

tiling: The process of printing a large form onto multiple sheets of paper.
Tiling occurs when the size of a form is larger than the page size on your
printer.

tool palette: The palette contains Informed Designer’s tools. They
include the Pointer tool, all drawing tools, and the Zoom tool. Before you
use a tool, you select it on the tool palette.

type style: Refers to the style of a font. Some examples are plain, bold,
italic, and underline.

view scale: The scale of the drawing window. Changing the view scale
allows you to view a smaller or larger area of a form in the drawing
window. The current view scale appears in the information box near the
bottom left corner of the drawing window.

visual attribute: An attribute that controls the appearance of an object.

work page: A special page of a form that doesn’t print. You use the work
page to store the instructions for a form or cells that shouldn’t print.

zero point: See ruler zero point.

zero point marker: The small rectangular box at the intersection of the
horizontal and vertical rulers on the drawing window. Click and drag the
zero point marker to change the position of the zero point.

zoom box: The small box on the right side of the active window’s title
bar. Click the zoom box to enlarge the drawing window to its maximum
size.

Zoom tool: The tool that you use to change the view scale of the drawing
window. You use the zoom tool (from the tool palette) to enlarge the
current view of a form on the drawing window. The Zoom tool is on
Informed Designer’s tool palette.
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Index

A
accuracy 4-23, B-2
active window D-2
Actual Size command 4-21
address cell 11-14
addressing forms. See sending

forms
in advance. See pre-address-

ing forms
manually 11-12
on the form 11-14 to 11-15

Align command 7-23 to 7-26
aligning objects

to a position 7-25
to each other 7-24 to 7-25
to the grid 7-25 to 7-26

alignment 6-20 to 6-21, D-2
Alignment submenu 6-16
annotation D-2
AppleMail 11-7
arc curvature 5-14
Arc tool, 5-14 to 5-15,  D-2
arcs

appearance of 5-15
curvature of 5-14
default appearance of A-2
drawing 5-14

arithmetic operators D-2
Arrange menu 7-2
Arrow tool. See Pointer tool
artwork updating 8-5 to 8-6
attribute D-2
attributes 6-2
auto-incrementing number D-2
automatic updating 8-6, 8-9

B
balloon help D-2
blank settings 6-4 to 6-6
bold type 6-19
boolean D-2
boolean operators D-2
box. See Rectangle tool
Box tool D-2
Bring forward command 7-34
Bring To Front command 7-35

C
calculation D-2
carbon copies

sending 11-7
cell D-2
cell section 5-23 to 5-24
cell type D-2
cell(s)

duplicating 7-22 to 7-23
printing 10-3

centimeters 4-7
changing the passwords

1-9 to 1-10
character format D-2
check formula D-2
choices palette D-3,   See also

the Informed Designer Data
Intelligence manual

circle. See Oval tool
Clear command 7-7 to 7-8
clearing

colors 9-6 to 9-7
objects 7-7 to 7-8

Clipboard
closing 7-39
copying to 7-39 to 7-40
cutting to 7-39 to 7-40
displaying 7-39

pasting from 7-40 to
7-42, 9-7

using 7-38 to 7-42
close box D-3
Close command 1-15 to 1-18
closing documents 1-15 to

1-18, 1-17 to 1-18
CMYK 9-4, D-3
cocatenate D-3
color 6-16

changing 9-5 to 9-6
choosing 9-8
creating 9-5
defining 9-2 to 9-7
definition dialog 9-3
editing 9-5 to 9-6
models 9-4 to 9-5
removing 9-6 to 9-7
uses of 9-2
using the Clipboard 9-7

Color Chart 9-2 to 9-3
color chart window D-3
Color Definition dialog 9-3
color names 2-16, 9-10
Color submenu 6-10, 6-16
coloring objects 9-8
column(s)

changing position 5-33
changing width 5-30 to

5-31
distributing 5-33 to 5-34
placing 5-29 to 5-30,

5-31 to 5-33
removing 5-34

comb D-3
comb(s) 5-25 to 5-26

changing heights 6-24
comparison operators D-3
completed forms 1-3,

1-17 to 1-18, 1-21 to
1-24
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condensed type 6-18 to 6-19
constant D-3
constrain D-3
converting documents 1-11
converting units

on dialogs B-3
Copy command 7-39 to 7-40
corner rounding 6-21 to 6-22
corners 5-11 to 5-12
Corners command 6-21 to

6-22
create

subscriber 8-10
Create Publisher command 8-6
creating

colors 9-5
crop marks 10-5 to 10-6
documents 1-5 to 1-6,

1-15 to 1-18
creating a publisher 8-6 to 8-7
creating a subscriber 8-10
crop mark D-3
crop marks 2-16
cross pointer 5-9
crosshairs 4-3, 4-9 to

4-10, D-3
Cut command 7-8, 7-39 to

7-40
cutout D-3
cutouts 9-10
cyan. See CMYK

D
dashed lines 6-15
data changes 1-21 to 1-24
data documents 1-4 to 1-5
data file 1-4 to 1-5
data type D-3
default address. See pre-address-

ing forms
default settings 1-4 to 1-5,

6-6 to 6-8, D-4, A-1
default value D-3
deleting signed data 1-24
deselecting objects 7-7

design mode D-4
printing from 10-3 to 10-7

dialog D-4
unit conversion B-3

dialogs
addressing with Microsoft

Mail 11-9
addressing with

QuickMail 11-11
Align Objects 7-24
color definition 9-3
Field Settings 5-20 to

5-21, 6-23
Grid Options 4-12 to

4-14, 4-25 to 4-26
Guide Options 4-16 to 4-18
New Save 1-18
Object Setting 7-9
Object Settings 6-9,

7-27, 7-38
Open 1-6
Paint Settings 6-10
Preferences 4-4, 10-8
Print Job 9-9
Publisher Options 8-9
publishing 8-7
Replicate 7-21
Resize Objects 7-14
Rounded Corners 6-22
Ruler Options 4-6
Save As 1-20
Save Changes 1-17
Save data changes 1-17,

1-21
Set Passwords 1-9
Subscriber Options 8-12
subscribing 8-10
Table Setting 5-35
Type Settings 6-17
verification 1-14

digital signatures 1-13 to
1-15, 1-23 to 1-24,  D-4

dimensions of text 5-7 to 5-8
distribute

by value 7-30 to 7-31
visually 7-28 to 7-30

Distribute command
7-28 to 7-31

distributing objects 7-28 to
7-31

dividing columns 5-32 to 5-33
document name D-4
document(s)  1-2

changing passwords
1-9 to 1-10

closing 1-15 to 1-18
conversion 1-11
creating 1-5 to 1-6,

1-15 to 1-18, 1-20 to
1-21

data 1-4 to 1-5
Fast Forms 1-8
form 1-3
in use 1-12 to 1-13
integrity of 1-13 to 1-15,

1-23
locked 1-12
mailing 11-2
opening 1-6 to 1-15
opening signed 1-13
replacing 1-16, 1-19
saving 1-18 to 1-20
saving copies of 1-20 to

1-21
signed 1-13 to 1-15
signing 1-13 to 1-15
stationery 1-3 to 1-4
templates 1-3
TrueForm 1-8
types 1-2 to 1-5

documents 1-2
dots per inch 4-23
double lines 6-15
drawing

arcs 5-14
fields 5-20
lines 5-9
ovals 5-12 to 5-13
polygons 5-15 to 5-16
rectangles 5-11
text 5-5 to 5-6

drawing accuracy 4-23 to
4-26



Index - 3

drawing arcs 5-14
drawing area 2-2, 2-8, 4-3,

D-4
aligning objects to 7-25
offsetting 2-12 to 2-15
repeating 2-15 to 2-16
size of 2-10

drawing environment 4-1
drawing fields 5-20
drawing lines 5-9 to 5-10
drawing offset 2-12 to

2-15, D-4
drawing ovals 5-12 to 5-13
drawing plane 7-34, D-4
drawing polygons 5-15 to

5-16
drawing rectangles 5-11 to

5-12
Drawing Setup command

2-2, 2-8 to 2-20
drawing size 2-2, 2-10 to

2-11, D-4
drawing tables 5-29
drawing text 5-5
drawing tools 5-1
drawing window 1-5,

4-2 to 4-5, D-4
Duplicate command

7-20 to 7-21

E
editing text 5-6 to 5-7
edition 8-5
elect Same command 7-2, 7-6
electronic mail 11-2, D-4
electronic signatures

1-13 to 1-15
Encapsulated PostScript

importing 8-2 to 8-3
enclosing rectangle D-4
Enlarge command 4-23
entering

fractions B-3
measurements B-3

entering fractions B-3
entering measurements B-1

EPSF D-4. See also Encapsu-
lated PostScript: importing

Escape key 5-3
extensions

mail 11-3, 11-6

F
Fast Forms 1-8
faster scrolling 4-4
field D-5
Field command 5-21,

6-22 to 6-24
field settings 6-22 to 6-24
Field tool 5-18 to 5-27,  D-5
field(s)

cell section of 5-23 to 5-24
combs of 5-25 to 5-26
default appearance of 6-8
default appearance of

5-27, A-3
drawing 5-20
parts of 5-18 to 5-19
resizing parts of 5-26 to

5-27
rule lines 5-24 to 5-40
rule lines of 6-23 to 6-24
title divider of 5-22 to 5-23
title section of 5-22 to

5-23, 6-23
File Menu 1-2,  2-2
fill pattern. See fill shade
fill shade 6-12 to 6-14, D-5

of arcs 5-15
of ovals 5-13
of polygons 5-17
of rectangles 5-11 to 5-12

Fill submenu 6-10, 6-12
font 6-18
font size 6-18
Font submenu 6-16
fonts

missing 1-11 to 1-12
footer 1-3
form document D-5
form documents 1-3

form ID 1-25
Form Information 1-24
Form menu 1-9
form size 2-8 to 2-20. See

also drawing size
format D-5
fractional character widths 10-8
fractions B-3
full justified text 6-20 to 6-21
function D-5

G
gradient fills. See graduated fills
graduate D-5
graduated fills 6-12 to 6-14
graduation direction 6-

13 to 6-14
grid D-5

described 4-10 to 4-14
display options 4-13 to

4-14
hiding 4-10
options 4-12 to 4-14,

4-25 to 4-26
printing 10-3
separation 4-13
showing 4-10
snapping 4-11 to 4-12

grid axis D-5
grid lines 4-3
Grid Options command

4-12 to 4-13, 4-25 to
4-26

Group command 7-32 to 7-33
grouping objects 7-32 to 7-33
guide lines 4-4, 4-14 to

4-18, D-5. See also object
guides

creating and removing
4-14 to 4-15

display options 4-17
hiding 4-14
locking 4-18
options 4-16 to 4-18
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printing 10-3
sensitivity 4-17
showing 4-14
snapping 4-15 to 4-16,

4-17 to 4-18

H
handles 7-3, D-5
header 1-3
help message D-5
Hide Borders command 8-8,

8-10
Hide Grid command 4-10
Hide Guides command 4-14
Hide Rulers command 4-6
Hide Specs command 7-17
hierarchical menu D-5
hierarchical menus. See sub-

menus
HLS D-6
home position 4-8, D-6
hue. See HLS

I
i-beam D-6
i-beam pointer 5-4
ImageWriter 2-7 to 2-8

page size 2-7
Tall Adjusted option 2-8

import D-6
Import Command 8-2 to 8-7
Import command 8-2
importing

errors when 8-3 to 8-4
graphics 8-2 to 8-7
PICT images 8-4 to 8-5
scanned images 8-4 to 8-6
TIFF images 8-4 to 8-5

inches 4-7
index D-6
indexes

updating 1-22 to 1-24
information box 4-20, D-6

initial values. See default value
invisible objects 7-37 to 7-38
italic type 6-18 to 6-19

J
justification. See alignment
justified text 6-20 to 6-21

K
key D-6
keys. See indexes: updating

L
labels 2-15
LaserWriter 2-4 to 2-6

options 2-4 to 2-6
paper size 2-5

layout 1-4, D-6
Layout & data

mailing 11-5
Layout menu 4-2
Layout only

mail format 11-5
leading D-6
letter documents 11-7,

11-18, 11-19 to 11-20
letter format

mailing 11-5, 11-7
lightness. See HLS
line style 5-9 to 5-11
Line Style submenu 6-4
Line tool 5-9 to 5-11, D-6
line width 6-14 to 6-15

choosing 6-14
of arcs 5-15
of lines 5-10
of ovals 5-13
of polygons 5-17
of rectangles 5-11 to 5-12

Line Width submenu 6-10
lines

appearance of 5-10
default appearance of

6-6 to 6-8

default appearance of A-2
lines per inch 2-5
lining up objects. See Align

command
Linotronic 2-6, 2-17
lists. See table
literal D-6
locked document 1-12
locking position 7-9
locking settings 6-9
lookup D-6

M
magenta. See CMYK
mail enabled 11-3 to 11-4
mail extensions 11-3, 11-6
mail formats 11-5
Mail submenu 11-2, 11-4
mailing forms 11-2
manipulating documents 1-1
manipulating objects 7-1
manual tiling 10-4 to 10-5
master page D-6
measurement units B-3
measurements B-3
Microsoft Mail

addressing dialog 11-9
mail enabled with 11-3
opening forms mailed with

11-20 to 11-21
pre-addressing 11-10 to

11-11
sending forms with

11-8 to 11-11
moving objects 7-25

through the drawing plane
7-34

with the align command
7-25 to 7-26

with the Pointer tool
7-8 to 7-9

multipart page D-6
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N
New command 1-5 to 1-6
new documents 1-15 to 1-16
new settings. See default settings
nudge D-7
nudging objects 7-36
numeric operators. See arithme-

tic operators

O
Object command 6-9, 7-9,

7-26 to 7-27, 7-37 to
7-38

object guides 7-26 to 7-27
object(s)

aligning 7-23 to 7-26
changing appearance 6-1
clearing 7-7 to 7-8
color of 6-16
coloring 9-8
copying 7-39 to 7-40
corners of 6-21 to 6-22
cutting 7-39 to 7-40
default settings 6-6 to 6-8
deselecting 7-7
distributing 7-28 to 7-31
duplicating 7-20 to 7-23
fill shade of 6-12 to 6-14
grouping 7-32 to 7-34
layering 7-34 to 7-36
line style of 6-15
line width of 6-14 to 6-15
locking position 6-9
moving 7-8 to 7-9
nudging 7-36 to 7-37
object guides 7-26 to 7-27
pasting 7-40, 7-41, 7-42
pen shade of 6-11
print option 7-37 to 7-38
repositioning 7-8 to 7-9
resizing 7-10 to 7-20
rotating 7-31
selecting 7-2 to 7-7
type settings of 6-16 to

6-21

ungrouping 7-32 to 7-34
on-line help. See help message
Open command 1-6 to 1-15
open dialog 1-6
Open mail command 11-2,

11-4, 11-15 to 11-17
opening documents 1-6 to 1-15
opening mailed forms 11-

15 to 11-22
manually 11-17
with the Open command

11-15 to 11-17
opening signed documents

1-13 to 1-15
operand D-7
operator D-7
outline type 6-18 to 6-19
Oval tool 5-12 to 5-14, D-7
ovals

appearance of 5-13 to 5-14
default appearance of A-2
drawing 5-12

overlays. See spot color overlay

P
page break 4-4
page controls 4-4, D-7
page options

LaserWriter 2-4 to 2-6
Page Setup command 2-2,

2-4 to 2-8
page size 2-11 to 2-12, D-7

custom 2-3
Paint command 5-9, 6-10
Paint Settings 6-9 to 6-16
paper size 2-4
password

changing 1-9 to 1-10
entering 1-7 to 1-9

Paste command 7-40 to 7-42
pasting

graphic objects 7-42
Informed objects 7-40 to

7-41
text objects 7-42

pen pattern. See pen shade
pen settings 5-9
pen shade 6-11, D-7

of arcs 5-15
of lines 5-10
of ovals 5-13
of polygons 5-17
of rectangles 5-12
of text 5-9

Pen submenu 6-10, 6-11
picas 4-7
PICT D-7
PICT format

importing 8-4 to 8-5
subscriber types 8-11

plain type 6-18 to 6-19
Pointer Tool

choosing 5-3
Pointer tool 5-3, D-7
points 4-7
polygon

appearance of 5-16 to 5-17
drawing 5-15 to 5-16
reshaping 5-17 to 5-18

Polygon tool 5-15 to 5-18,
D-7

polygons
default appearance of

6-6 to 6-8
default appearance of A-3

PostScript D-7. See also EPSF
PowerTalk 1-13, 1-23 to

1-24, 11-5
mail enabled with 11-3
opening forms mailed

with 11-17 to 11-20
sending forms with

11-6 to 11-8
pre-addressing forms

11-10 to 11-11,
11-12 to 11-14

precision. See drawing accuracy
preferences 1-4
Preferences dialog 4-4, 10-8
Print Progress 10-2 to 10-3
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printing
cells 10-3
color names 10-6
crop marks 10-5 to 10-6
cutouts 10-6
from design mode

10-3 to 10-7
from test mode 10-7 to 10-8
grid lines 10-3
guide lines 10-3
inconsistent type spacing

10-8
options 10-2
registration marks 2-16,

10-6
shades 2-5 to 2-6
spot color 9-8 to 9-10, 10-6
tiles 10-3 to 10-5
with data hidden 10-7
with layout hidden 10-7

publisher 8-5
cancelling 8-9
creating 8-6 to 8-7
defined 8-5

Publisher Options command
8-8

Q
Quick-Tab D-7
QuickMail

addressing dialog 11-11
mail enabled with 11-3
opening forms mailed

with 11-17, 11-22
sending forms with 11-11

R
reading forms 1-5 to 1-6
Rectangle tool 5-11 to 5-

12, D-7
rectangles

appearance of 5-11 to 5-12
default appearance of

6-6 to 6-8
default appearance of A-2

drawing 5-11
rounding 6-21 to 6-22

Reduce command 4-23
registration marks 2-16,

9-10, D-7
removing color 9-6
Replicate command 7-21 to

7-22
repositioning objects 7-8 to

7-10
Reshape Polygon command

5-17 to 5-18
reshaping a polygon

5-17 to 5-18
Resize command 7-14 to 7-16
resizing

arcs 7-11
boxes 7-11
fields 7-12 to 7-13
lines 7-10 to 7-11
multiple objects 7-13 to

7-14
objects 7-10 to 7-20
ovals 7-11
polygons 7-11
rectangles 7-11
tables 7-12 to 7-13
text 7-12

resolution 4-23
reverse quote key 5-3
reverse type. See white type
RGB 9-4, D-8
Rotate command 7-31
rotating objects 7-31
Rounded Corners 6-21 to 6-22
rounded corners 5-11 to

5-12, 6-21 to 6-22
row lines 5-38 to 5-39
rule lines 5-24 to 5-25,

6-23 to 6-24
ruler

crosshairs 4-9 to 4-10
home position 4-8
units 4-7, B-3
zero point 4-7 to 4-8

ruler crosshairs D-8
ruler home position D-8
Ruler Options commands 4-6
ruler zero point D-8
rulers 4-6 to 4-10, D-8

S
saturation. See HLS
Save As command 1-20 to

1-21
Save command 1-18 to 1-20
saving a document 1-18 to

1-20
saving copies of documents

1-20
saving mailed forms

11-16, 11-18
scale. See view scale
scanned forms 8-4 to 8-5
Screens at attribute 2-5
scrollbars D-8
scrollbox D-8
security. See digital

signatures; password:
entering

Select All command 7-2, 7-6
selecting

all objects 7-6
behind objects 7-5 to 7-6
more than one object 7-4
objects 7-2 to 7-7
similar objects 7-6 to 7-7
text 7-39 to 7-40
through objects 7-5 to 7-6

selecting objects 7-2 to 7-7
selection rectangle 7-3 to

7-4, D-8
Send Backward command 7-35
Send command 11-2,

11-4, 11-6
Send Options command

11-2, 11-12
Send To Back command 7-36
sending forms 11-6 to

11-15. See also mailing
forms
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with Microsoft Mail
11-8 to 11-11

with PowerTalk 11-6 to
11-8

with QuickMail 11-11
sensitivity area D-8
setting multiple objects

6-4 to 6-6
setting up the drawing

2-8 to 2-20
setting up the page 2-4 to 2-8
settings

defaults 1-4 to 1-5
locking 6-9

Settings menu 6-2
shade D-8
shaded text 5-8 to 5-9
shades

printing 2-5 to 2-6
selecting 6-11

shadow type 6-18 to 6-19
shortcuts C-1
Show Borders command

8-8, 8-10
Show Clipboard command

7-39
Show Grid command 4-10
Show Guides command 4-14
Show rulers command 4-6
Show Specs command 7-17
Show Tools command 5-3
signatures

cell 1-23 to 1-24
changing calculation for-

mula 1-24
changing cell type 1-24
deleting signed data 1-24
digital 1-13 to 1-15
electronic 1-13 to 1-15
invalid 1-23
verifying 1-13 to 1-15

signing forms 1-13 to
1-15, 1-23 to 1-24

size
of drawing area 2-8 to 2-20
of form 2-8 to 2-20

of ImageWriter page 2-7
of LaserWriter page 2-4

size box D-8
Size submenu 6-16
SmartForm 1-8
Snap To Guides command

4-15 to 4-16
snapping D-8
specs palette 4-4, 7-16 to

7-20, D-9
hiding 7-17
showing 7-17

splitting a column 5-31 to 5-33
spot color 9-8, 9-10, D-9
spot color overlay D-9
stacking order D-9
stationery documents 1-3 to

1-4,  D-9
Style menu 6-17
submenu D-9
submenus 6-3 to 6-4,

6-10 to 6-11
Subscribe To command 8-10
subscriber 8-5

cancelling 8-12
creating 8-10
defined 8-5
options 8-12
textual 8-11
types 8-11

Subscriber Options command
8-12

subscriber types 8-11

T
tab order D-9
tab position D-9
table D-9
Table command 5-35, 6-25
Table tool 5-27 to 5-40, D-9
table(s)

column sections 5-37 to
5-38

default appearance of 6-8
default appearance of 5-40

distributing columns
5-33 to 5-34

drawing 5-29
moving columns 5-33
parts of 5-27 to 5-29
placing columns 5-29 to

5-30, 5-30 to 5-31
removing columns 5-34
resizing columns 5-30 to

5-31
resizing parts of 5-39 to

5-40
row lines of 5-38 to 5-39
rows of 5-36 to 5-37,

6-25 to 6-26
title sections of 5-35 to

5-36, 6-26
tables

default appearance of A-3
tabloid

drawing size 2-12
page size 2-3, 2-19

templates 1-3
test mode D-9
text entry box D-9
Text tool 5-4, D-9

using shaded text 5-8 to
5-9

text tool
choosing 5-4
drawing a caption 5-4
drawing a paragraph 5-5
drawing in a box 5-5 to 5-6
editing text 5-6 to 5-7

texual graphics
appearance of 5-8 to 5-9
copying 7-39 to 7-40
cutting 7-39 to 7-40
default appearance of A-2
dimensions of 5-7 to 5-8
drawing 5-5 to 5-6
editing 5-6 to 5-7
pasting 7-40
selecting 7-40
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shading 5-8 to 5-9
subscriber 8-11

TIFF D-10
tiling 2-3, 10-3 to 10-5, D-10
title dividers 5-22 to 5-23,

5-36 to 5-37
titles 5-21 to 5-22,

5-35 to 5-36
tool palette 4-4, 5-2 to

5-4, D-10
TrueForm 1-8
type face. See font
type size. See font size
type spacing 10-8
type style D-10
types. See cell type

U
Ungroup command 7-33 to

7-34
ungrouping objects 7-33 to

7-34
unit conversion B-3
units 4-7
updating artwork 8-5 to 8-6

V
verifying signatures 1-13
vertical alignment 6-20 to

6-21
view scale 4-19 to 4-23, D-10

changing 4-19 to 4-23
commands 4-21 to 4-23
enlarging 4-23
reducing 4-23

visual attribute D-10
visual attributes 6-2

W
white type 6-18 to 6-19
width of lines 6-14 to 6-15
window 1-5
windows

drawing 1-5

work page D-10

Y
yellow. See CMYK

Z
zero point D-10
zero point ruler D-10
zoom box D-10
Zoom tool 4-20 to 4-21, D-10
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